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What Is TimeCosting-PC? 

 

The essence of time-costing is that an employee works on a process which is part of a job. For 
examples of time-costing, click here. 

TimeCosting-PC is an add-on module of TimeKeeper-PC designed to store, calculate, and 
analyze time-costing data. 

TimeCosting-PC is fully integrated with TimeKeeper-PC. The two programs work together, 
TimeKeeper-PC providing the rules and regulations of your company's time and attendance 
policies and accumulating the final attendance and absence data to which TimeCosting-PC (TC) 
is applied. TimeCosting-PC's rate calculations provide vital information for both costing and billing 
on a job-by-job basis. 

TimeCosting-PC defines up to four levels of jobs, from work orders down to processes, and allows 
levels to be linked in order to cost processes according to the work orders to which they are 
assigned. TC records the hours worked by an employee at any number of jobs and processes in a 
single day. TC can apply automatic percentages to divide an Employee's hours between jobs and 
processes even without manual starting and ending punches. TC processes time-costing activity 
on both a daily and a pay-period basis. Once time-costing data is corrected and calculated, it can 
be transferred to your payroll department or exported for costing, billing, and other uses. 

For Help using TimeCosting-PC in Seven Easy Steps, click here. 

TimeCosting-PC can assign default pay rates to an employee, a department, or a profession, or 
any of the costing levels defined. TC combines these and other fields to base a rate structure on 
up to five separate elements. TC can create up to three different rate structures, allowing you to 
separate costing, billing, payroll, and other considerations. 

For Help setting up TimeCosting-PC, click here. 

TimeCosting-PC can create time and attendance reports by day or pay period, and by employee 
or by specific level. These reports can be presented graphically and exported to Microsoft Excel 
files. TC can also create reports on TC system setup. 

For Help using TimeCosting-PC reports and other advanced functions, click here. 

 For the purposes of this Help file, time-costing levels are sometimes referred to by the following names:  

 Level 1 Level 2 Level 3 Level 4 

 Work order Batch Part Process 

Examples of Time-Costing 
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The essence of time-costing is that an employee works on a process which is part of a job. Each 
of these three elements can be broken down into a number of levels: 

 Employee: TimeCosting-PC can track time-costing for any level of your company's hierarchy. 

 Process: TimeCosting-PC can track the individual steps of a process, or even different machines performing the same step. 

 Job: TimeCosting-PC can track individual parts of a larger job. A job can be defined as a product, a service, a customer, a 

geographical district, and so on. 

Our first example is a large automotive plant...  

Our second example is a technical writing firm...  

Our third example is a chain of restaurants...  

All of these elements are defined in TimeCosting-PC setup. For Help setting up TimeCosting-PC, 
click here. 

In a large automotive plant, each model of car or truck can be considered a separate job. If a 
pickup truck has an optional camper module, the camper module can be considered a separate 
part of the larger job, which is the assembled pickup truck with the camper. Assembling the 
camper module can require hundreds of individual processes, such as stamping, welding, 
painting, and so on. The single process of painting can be broken down into sanding, priming, 
painting, inspecting the paint job, and so on. The plant may use three different models of spray-
paint machines, each with its own standard cost and speed. All of the above details can be 
defined as separate elements of TimeCosting-PC. 

There can be overlap between employees, processes, and jobs. For example, the same 
employee can work with more than one spray-paint machine. The same machine can be used to 
paint parts belonging to different cars, in which case a number of jobs can share the same 
process. One electrician can repair machines belonging to different processes or jobs, and so on. 

A technical writing firm can charge different rates to different customers, and each customer can 
be considered a separate job. Each manual produced for a customer can be considered part of 
the larger job, which is the customer. Unlike assembling a pickup truck, writing a manual can 
involve a small number of processes, such as researching, writing, testing, and proofreading. The 
firm can charge one customer for writing by the hour, and another customer by the page: different 
rates for the same process on different jobs. The firm can charge the same customer different 
rates for writing different manuals, or give a customer a discount if the employee who proofreads 
the manual is an intern. All of the above details can be defined as separate elements of 
TimeCosting-PC. 

In a chain of restaurants, each region of the country can be considered a different job, in order to 
account for regional variations in the cost of produce. Each restaurant within a region can be 
considered part of the larger job, which is the region. Since the franchising corporation wants to 
maintain uniformity, the restaurants all include the exact same processes, but they are costed 
differently according to region. The process of preparing french fries, which is a standard process 
throughout the chain, can be costed differently for a new employee than for an experienced one. 
All of the above details can be defined as separate elements of TimeCosting-PC. 

TimeCosting-PC in Seven Easy Steps 

 

 Edit TC-Specific Fields in Employee Profiles: You edit TC-specific fields in the Seniority / 
Costing Data tab of TimeKeeper-PC Employee Profiles. 
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 Time Data Input: TimeKeeper-PC acquires each employee's daily arrival and departure 
hours, and TimeCosting-PC acquires each employees’s start and end times in various jobs -- 
usually from punch clocks. 

 Edit Invalid TC Punches: You edit invalid punches received in the time data input phase. 

 TC Errors & Exceptions Report: TimeCosting-PC reports any mistakes or inconsistencies in 
the input data. 

 Daily Transactions Report: TimeCosting-PC reports all job transfers. 

 Edit Daily Job Transfers: You tell TimeCosting-PC how to change time-costing input data. 

 Export TC Data: TimeCosting-PC delivers the corrected summary for use in payroll, billing, 
or costing. 

 

What Else Can TimeCosting-PC Do? 

Editing TC-Specific Fields in Employee Profiles 

What Is It? 

An Employee Profile contains all the information you need about an Employee, including name, 
number, department assignment, hire date, place of work, profession, and other personal 
information. Use the Seniority / Costing Data tab of the Employee Profile to enter information in 
TC-specific fields. 

 You can assign an Employee to a new default rate. 

Why Do I Need It? 

TimeCosting-PC cannot allocate hours for an Employee who is not labeled as a TC Employee. 

Additionally, while an Employee is not required to have a default rate code, it is recommended to 
assign one. For every TC Record, at least one of the following elements must have a default rate 
code: Employee, Department, Profession, or one of the active levels. 

Editing TC-Specific Fields in the Seniority / Costing Data tab 

Where Do I Go Next? 

Seniority / Costing Data Tab 

The following fields are displayed in the lower half of the Seniority / Costing Data tab: 

Occupation Type 

Rate Code 

Editing TC-Specific Fields -- Where Do I Go Next? 

If you have not yet saved the Employee Profile, click the Save Record icon now: 
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You will be prompted by a small dialog box: "Save Changes To File?" Click Yes to save the 
settings. 

You can edit TC-specific fields in another new Employee Profile. 

Click the Exit icon to close the Employee dialog box: 

 

If you have changed any settings but not saved them, you will be prompted by a small dialog box: 
"Save Changes To File Before Exit?" 

 If you want to save the changes you have made to the settings in the current Employee Profile, click Yes. 

 If you want to close the dialog box without saving those changes, click No. 

 If you want to keep the dialog box open, click Cancel. 

After you add and edit Employee Profiles, you need to aquire each employee's daily arrival and 
departure hours. For Help acquiring time data, click here. 

TC Occupation Types 

The Occupation Type field is used to identify Employees whose work hours are included in the 
TimeCosting-PC (TC) or Departmental Allocation-PC (DA) modules. 

 The DA module is used to distribute the cost of an Employee's hours among departments in your organization. 

An Employee must be labeled as a TC Employee in order for TC to be able to calculate time-
costing data for that Employee. An Employee labeled as "TK Employee Only" or "DA Employee" 
will not be included in TimeCosting-PC . 

"TK Employee Only" is always be an option for this field. Options beginning with TC or DA are 
displayed in this field only if those modules are installed in the system configuration. 

 If Departmental Allocation is installed in the system configuration, but not TimeCosting, then this field 

includes only the options "TK Employee Only" and "DA Employee". 

To Label an Employee as a TC Employee 

1. Click the drop-down arrow next to the Occupation Type field to open a list of occupation types. The currently selected 
occupation type is displayed as a raised gray button with white characters. 

2. Click to choose an occupation types. For Help choosing TC occupations types, click here.  

Choosing TC Occupations Types 

Choose TK Employee Only to disable time-costing for that Employee. 

TC occupation types include combinations of the following elements: 

Indirect/Direct  

Default Jobs  

Clock Transactions  

To label an Employee as a TC Employee, choose one of the following combinations: 

 TC-Indirect 

 TC-Indirect + Default Jobs only w/o Clock Transactions 
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 TC-Indirect + Default Jobs only with Clock Transactions 

 TC-Indirect + Default Jobs 

 TC-Direct 

 TC-Direct + Default Jobs only w/o Clock Transactions 

 TC-Direct + Default Jobs only with Clock Transactions 

 TC-Direct + Default Jobs 

Occupation Types -- Indirect/Direct 

A process can be defined as either direct or indirect. An indirect process is not necessary for a 
specific job, but for the system as a whole. A direct process is necessary for a specific job. 

 In a large automotive plant, Sweeping and Testing Van Chassis Assembly are both processes. Sweeping is 

necessary for the plant as a whole, but any one part can be assembled even if the floor has not been swept. 

Sweeping is therefore an indirect process. Testing van chassis assemblies is necessary for Van Chassis 

Assembly, and it is therefore a direct process. 

When a TC Employee is defined as indirect, then any process is considered indirect while that 
Employee's hours are assigned to it. When a TC Employee is defined as direct, then a process is 
considered indirect only if it has been specifically defined as indirect. 

 In the example above, a plant manager can be defined as an indirect Employee. In that case, even if that 

manager tours the plant and spends time working with the Van Chassis Assembly Testing team (normally a 

direct process), those hours will be considered indirect. 

For Help defining processes as direct or indirect, click here. 

Occupation Types -- Default Jobs 

A TC Default Jobs Employee assigns hours that are not punched for TC according to the default 
job assignment tables. 

A TC Employee not defined as Default Jobs does not assign hours according to the default job 
assignment tables, even those hours that are not punched for TC. 

 An Employee in the Bookkeeping Department is defined by a default job assignment table to work 50% in 

Accounts Payable and 30% in Employee Training. If the Employee is defined as Default Jobs, then any 

hours that are not punched for TC will be assigned according to that table. If the Employee is not defined 

as Default Jobs, then no hours will be assigned according to that table, even those hours that are not 

punched for TC. 

For Help assigning default job assignment tables to Employees, click here. 

A TC Default Jobs Employee can make the use of default job assignment tables conditional on 
manual TC punches. For Help making default job assignment tables conditional on manual TC 
punches, click here. 

Occupation Types -- Clock Transactions 

A TC Default Jobs Employee can make the use of default job assignment tables conditional on 
manual TC punches. 
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A TC Default Jobs Employee defined as Only Without Clock Transactions assigns hours 
according to the default job assignment tables only if the Employee had no TC clock transactions 
on that day. 

A TC Default Jobs Employee defined as Only With Clock Transactions assigns hours according to 
the default job assignment tables only if the Employee had at least one TC clock transactions on 
that day. In that case, the default job assignment table apply only to the hours that were not 
punched manually. 

 An Employee in the Bookkeeping Department is defined by a default job assignment table to work 50% in 

Accounts Payable and 30% in Employee Training. The Employee punches in for eight TK hours, four of 

which were punched in as TC hours. If the Employee is defined as Default Jobs Only Without Clock 

Transactions, then no hours are assigned according to that table. If the Employee is defined as Default 

Jobs Only With Clock Transactions, then only the four hours which were not punched in as TC hours are 

assigned according to that table. 

For Help assigning default job assignment tables to Employees, click here. 

A TC Default Jobs Employee can also use default job assignment tables regardless of manual TC 
punches. For Help using default job assignment tables regardless of manual TC punches, click 
here. 

TC Rate Codes for Employees 

An Employee can be assigned a default rate code. TC can be configured to use this rate as the 
default pay rate, to use it under certain conditions, or to use it to calculate other pay rates. 

For Help defining TC rate codes, click here. 

If you type 0, the Employee will have no default rate code. Note that for every TC Record, at least 
one of the following elements must have a default rate code: Employee, Department, Profession, 
or one of the active levels. 

The Rate Code field displays the number of the Employee's assigned rate code. The name of that 
rate code is displayed to the right of the Rate Code field. 

To Choose an Employee's Rate Code 

1. Click the drop-down arrow next to the Rate Code field to open a list of rate codes sorted by number. The currently 
selected rate code is displayed as a raised gray button with white characters. 

2. Use the vertical scroll bar on the right to scroll up and down the list. 

3. To choose a rate code, click anywhere on that rate code's line. The drop-down list closes, and the number of the 
selected rate code is displayed in the Rate Code field. The name of the selected rate code is displayed to the right of 
the Rate Code field. 

TC Time Data Input 

 Before you can enter time data, you need to edit TC-specific fields in the Seniority / Costing Data tab of 

TimeKeeper-PC Employee Profiles. For Help editing the Seniority / Costing Data tab, click here. 

Data from punch clocks are stored as a series of transactions. Each transaction includes the 
following information: 

 Clock number 

 Employee Badge number 

 Date and Time 

 Index codes for each active level (work order, batch, part, process) 
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 Event Type (i.e., whether the punch is Start or End) 

There are two ways in which TimeKeeper-PC can acquire Employees' daily arrival and departure 
hours: 

 By polling punch clocks: transactions stored in the punch clocks are transmitted directly to the computer 

 By reading backup punch files: transactions stored in a data file are read into the computer 

TC Polling Clocks 

 Before you can poll clocks, your TimeKeeper-PC dealer needs to physically install your punch clocks, 

connect them to your computer, and run their installation software. 

 Before you can poll clocks, the Employees who punched in need to have the correct Badge numbers and 

valid Contracts in their Employee Profiles. For Help editing Employee Badge numbers, click here. For Help 

editing Employee Contract numbers, click here. 

Data from punch clocks are stored as a series of transactions. There are three ways in which 
TimeKeeper-PC can poll clocks for punch data: 

 By automatically polling clocks at a fixed interval (also called "Online Polling") 

 You can set up TimeKeeper-PC  to automatically poll clocks every ten minutes. 

 By automatically polling clocks at a fixed time 

 You can set up TimeKeeper-PC  to automatically poll clocks at 8:00 AM, 12:00 PM, and 5:00 PM. 

 By manually polling clocks according to user demand (also called "Batch Polling"). To manually poll clocks, choose Poll 

Clocks from the Activities menu. 

The polling method used is defined in the system configuration in TimeKeeper-PC Set-Up. If 
errors occur during polling, consult the Defining the Polling Parameters addendum to your User's 
Manual. This addendum contains polling information specific to your brand of punch clock. 

What happens when TimeKeeper-PC Polls Clocks? 

Where Do I Go Next? 

After polling is completed, edit invalid punches received in the time data input phase. For Help 
editing invalid punches, click here. 

TC Backup Punch Files 

 Before you can read backup punch files, the Employees in those files need to have the correct Badge 

numbers and valid Contracts in their Employee Profiles. For Help editing Employee Badge numbers, click here. 

For Help editing Employee Contract numbers, click here. 

Data from punch clocks are stored as a series of transactions. Each time clocks are polled, a 
separate backup file is automatically created. These backup files are used for two purposes: 

 As an emergency backup in case data are lost 

 To transfer data to a computer which is not physically connected to the punch clocks 

Backup punch files are created and stored in simple text format. Each transaction is a separate 
line in the file. 
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TimeKeeper-PC can read two formats of backup punch files: 

 TK Format: the proprietary format used by TK and TC. 

 Clock Format: the format created by Synel brand punch clocks. 

To read backup punch files, choose either Read Backup Punch File (TK Format) or Read Backup 
Punch File (Clock Format) from the Activities menu. For Help reading backup punch files, click here. 

Where Do I Go Next? 

After you read backup punch files, edit any invalid punches received in the time data input phase. 
For Help editing invalid punches, click here. 

Viewing and Editing Invalid TC Punches with the 

Transactions File 

 Before you edit invalid punches, you need to acquire time data, either by polling the punch clocks or by 

reading a punch backup file. For Help acquiring time data, click here. 

What Is It? 

The Transactions File displays invalid punch transactions, which include clock numbers, 
Employee Badge numbers, dates and times, index codes for each active level, and whether 
punches are Start or End. 

For examples of invalid punches, click here. 

Use the Transactions File to correct invalid punches. 

Why Do I Need It? 

Invalid punches must be corrected because TimeCosting-PC cannot calculate the work hours of 
an Employee with an invalid time clock entry. 

 

Editing the TC Transactions File 

Reading the TC Transactions File 

Where Do I Go Next? 

Examples of Invalid Punches 

The most common cause of an invalid punch in TimeCosting-PC is an invalid Badge number or 
level index code. 

Invalid Badge Numbers 

One possible cause of an invalid Badge number is a new Badge which has not yet been entered 
in the system. 

 An Employee loses a Badge, and is given a new Badge, but the new Badge has not yet been entered in the 

system. When the Employee uses the new Badge, the clock produces an invalid punch. 

To correct this problem, the new Badge number must be entered in the Employee's Profile. For 
Help editing an Employee's Badge number, click here. 

Another possible cause of an invalid Badge number is the use of a Badge which has expired. 
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 An Employee loses a Badge, and is given a new Badge. Later, the Employee finds and accidentally uses the 

old Badge, which is no longer valid in the system. The clock produces an invalid punch. 

To correct this problem, the Badge number in the invalid punch transaction must be edited. For 
Help editing invalid punch transactions, click here. 

Invalid Level Index Codes 

One possible cause of an invalid index code is a new index code which has not yet been entered 
in the system. 

 An Employee is assigned to a new process which has not yet been entered in the system. When the 

Employee keys in the number of the new process, the clock produces an invalid punch. 

To correct this problem, the new index code must be entered in TC Setup. For Help creating new 
index codes, click here. 

In some cases, an Employee can accidentally key in an invalid index code. To correct this problem, 
the index code in the invalid punch transaction must be edited. For Help editing invalid punch 
transactions, click here. 

 Some punch clocks can upload validity tables, which prevent an Employee from accidentally keying in an 

invalid index code. For more information, consult your TimeCosting-PC dealer. 

Editing the TC Transactions File 

To Edit the Transactions File 

1. Choose View/Edit Invalid Punches from the Maintenance menu. The Edit Erroneous Transactions window displays a 
blue bar which fills across a scale in the window. This bar marks the progress of the transfer of TK punch 
transactions to a temporary file. 

2. When the transfer of punch transactions is completed, the TK Transactions File (Edit Erroneous Transactions) is 
displayed. 

3. Choose Open File from the File menu, or click the Open File icon: 

 

4. You will be prompted by a small dialog box: "Update Invalid Punch File with Edits?" Click No. The Select File To 
Open dialog box is displayed. 

5. Click TC Error Transactions File, or click Select to choose a non-standard file name. For Help using the Select 
button, click here. 

6. Click OK. The Edit Erroneous Transactions window displays a blue bar which fills across a scale in the window. This 
bar marks the progress of the transfer of TC punch transactions to a temporary file. 

7. When the transfer of punch transactions is completed, the TC Transactions File is displayed. For Help reading the TC 
Transactions File, click here. 

8. Edit transactions as needed. For Help editing transactions, click here. 

9. After you make all desired changes, choose Exit from the File menu, or click the Exit icon: 

 

10. You will be prompted by a small dialog box: "Update Invalid Punch File with Edits?" Click Yes. 

You have now edited the TC Transactions File. 

Error Transactions File -- Select Button 

You can choose to display any transactions file using the Select button. 
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 You can view the backup file for TK error transactions, whose standard name is TRANSERR.BAK. 

To choose a non-standard Transaction File name, click Select. The Select File To Open dialog 
box is displayed: 

 

File Location 

The Drives field on the bottom right displays the drive currently selected. You can choose a 
different drive by clicking the drop-down arrow in this field to open a list of drives. 

The name of the directory currently selected is displayed under the title Directories. 

The path of the directory currently selected is displayed in the large Directories panel on the right. 
The name of the directory currently selected is highlighted in this panel. 

 In the example above, the path indicates that the directory currently selected, tk5win, is a sub-directory of 

lavie, which is a directory in the c:\ drive. 

Double-click any level of the path to open a list of directories on the level below. 

 You can double-click the c:\ drive to open a list of all directories of c:\. You can also double-click the lavie 

directory to open a list of all sub-directories of lavie. 

Click to select any directory on the path displayed. The selected directory is highlighted, and its 
name is displayed under the title Directories. 

File Type 

The file type is displayed in the List Files of Type field. You can choose a file type by clicking the 
drop-down arrow in this field to open a list of file types. The three options are: 

 User Defined: Choose this option to display a list of files with a given filename or extension using wild card characters. 

 If you choose User Defined for the File Type, and enter P*.BAK in the File Name field, the Files panel will 

display only those files whose names start with P and whose suffixes are BAK -- for example, 

PRDERR.BAK. 

 After you enter the wild card characters in the File Name field, press <Enter> to see the results in the Files 

panel. 

 Only Files (*TXT): Choose this option to display only text files with the TXT suffix. 
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 All Files: Choose this option to display all files. 

File Name 

The files of the selected type contained in the selected directory are displayed in the large Files 
panel on the left. When you use the up and down arrows to scroll through file names in the Files 
panel, the name of the file currently outlined is displayed in the File Name field. 

The standard file name for the TC Transactions File is PRDERR.TXT. The standard file name for 
the TK Transactions File is TRANSERR.TXT. 

Click to select a file. When the desired file name is displayed in the File Name field, click OK to 
close the dialog box. 

To Use the Select Button to Choose a Non-Standard Transaction File Name 

1. Click Select. The Select File To Open dialog box is displayed: 

2. Click the drop-down arrow in the Drives field to open a list of drives. 

3. Click to select a drive. The drop-down list closes, and the selected drive is displayed in the Drives field. 

4. Click to select a directory from the path in the Directories panel. The selected directory is highlighted, and its name is 
displayed under the title Directories. 

5. Click to select a file type. The drop-down list closes, and the selected file type is displayed in the List Files of Type 
field. The files of this type contained in the currently selected directory are displayed in the Files panel on the left. 

6. Click the file you want to select from the Files panel. 

7. When you finish choosing the file, click OK to close the dialog box. 

Reading the TC Transactions File 

When you open the TC Error Transactions File, the Transactions File is displayed. 

 

The Transactions File menu bar and tool bar are displayed at the top of the dialog box. The menu 
bar contains the menu options available for the Transactions File. The tool bar contains the icons 
available for the Transactions File. 
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The name of the selected Transactions File is displayed on the title bar. 

Each line in the upper panel of the Transactions File is a single invalid punch transaction. A punch 
transaction includes the clock number, Employee Badge number, date and time, index codes for 
each active level, and whether the punches is Start or End. Click any transaction to select it. The 
currently selected transaction is displayed in red characters. 

You can also select transactions using the Go To icons on the tool bar, or the Go To options in the 

Record menu on the menu bar. You can also use the  and  arrows on the vertical scroll bar 
to move one page up or down in the upper panel. 

If you make any changes in a transaction and click to select another transaction, you will be 
prompted by a small dialog box: "Current Record Has Been Changed! Save?" Click Yes. 

The lower (Transaction to Edit) panel displays the transaction currently selected in the upper 
panel. Use this panel to edit the invalid transaction. 

Each line in the Transaction to Edit panel displays one element of the transaction. The line whose 
element is invalid is highlighted in yellow. Click any line to select it. 

When you correct an invalid element, it continues to be highlighted in yellow. The next time you 
update the TC Error Transactions File (assuming you have reread the new, corrected invalid 
punch file), that transaction will not be displayed. 

When you edit a transaction in the Transaction to Edit panel and click Apply, the changes you 
have made are displayed in the upper panel. 

Press <Tab> to move forward to the next column and select it. Hold <Shift> and press <Tab> to 
move backward to the previous column and select it. You can also use the vertical scroll bar on 
the right to scroll up and down lines. 

For Help editing transactions, click here. 

Transactions File Menu Bar 

The following options are displayed on the Transactions File menu bar. Click any highlighted 
option on this list for Help using that menu option. 

File menu: 

 New File: Choose this option to create a new transactions file. This option is recommended for use by advanced users only. 

For Help creating new transactions files, click here. 

 Open File 

 Save File As 

 Select Sort 

 Print Transactions 

 Create Backup Copies 

 Delete Transactions 

 Partial Deletion 

 Exit 

Record menu: 

 Go To File Top: Choose this option to go to the first transaction displayed in the upper panel. 

 Go To Prev. Record: Choose this option to go to the previous transaction displayed in the upper panel. 

 Go To Next Record: Choose this option to go to the next transaction displayed in the upper panel. 
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 Go To End of File: Choose this option to go to the last transaction displayed in the upper panel. 

 If you choose any of these four options after making changes in the currently selected transaction, you will 

be prompted by a small dialog box: "Current Record Has Been Changed! Save?" Click Yes. 

 Save Transaction 

 Delete Transaction 

Edit menu: This menu is recommended for use by advanced users only. For Help changing data 
input structures, click here. 

Help Menu 

Transactions File Tool Bar 

The following icons are displayed on the Transactions File tool bar. 

 Click the Help icon for Help using the Transactions File. 

 Click the New File icon to create a new transactions file. This option is recommended for 
use by advanced users only. For Help creating new transactions files, click here. 

 Click the Open File icon to open a transactions file. 

 Click the Save Record icon to save the currently selected transaction. 

 Click the Save File As icon to save the currently displayed transactions file under a 
different name. 

 Click the Top of File icon to go to the first transaction displayed in the upper panel. 

 Click the Previous Record icon to go to the previous transaction displayed in the upper 
panel. 

 Click the Next Record icon to go to the next transaction displayed in the upper panel. 

 Click the End of File icon to go to the last transaction displayed in the upper panel. 

 If you click any of these four icons after making changes in the currently selected transaction, you will be 

prompted by a small dialog box: "Current Record Has Been Changed! Save?" Click Yes. 

 Click the Delete Record icon to delete the currently selected transaction from the 
transactions file. 

 Click the Print File icon to print the currently displayed transactions file. 

 Click the Exit icon to close the Employee Master File. 
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 This green exit door icon is used to close the dialog box. Only the red exit door on the main tool bar exits 

the TimeKeeper-PC program. 

Opening a Transactions File 

When you choose View/Edit Invalid Punches from the Maintenance menu, the TK Error 
Transactions File is automatically displayed. You can choose to display any other transactions file. 

 You can view the TC Error Transactions File by opening that file after the TK Error Transactions File is 

displayed. 

To open a transactions file, choose the Open File option from the File menu, or click the Open File 
icon: 

 

You will be prompted by a small dialog box: "Update Invalid Punch File with Edits?" Click Yes to 
update the currently displayed file with the changes you have made. The Edit Erroneous 
Transactions window displays a blue bar which fills across a scale in the window. This bar marks 
the progress of the transfer of punch transactions from the temporary storage file back to the 
original invalid punches text file. When the transfer of punch transactions is completed, the Select 
File To Open dialog box is displayed: 

 

Click No to close the currently displayed file without updating it. The currently displayed file closes, 
and the Select File To Open dialog box is displayed. 

 If you close the currently displayed file without updating it, your changes will be lost. 

Click Time Keeper Error Transactions File to open the standard transactions file for TimeKeeper-
PC, which is TRANSERR.TXT. Click TC Error Transactions File to open the standard transactions 
file for TimeCosting-PC, which is PRDERR.TXT. 

Click Select to choose a non-standard file name. For Help using the Select button, click here.. 

 You can view the backup file for TK error transactions, whose standard name is TRANSERR.BAK. 

Click OK to open the file. The Edit Erroneous Transactions window displays a blue bar which fills 
across a scale in the window. This bar marks the progress of the transfer of punch transactions to 
a temporary file. When the transfer of punch transactions is completed, the selected transactions 
file is displayed. 

To Open a Transactions File 
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1. Choose the Open File option from the File menu, or click the Open File icon. You will be prompted by a small dialog 
box: "Update Invalid Punch File with Edits?" 

2. Click Yes to update the currently displayed file with the changes you have made. Click No to close the currently 
displayed file without updating it. The Select File To Open dialog box is displayed. 

3. Click to select one of the standard error transactions files, or click Select to choose a non-standard file name. 

4. Click OK. The selected transactions file is displayed. 

Saving a Transactions File Under a Different Name 

You can save a transactions file under a different name. This can be useful if you want to save 
information about invalid punches, to track down their causes. 

 A defective punch clock reports invalid punch times, such as 08:62. Those punches are stored in the 

TRANSERR.TXT error transactions file. When you correct these punches and update the punch file, the 

information about those errors is lost. If you save the transactions file under the name TRANSERR.OLD, 

you will have a record of the clock which is reporting invalid punch times. 

The Create Backup Copies option saves the old transaction file with the prefix *.BAK. However, 
this backup file is overwritten every time you update the punch file. To save a permanent copy of 
the erroneous transactions file, regardless of how many times you update the punch file, you need 
to save the transactions file under a different name. For Help using the Create Backup Copies 
option, click here. 

To save a transactions file under a different name, choose the Save File As option from the File 
menu, or click the Save File As icon: 

 

You will be prompted by a small dialog box: "Create New File From Current?" Click Yes. The 
Enter File Name To Save dialog box is displayed: 

 

File Location 

The Drives field on the bottom right displays the drive currently selected. You can choose a 
different drive by clicking the drop-down arrow in this field to open a list of drives. 

The name of the directory currently selected is displayed under the title Directories. 

The path of the directory currently selected is displayed in the large Directories panel on the right. 
The name of the directory currently selected is highlighted in this panel. 
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 In the example above, the path indicates that the directory currently selected, tk5win, is a sub-directory of 

lavie, which is a directory in the c:\ drive. 

Double-click any level of the path to open a list of directories on the level below. 

 You can double-click the c:\ drive to open a list of all directories of c:\. You can also double-click the lavie 

directory to open a list of all sub-directories of lavie. 

Click to select any directory on the path displayed. The selected directory is highlighted, and its 
name is displayed under the title Directories. 

File Type 

The file type is displayed in the List Files of Type field. You can choose a file type by clicking the 
drop-down arrow in this field to open a list of file types. The three options are: 

 User Defined: Choose this option to display a list of files with a given filename or extension using wild card characters. 

 If you choose User Defined for the File Type, and enter P*.BAK in the File Name field, the Files panel will 

display only those files whose names start with P and whose suffixes are BAK -- for example, 

PRDERR.BAK. 

 After you enter the wild card characters in the File Name field, press <Enter> to see the results in the Files 

panel. 

 Only Files (*TXT): Choose this option to display only text files with the TXT suffix. 

 All Files: Choose this option to display all files. 

File Name 

The files of the selected type contained in the selected directory are displayed in the large Files 
panel on the left. When you use the up and down arrows to scroll through file names in the Files 
panel, the name of the file currently outlined is displayed in the File Name field. 

The standard file name for the TC Transactions File is PRDERR.TXT. The standard file name for 
the TK Transactions File is TRANSERR.TXT. 

Type the desired file name in the File Name field. Click OK to close the dialog box. 

To Save a Transactions File Under a Different Name 

1. Choose the Save File As option from the File menu, or click the Save File As icon. You will be prompted by a small 
dialog box: "Create New File From Current?" 

2. Click Yes. The Enter File Name To Save dialog box is displayed. 

3. Click the drop-down arrow in the Drives field to open a list of drives. 

4. Click to select a drive. The drop-down list closes, and the selected drive is displayed in the Drives field. 

5. Click to select a directory from the path in the Directories panel. The selected directory is highlighted, and its name is 
displayed under the title Directories. 

6. Click to select a file type. The drop-down list closes, and the selected file type is displayed in the List Files of Type 
field. The files of this type contained in the currently selected directory are displayed in the Files panel on the left. 

7. Type the desired file name in the File Name field. 

8. Click OK to close the dialog box. 

Sorting Transactions Files 

Each line in the upper panel of the Transactions File is a single invalid punch transaction. You can 
sort these transactions in the upper panel according to Badge number, clock number, or date. 
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To Sort Transactions in the Upper Panel 

1. Choose the Select Sort option from the File menu. The Select Sorts dialog box is displayed. 

2. Under the title Available Sorts, click the drop-down arrow to open a list of sorting options. 

3. Click an option to choose it and close the drop-down list. 

4. Click OK. The dialog box closes, and the transactions in the upper panel are displayed according to the sorting option 
chosen. 

Printing a Transactions File 

You can print a single transaction or all transactions in a transactions file. You can print 
transactions with various levels of detail. You can print transactions in the order they are saved in 
the transactions file, or in the order they are currently displayed. 

To print transactions, choose Print Transactions from the File menu, press <Ctrl+P>, or click the 
Print icon: 

 

The Print Transactions dialog box is displayed: 

 

Print Detail 

Choose one of the following options for print detail: 

 Display Data Only: This option prints only the raw data included in the transactions file. Following is an example of a single 

printed transaction: 

99000000480000016-12-960220728J00010005100000 

 Transaction and Error Description Det.: This option prints the data in a table which duplicates the display in the lower panel of 

the Transactions File display. Following is an example of a single printed transaction: 

Transaction 99000000480000016-12-
960220728J00010005100000 

Clock # 99  

Badge # 48 Employee:   1017   DOUGLAS 
BOGDAN 

Date 16/12/199
6 
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Error # 0  

Record 
Type 

22 Minimum Detail Transaction 

Time 7:28  

Event J  

Job # 100  

Process # 510 Paint Chassis RG8000 

Sorting 

Choose one of the following options for sorting: 

 User Current Sort: This option prints the transactions in the order they are displayed in the upper panel of the Transactions 

File display. For Help sorting transactions files, click here. 

 User File Records Order: This option prints transactions in the order they are saved in the transactions file, which is by date. 

One or All 

Choose one of the following options: 

 Only For Current Transaction: This option prints the currently selected transaction only. 

 For All Transactions: This option prints the entire transactions file. 

To choose print options such as paper size and orientation, click Setup. The Print Setup dialog 
box is displayed. For Help choosing print options, click here. 

When you are done selecting print options, click Print to print the transactions. 

To Print a Transactions File 

1. Choose Print Transactions from the File menu, press <Ctrl+P>, or click the Print icon. The Print Transactions dialog 
box is displayed. 

2. Choose options for print detail, sorting, and the number of transactions to print. 

3. Click Setup to choose print options such as paper size and orientation. 

4. Click Print to print the transactions. 

Creating Backup Copies of Transactions Files 

The Create Backup Copies option saves the old transaction file with the prefix *.BAK every time 
you update the punch file. This backup file can be useful if you want to view recent invalid 
punches which have been corrected. 

When Create Backup Copies is enabled, the backup file is overwritten every time you update the 
punch file. To save a permanent copy of the erroneous transactions file, regardless of how many 
times you update the punch file, you need to save the transactions file under a different name. For 
Help using the Save File As option, click here. 

When Create Backup Copies is enabled, a check mark is displayed next to the Create Backup 
Copies option in the File menu. 

When Create Backup Copies is enabled, click the option in the File menu to disable it. When 
Create Backup Copies is disabled, click the option in the File menu to enable it. 

Deleting Transactions 

There are three ways to delete transactions from a transactions file: 
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 Delete a single transaction from a file 

 Delete some of the transactions from a file 

 Delete all of the transactions from a file 

 Transaction deletion is like any other change made to a transactions file. If you close the currently 

displayed file without updating it, your changes will be lost, and the deleted transactions will remain in the 

file. 

Deleting a Single Transaction from a File 

You can delete a single transaction from a transactions file. 

 If the currently selected transaction has been superseded by a valid punch, you can delete the invalid 

punch with this command. 

For Help deleting some or all of the transactions from a file, click here. 

To Delete a Single Transaction from a File 

1. Click in the upper window to select the transaction you want to delete. 

2. Choose Delete Transaction from the Record menu, press <F6>, or click the Delete Record icon: 

 

3. You will be prompted by a small dialog box: "Delete Current Transaction?". 

4. Click Yes. The selected transaction is deleted from the file. 

Deleting Some of the Transactions from a File 

You can delete a group of transactions from a transactions file. A group of transactions can be 
marked for deleting by clock number, Badge number, Date, or transaction type. 

 When technicians install a new punch clock, they may use a dummy badge to test the clock's performance. 

You can delete all of the punches from that badge number. 

For Help deleting a single transaction or all of the transactions from a file, click here. 

To delete a group of transactions from a transactions file, choose Partial Deletion from the File 
menu or press <Shift+F6>. The Select Transactions to Delete dialog box is displayed: 
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For Clock Number, Badge number, and Date, you can choose to delete all transactions or a 
specified range of transactions. For Transaction Type, you can choose to delete all transactions or 
a specified type of transaction. 

To delete a group of transactions according to a single field, specify a range or type for that field 
and set the other fields to All. You can also choose options for more than one field. Only the 
transactions which fit all of the specified values are deleted. 

 If you set Clock to a range of 3 to 9, and Transaction Type to Emergency Call-Back Entry, then only the 

Emergency Call-Back Entry punches from those clocks will be deleted. 

To Specify a Range for Clock Number, Badge Number, or Date 

1. Click the drop-down arrow next to the appropriate field. 

2. Click Range. 

3. Double-click the From field and type the first number in the range. 

4. Double-click the To field and type the last number in the range. 

 When the drop-down list is set to All, the From and To fields are disabled. 

To Specify a Transaction Type 

1. Click the drop-down arrow next to the Transaction Type field. 

2. Click Selected Type. 

3. Click the drop-down arrow next to the Type field to open a list of Transaction Types. 

4. Click to choose a transaction type and close the drop-down list. 

 When the Transaction Type field is set to All, the Type field is disabled. 

When you are done selecting the group of transactions to be deleted, click Delete. The selected 
transactions are deleted from the file. 

You will be prompted by a small dialog box: "Update Invalid Punch File with Edits?" 

 If you want to update the currently displayed file with the changes you have made, click Yes. 

 If you want to close the currently displayed file without updating it, click No. 

 If you want to continue working without exiting, click Cancel. 

Deleting All of the Transactions from a File 

You can delete all of the transactions from a transactions file. 

 When a new clock system is installed, a series of test punches may be entered into the system. You can 

delete all of these punches from the invalid transactions file. 

For Help deleting a single transaction or some of the transactions from a file, click here. 

To Delete All of the Transactions from a File 

1. Choose Delete Transactions from the File menu, or press <Ctrl+F6>. You will be prompted by a small dialog box: 
"Delete All Transactions?". 

2. Click Yes. All transactions are deleted from the file. 

Saving a Transaction 

You need to save a transaction every time you make changes and select another transaction. 
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 If you do not save the changed transaction, your changes will be lost immediately when you select another 

transaction. 

To save the currently selected transaction, choose Save Transaction from the Record menu, 
press <Ctrl+S>, or click the Save Record icon: 

 

You will be prompted by a small dialog box: "Current Record Has Been Changed! Save?" Click 
Yes. 

Editing TC Transactions 

The lower (Transaction to Edit) panel of the Transactions File displays the transaction currently 
selected in the upper panel. Each line in the Transaction to Edit panel displays one element of the 
transaction. The line whose element is invalid is highlighted in yellow. Click any line to select it. 

You can also select transactions using the Go To icons on the tool bar, or the Go To options in the 

Record menu on the menu bar. You can also use the  and  arrows on the vertical scroll bar 
to move one page up or down in the upper panel. 

When you correct an invalid element, it continues to be highlighted in yellow. The next time you 
update the TC Error Transactions File (assuming you have reread the new, corrected, invalid 
punch file), that transaction will not be displayed. 

 

Press <Tab> to move forward to the next column and select it. Hold <Shift> and press <Tab> to 
move backward to the previous column and select it. You can also use the vertical scroll bar on 
the right to scroll up and down lines. 

The following columns are displayed in the Transaction to Edit panel: 

 Item: This column contains the name of the element described on that line. The elements which you will most commonly edit 

are the Badge number and Department number. For examples of invalid punches, click here. 

 Data: This column contains the transaction data. 

 Description: This column contains a description of some transaction elements. 

 In the example above, Record Type 22 includes the description "Minimum Detail Transaction". 

 Error Message: This column contains a description of the error found in the transaction. 

To correct an error, click the Data column on the line where the error is highlighted. A drop-down 
arrow is displayed in that field. Click the arrow to display a list of valid values for that element. 
Click the desired value to close the list and display that value in the Transaction to Edit panel. 



  22 

 In the example above, the Badge number 8765 is invalid. Click the invalid Badge number to display a drop-

down arrow in the field. Click the drop-down arrow to display a list of valid Badge numbers and 

corresponding Employee names. You can click the valid Badge number 17 to close the list and display the 

value 17 in the Badge number field. The corresponding Employee name is displayed in the Description 

column. 

To view your changes to the transaction in the upper panel, click Apply. 

After you correct the error in the transaction, save the transaction by choosing Save Transaction 
from the Record menu, pressing <Ctrl+S>, or clicking the Save Record icon: 

 

You will be prompted by a small dialog box: "Current Record Has Been Changed! Save?" Click 
Yes. 

You can also directly edit the invalid punch transaction data. For Help directly editing invalid punch 
transaction data, click here. 

Select another transaction to edit. When you are done editing transactions, choose Exit from the 
File menu, or click the Exit icon: 

 

You can also open another transactions file for editing. For Help opening a transactions file, click 
here. 

Full Transaction Editing 

You can directly edit punch transaction data. Use this option only if you are completely familiar 
with the structure and interpretation of raw transaction data in your system. 

To Directly Edit Punch Transaction Data 

1. Click to select a transaction. 

2. Double-click the transaction to display the Full Transaction Edit dialog box: 

 

3. Edit the transaction data as needed. 

4. Click OK to close the Full Transaction Edit dialog box. 

5. Save the transaction by choosing Save Transaction from the Record menu, pressing <Ctrl+S>, or clicking the Save 
Record icon: 

 

6. You will be prompted by a small dialog box: "Current Record Has Been Changed! Save?" Click Yes. 

Viewing and Editing Invalid TC Punches -- Where 

Do I Go Next? 
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When you are done editing transactions, choose Exit from the File menu, or click the Exit icon: 

 

You will be prompted by a small dialog box: "Update Invalid Punch File with Edits?" 

 If you want to update the currently displayed file with the changes you have made, click Yes. 

 If you want to close the currently displayed file without updating it, click No. 

 If you want to continue working without exiting, click Cancel. 

You can also open another transactions file for editing. For Help opening a transactions file, click 
here. 

After you edit invalid TC punches, you need to produce the TC Errors & Exceptions Report. For 
Help producing the TC Errors & Exceptions Report, click here. 

TC Errors & Exceptions Report 

What Is It? 

The TC Errors & Exceptions Report finds mistakes and inconsistencies in input data. 

An Error shows that TC cannot calculate costs because of an incorrect Contract definition, 
uncalculated Record, or invalid pay category definitions. 

 A Record which has been changed but not recalculated is labeled on this report with an Error. 

 An Employee whose Contract has no Regular pay category definition in TC Setup is labeled on this report 

with an Error. 

An Exception shows that TC cannot calculate costs because pay categories or rate codes have 
been disabled. 

 An Employee whose Contract defines all pay categories in TC Setup as "Not In Use" is labeled on this 

report with an Exception. 

Why Do I Need It? 

Errors must be corrected because TimeCosting-PC cannot calculate costs for an Employee with 
invalid Contract definitions. 

If Exceptions are not corrected, TimeCosting-PC will calculate costs to zero. 

TC Errors and Exceptions are corrected using TC Setup. For Help setting up TimeCosting-PC, 
click here. 

 

Producing the Report  

Reading the Report 

Where Do I Go Next? 

What Other Reports Can I Produce? 

An Error shows that TC cannot calculate costs because of an incorrect Contract definition, 
uncalculated Record, or invalid pay category definitions. 
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An Exception shows that TC cannot calculate costs because pay categories or rate codes have 
been disabled. 

Producing a TC Errors & Exceptions Report 

 Before you can produce this report, you need to edit invalid punches in the original time data input. For 

Help editing invalid punches, click here. 

To Preview a Draft of the Report 

1. Choose Reports & Graphs from the main menu bar. 

2. Choose TC Daily Activity Reports. The Select Report to Process dialog box is displayed. 

3. Choose TC Errors & Exceptions and click OK. The TC Errors & Exceptions Report dialog box opens, with the current 
Report Parameters displayed in the white Report Parameters box at the bottom of the dialog box. 

4. Choose the report parameters to specify the information you need. For Help choosing Report Parameters, click here. 

5. Choose Output Options from the Report menu bar. The Output Options dialog box opens. 

6. Click the arrow next to the Send Report To field. Choose Print Preview from the drop-down list. Click OK. 

7. Choose Start Report from the Report menu bar, or click the Start Report icon: 

 

8. The report is displayed on the screen exactly as it will appear on your printer. For Help reading the report, click here. 

If You Need Help Making Changes in the Report: 

 If the report does not display the information you need, click here. 

 If part of the report is cut off, or if some of the characters are not visible, click here. 

 If you want to change the fonts used in the report, click here. 

 If you need help making any other changes in the report, click here. 

To Produce the Report 

1. Choose Output Options from the Report menu bar. The Output Options dialog box opens. For Help filling in this 
dialog box, click here. 

 If you chose Send Report To Printer, choose Print Setup from the File Menu in the Report menu bar, or 

click the Print Setup icon. For Help choosing print options, click here. 

2. Choose Start Report from the Report menu bar, or click the Start Report icon: 

 

You have now produced the TC Errors & Exceptions report. 

TC Errors & Exceptions Report Dialog Box 

Choose TC Errors & Exceptions from the TC Daily Activity Reports option on the Reports & 
Graphs menu. The TC Errors & Exceptions Report dialog box opens, with the current report 
parameters displayed in the white Report Parameters box. 
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Report Parameters Box 

The Report Parameters box is the white box at the bottom of the dialog box with black and blue 
characters. The blue characters display parameter names, and the black characters display the 
values currently chosen for them. When you first load a report, the values displayed are the 
default values. 

The top panel of the box displays the dates covered by the report. In the example above, the 
report covers input data for December 22, 1998. For Help choosing Report Dates, click here. 

The left-hand panel of the box displays the Report Range values. These are the ranges of data 
covered by the report for the various levels of your organization. 

 In the example above, the report includes data from Plants 10 through 17, Sites 22 through 28 at those 

Plants, all of the Departments at those Sites, and Employees number 1 through 9999 in those Departments. 

 Employees assigned to Plant 12, Site 25, and any Department, will be included. Employees assigned to 

Plant 18 will not be included, because Plant 18 is outside the currently selected range of Plants 10 through 

17. 

 You can use a synonym for any level of your organization. 

Each item on the left-hand panel corresponds to a menu on the Report Menu Bar. For Help 
choosing Report Range values, click here. 

The right-hand panel of the box displays the Output Options parameters. These determine certain 
aspects of the report's appearance when it is sent to the Print Preview, the printer, the screen, or 
a file. For Help choosing Output Options parameters, click here. 

You can also change parameters without using the report menus. Double-click any black or blue 
text in the Report Parameters box to open the dialog box for the corresponding parameter. Click 
OK to close a dialog box, and the parameter displayed in the Report Parameters box is 
automatically updated. 
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 To change the default dates covered by the report, double-click the word Date in the top panel of the box. 

The Date dialog box opens, allowing you to change the default dates. 

If you have used the Select option to change Dates or Report Ranges during the current run of the 
report, double-clicking opens the Select dialog box instead of the Default dialog box. 

You can also open Date and Report Range menus with the right mouse button. Right-click any 
black or blue text in the top or left-hand panels to open the corresponding report menu within the 
Report Parameters box. 

 To open the Date menu, right-click the word Date in the top panel of the box. The Date menu is displayed 

within the Report Parameters box, allowing you to choose the Select or Default option. 

Report Bars 

The Report title bar, Report menu bar, and Report tool bar are always displayed at the top of this 
dialog box. 

The Report title bar displays the name of the report. 

The Report Menu Bar contains the menu options available for reports. 

The Report Tool Bar contains the icons available for reports. 

TC Errors & Exceptions Report Menu Bar 

The following options are displayed on the TC Errors & Exceptions Report menu bar. Click any 
highlighted option on this list for Help using that menu option. 

File menu: 

 Change Report: Choose this option to open the Select Report to Process dialog box. Click to choose any TC Daily Activity 

Report from the list. For Help using TC Daily Activity Reports, click here.

 Fonts 

 Print Setup 

 Set Char. Width 

 Save 

 Restore Default Fonts: Choose this option to restore system default settings for report fonts. 

 Exit 

Date menu 

Report Range menus: 

 Plant 

 Site 

 Department 

Employee menu: 

 All 

 Select 

 Default 

 Sort By Number: Choose this option to sort the Employees by number on the list displayed by the Select option. 
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 Sort By Name: Choose this option to sort the Employees by name on the list displayed by the Select option. 

Output Options 

Start Report: Choose this option to produce a report according to the parameters you have 
chosen. 

Choosing Employees for Reports 

When you choose Select from the Employee menu, the Employee Details/Shared dialog box is 
displayed: 

 

The dialog box displays the following columns: 

 Employee Number 

 Employee Last Name 

 Employee First Name 

Selected Employees are displayed as raised gray buttons with white characters. In the example 
above, the first and third Employees are currently selected. 

Click to select any Employee. Click to deselect any selected Employee. Click Deselect All to 
deselect all Employees. Click Select All to select all Employees. 

To find any character string in the dialog box, type the string in the field next to the Find button. 
Click Find to find the first instance of that string. Click Find Next to find the next instance of that 
string. 

When the desired Employees are selected, click OK. The Employee Details/Shared dialog box 
closes, and the number of selected Employees is displayed in the left panel of the Report dialog 
box. 

Report Output Options 

For the TC Errors & Exceptions Report 

This dialog box determines certain aspects of the report's content and appearance. 

Choose Output Options to open the Output Options dialog box. 
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Press <Tab> to move forward to the next field and select it. Hold <Shift> and press <Tab> to 
move backward to the previous field and select it. 

Calculate TCDAY 

The first field displayed in this dialog box is the Calculate TCDAY field. When you produce any 
Daily Activity Report in TimeCosting-PC , the program can automatically recalculate Records in 
the TC  Daily Activity File. However, the TC Daily Activity File can contain a large number of 
Records for a single day, and it can be unwieldy and time-consuming to recalculate all of them 
every time you produce a report. 

Normally, there is no need to recalculate the records in the TC Daily Activity file prior to running 
the report (as the calculations are automatically performed whenever data is either entered or 
modified). However, if you are unsure that the calculations are current or valid, enable this option. 

 Type 0 (recommended) to produce a report without calculating TCDAY Records. 

 Type 1 to calculate TCDAY Records automatically when you produce a report. 

The next six fields in this dialog box are drop-down lists. To choose an option from any of these 
fields, click the arrow to the right of the field. A list of options is displayed, with the current option 
displayed in a dark gray box with white characters. Click to choose an option. 

Level Output Format 

You can display level elements by number and name, or by number only. 

 If you choose Number, then Process # 345 Wheel Alignment will be displayed on this report as Process 

345. 

 Choose Number to display level elements by number only. 

 Choose Name to display level elements by number and name. 

Records Type 

While the TC Errors & Exceptions Report examines input data records for all Employees selected 
in the Employee menu, you can choose which data records are displayed in the report output. 

An Error shows that TC cannot calculate costs because of an incorrect Contract definition, 
uncalculated Record, or invalid pay category definitions. 

An Exception shows that TC cannot calculate costs because pay categories or rate codes have 
been disabled. 

 Errors & Exceptions: Choose this option to display output covering all Employees labeled with an Error or an Exception. 

 Errors Only: Choose this option to display output covering only those Employees labeled with an Error. 

 Exceptions Only: Choose this option to display output covering only those Employees labeled with an Exception. 

 All Records: Choose this option to display output covering all Employees, including those who are not labeled with any Errors 

or Exceptions. 

Page Break On Change Of 

You can choose where to place page breaks in the report output: 

 Date: Choose this option to start a new page at the beginning of each Day in the report. 

 Plant: Choose this option to start a new page at the beginning of each Plant in the report. 

 Site: Choose this option to start a new page at the beginning of each Site in the report. 

 Department: Choose this option to start a new page at the beginning of each Department in the report. 
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 You can use a synonym for any level of your organization. 

Work Order/Batch Display 

 Work Order: Choose this option to display work orders in the report. 

 Batch: Choose this option to display batches in the report. 

 Work Order and Batch: Choose this option to display both work orders and batches in the report. 

 None: Choose this option to display neither work orders nor batches in the report. 

Part/Process Display 

 Part: Choose this option to display parts in the report. 

 Process: Choose this option to display processes in the report. 

 Part and Process: Choose this option to display both parts and processes in the report. 

 None: Choose this option to display neither parts nor processes in the report. 

 For the purposes of this Help file, time-costing levels are sometimes referred to by the following names:  

 Level 1 Level 2 Level 3 Level 4 

 Work order Batch Part Process 

Send Report To 

You can choose where to display the report output: 

 Print Preview: Choose this option to view the report on the screen page by page, exactly as it will appear in the printer output. 

 The Print Preview begins by displaying the first page of the report. Click Next to see the next page of the 

report, unless you are viewing the last page of the report. Click Close to close the Print Preview. 

 Printer: Choose this option to send the report to a printer. If you choose this option, make sure your print setup is correct by 

choosing Print Setup from the File Menu in the Report menu bar. For Help using Print Setup, click here. 

 Screen: Choose this option to display the report output on your screen. This option allows you to review the report without 

producing a hard copy. For Help reading the Screen display of your report, click here. 

 File: Choose this option to send the report output to a plain text file. When you choose this option, a new field is displayed to 

the right of the arrow on this line. Click that field and type the name of the file. 

 The report output is sent to a plain text file in the Tk5win folder or directory. This file can then be easily 

accessed for use by other applications, such as word processors. 

Footer Text 

The last two fields in this dialog box are text fields for the Footer text which is displayed at the 
bottom of each page of the report output. This text is optional. 

 You can use this Footer text for the name and signature of the supervisor checking the report printout, for 

notes relating to the content of the report, or for holiday messages. 

If you want to include a line of text in the Footer, click the Footer Text 1 field and type the desired 
text. If you want to add a second line of text, click the Footer Text 2 field and type the desired text. 
You can type up to 40 characters in each field. 
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After you choose the desired options from all six fields, click OK to close the Output Options 
dialog box. The options you have chosen are displayed in the right-hand panel of the Report 
Parameters box. 

Reading the TC Errors & Exceptions Report 

 Before you can read this report, you need to produce it. For Help producing this report, click here. 

The Errors & Exceptions Report displays each Department separately. Each Department includes 
a list of Employees and their beginning and ending times in various jobs. 

For a graphic example of a Daily Transactions Report, click here. 

Header 

The top of each page of the report (the Header) displays: 

 at the top center, the User Name (for example, "Punctual Products, Inc."), which is the User Name defined in the system 

configuration 

 on the top left, the number and title of the report and the date range covered by the report 

 on the top right, the current page number and the date and time that the report was produced 

Sub-Headers 

The first line of each Department section (the sub-Header) displays the Department number and 
name. You can find lists of Department numbers and names in the Shared Set-Up Files Reports. 

The first line of each Employee section displays the Employee number and name. You can find 
lists of Employee numbers and names in Employee Lists. 

 You can use a synonym for any level of your organization. 

Body 

The Body of the report is comprised of columns. The columns in each Department display: 

 the Employee Number, Name, and Contract 

 the currently active levels (Work Order, Batch, Part, and Process) and Cost Center 

 the Start and End times for each Employee in each job 

 the Error or Exception message being reported 

 If an Employee works one more than one job in a single day, information for each job will be displayed on a 

separate line. After the first line for each Employee, additional lines for the same Employee do not display 

Employee information. 

A summary (the sub-Total) is displayed at the end of each Employee, Department, and Date in 
the report. The summary of the entire report is displayed at the end of the report. 

Footer 

The bottom of each page of the report (the Footer) displays: 

 on the bottom left, above the line: the Footer text which was defined in the Output Options dialog box 

 on the bottom left, below the line: copyright information regarding TimeCosting-PC 
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 on the bottom right, below the line: the name and creation date of the executable program used to produce the report, the font 

name and size chosen in the Fonts dialog box, and the character width chosen in the Percents dialog box 

When you send a report to the Screen or Print Preview, TimeCosting-PC tells you which page you 
are viewing. On the bottom right of your screen, below the horizontal scroll bar, the current page 
number and total number of pages are displayed. 

 If you are viewing the third page of a five-page report, the legend "Page 3 of 5" will be displayed. 

After You Read the Report 

If you sent the report to the Screen or Print Preview, you need to close the report to return to the 
report dialog box. 

To close a Screen report, click the Exit Program icon: 

 

To close a Print Preview, click Close. 

Click here to close this window. 

Click on any of the three outlined areas to view in detail. 
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Errors & Exceptions Report -- Where Do I Go 

Next? 

If you wish to retain any modifications to the report parameters and have not yet saved them, click 
the Save Record icon now: 

 

You will be prompted by a small dialog box: "Save Changes To File?" Click Yes to save to the 
settings. 

Click the Exit icon to close the report dialog box: 

 

After you produce the TC Errors & Exceptions Report, you need to redefine TC Setup to correct 
Errors and account for Exceptions. For Help setting up TimeCosting-PC, click here. 

After you redefine TC Setup to correct Errors and account for Exceptions, you need to produce the 
Daily Transactions Report. For Help producing the Daily Transactions Report, click here. 

What Other Reports Can I Produce? 

Daily Transactions Report 

 Before you can produce this report, you need to edit invalid punches in the original time data input. For 

Help editing invalid punches, click here. 
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What Is It? 

The Daily Transactions Report displays time-costing data for Employees according to the 
parameters you have chosen. 

 In a technical writing firm, this report can display all the Employees who worked on translations during the 

month of June. 

Why Do I Need It? 

Process supervisors can check the Employee hours for which they are being charged, and 
indicate any changes that need to be made. 

Employee can check the hours worked by an individual Employee in their default process or any 
other process, and indicate any changes that need to be made. 

For Help making changes in time-costing input data, click here. 

 

Producing the Report  

Reading the Report 

Where Do I Go Next? 

What Other Reports Can I Produce? 

Producing a Daily Transactions Report 

 Before you can produce this report, you need to edit invalid punches in the original time data input. For 

Help editing invalid punches, click here. 

To Preview a Draft of the Report 

1. Choose Reports & Graphs from the main menu bar. 

2. Choose TC Daily Activity Reports. The Select Report to Process dialog box is displayed. 

3. Choose TC Daily Transactions Report and click OK. The TC Daily Transactions Report dialog box opens, with the 
current Report Parameters displayed in the white Report Parameters box at the bottom of the dialog box. 

4. Choose the report parameters to specify the information you need. For Help choosing Report Parameters, click here. 

5. Choose Output Options from the Report menu bar. The Output Options dialog box opens. 

6. Click the arrow next to the Send Report To field. Choose Print Preview from the drop-down list. Click OK. 

7. Choose Start Report from the Report menu bar, or click the Start Report icon: 

 

8. The report is displayed on the screen exactly as it will appear on your printer. For Help reading the report, click here. 

If You Need Help Making Changes in the Report: 

 If the report does not display the information you need, click here. 

 If part of the report is cut off, or if some of the characters are not visible, click here. 

 If you want to change the fonts used in the report, click here. 

 If you need help making any other changes in the report, click here. 

To Produce the Report 
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1. Choose Output Options from the Report menu bar. The Output Options dialog box opens. For Help filling in this 
dialog box, click here. 

 If you chose Send Report To Printer, choose Print Setup from the File Menu in the Report menu bar, or 

click the Print Setup icon. For Help choosing print options, click here. 

2. Choose Start Report from the Report menu bar, or click the Start Report icon: 

 

You have now produced the Daily Transactions report. 

Daily Transactions Report Dialog Box 

Choose TC Daily Transactions Report from the TC Daily Activity Reports option on the Reports & 
Graphs menu. The TC Daily Transactions dialog box opens, with the current report parameters 
displayed in the white Report Parameters box. 

 

Report Parameters Box 

The Report Parameters box is the white box at the bottom of the dialog box with black and blue 
characters. The blue characters display parameter names, and the black characters display the 
values currently chosen for them. When you first load a report, the values displayed are the 
default values. 

The top panel of the box displays the dates covered by the report. In the example above, the 
report covers input data for December 22, 1998. For Help choosing Report Dates, click here. 

The left-hand panel of the box displays the Report Range values. These are the ranges of data 
covered by the report for the various levels of your organization. 

 In the example above, the report includes data from Plants 10 through 17, Sites 22 through 28 at those 

Plants, all of the Departments at those Sites, and Employees number 1 through 9999 in those Departments. 
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 Employees assigned to Plant 12, Site 25, and any Department, will be included. Employees assigned to 

Plant 18 will not be included, because Plant 18 is outside the currently selected range of Plants 10 through 

17. 

 You can use a synonym for any level of your organization. 

Each item on the left-hand panel corresponds to a menu on the Report Menu Bar. For Help 
choosing Report Range values, click here. 

The right-hand panel of the box displays the Output Options parameters. These determine certain 
aspects of the report's appearance when it is sent to the Print Preview, the printer, the screen, or 
a file. For Help choosing Output Options parameters, click here. 

You can also change parameters without using the report menus. Double-click any black or blue 
text in the Report Parameters box to open the dialog box for the corresponding parameter. Click 
OK to close a dialog box, and the parameter displayed in the Report Parameters box is 
automatically updated. 

 To change the default dates covered by the report, double-click the word Date in the top panel of the box. 

The Date dialog box opens, allowing you to change the default dates. 

If you have used the Select option to change Dates or Report Ranges during the current run of the 
report, double-clicking opens the Select dialog box instead of the Default dialog box. 

You can also open Date and Report Range menus with the right mouse button. Right-click any 
black or blue text in the top or left-hand panels to open the corresponding report menu within the 
Report Parameters box. 

 To open the Date menu, right-click the word Date in the top panel of the box. The Date menu is displayed 

within the Report Parameters box, allowing you to choose the Select or Default option. 

Report Bars 

The Report title bar, Report menu bar, and Report tool bar are always displayed at the top of this 
dialog box. 

The Report title bar displays the name of the report. 

The Report Menu Bar contains the menu options available for reports. 

The Report Tool Bar contains the icons available for reports. 

Reading the Daily Transactions Report 

 Before you can read this report, you need to produce it. For Help producing this report, click here. 

The Daily Transactions Report displays each Department separately. Each Department includes a 
list of Employees and their beginning and ending times in various jobs. 

For a graphic example of a Daily Transactions Report, click here. 

Header 

The top of each page of the report (the Header) displays: 

 at the top center, the User Name (for example, "Punctual Products, Inc."), which is the User Name defined in the system 

configuration 

 on the top left, the number and title of the report and the date range covered by the report 
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 on the top right, the current page number and the date and time that the report was produced 

Sub-Headers 

The first line of each Department section (the sub-Header) displays the Department number and 
name. You can find lists of Department numbers and names in the Shared Set-Up Files Reports. 

The first line of each Employee section displays the Employee number and name. You can find 
lists of Employee numbers and names in Employee Lists. 

 You can use a synonym for any level of your organization. 

Body 

The Body of the report is comprised of columns. The columns in each Department display: 

 the Employee Number and Name 

 the currently active levels (Work Order, Batch, Part, and Process) and Cost Center 

 the Start and End times for each Employee in each job 

 the Net Duration of hours between the Start and End times 

 the Rate applied to those hours 

 the Cost for those hours, if the Auto Calculate Type is set to Duration 

 the Quantity for those hours, if the Auto Calculate Type is set to Quantity 

 Update Code: indicates whether the Record has been manually updated. An Update Code of 1 indicates that the Record has 

been manually updated, but not yet calculated. Otherwise, the Update Code is 2. 

 the distribution of the Net Duration between TC Pay Categories 

 If an Employee works one more than one job in a single day, information for each job will be displayed on a 

separate line. After the first line for each Employee, additional lines for the same Employee do not display 

Employee information. 

If you choose Statistical Summary Enabled in the Output Options dialog box, a summary (the sub-
Total) is displayed at the end of each Employee, Department, and Date in the report. The 
summary of the entire report is displayed at the end of the report. 

Footer 

The bottom of each page of the report (the Footer) displays: 

 on the bottom left, above the line: the Footer text which was defined in the Output Options dialog box 

 on the bottom left, below the line: copyright information regarding Departmental Allocation-PC 

 on the bottom right, below the line: the name and creation date of the executable program used to produce the report, the font 

name and size chosen in the Fonts dialog box, and the character width chosen in the Percents dialog box 

When you send a report to the Screen or Print Preview, TimeCosting-PC tells you which page you 
are viewing. On the bottom right of your screen, below the horizontal scroll bar, the current page 
number and total number of pages are displayed. 

 If you are viewing the third page of a five-page report, the legend "Page 3 of 5" will be displayed. 

After You Read the Report 
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If you sent the report to the Screen or Print Preview, you need to close the report to return to the 
report dialog box. 

To close a Screen report, click the Exit Program icon: 

 

To close a Print Preview, click Close. 

Click here to close this window.Reading_the_Daily_Transactions_Report>main 

Click on any of the three outlined areas to view in detail. 
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Report Output Options 

For the Daily Transactions Report 

This dialog box determines certain aspects of the report's content and appearance. 

Choose Output Options to open the Output Options dialog box. 

Press <Tab> to move forward to the next field and select it. Hold <Shift> and press <Tab> to 
move backward to the previous field and select it. 

Calculate TCDAY 

The first field displayed in this dialog box is the Calculate TCDAY field. When you produce any 
Daily Activity Report in TimeCosting-PC , the program can automatically recalculate Records in 
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the TC  Daily Activity File. However, the TC Daily Activity File can contain a large number of 
Records for a single day, and it can be unwieldy and time-consuming to recalculate all of them 
every time you produce a report. 

Normally, there is no need to recalculate the records in the TC Daily Activity file prior to running 
the report (as the calculations are automatically performed whenever data is either entered or 
modified). However, if you are unsure that the calculations are current or valid, enable this option. 

 Type 0 (recommended) to produce a report without calculating TCDAY Records. 

 Type 1 to calculate TCDAY Records automatically when you produce a report. 

The next six fields in this dialog box are drop-down lists. To choose an option from any of these 
fields, click the arrow to the right of the field. A list of options is displayed, with the current option 
displayed in a dark gray box with white characters. Click to choose an option. 

Level Output Format 

You can display level elements by number and name, or by number only. 

 If you choose Number, then Process # 345 Wheel Alignment will be displayed on this report as Process 

345. 

 Choose Number to display level elements by number only. 

 Choose Name to display level elements by number and name. 

Print Statistical Summary 

You can display a Statistical Summary at the end of each Department, Site, Plant, and Date in the 
report, and a summary of the entire report at the end of the report. The summary includes: 

 the total number of Errors 

 the total number of Exceptions 

 the total number of Employees without Errors or Exceptions ("Good") 

The options for the Statistical Summary are: 

 Disabled: Choose this option to display output without Statistical Summaries. 

 Enabled: Choose this option to display output with Statistical Summaries. 

Page Break On Change Of 

You can choose where to place page breaks in the report output: 

 Date: Choose this option to start a new page at the beginning of each Day in the report. 

 Plant: Choose this option to start a new page at the beginning of each Plant in the report. 

 Site: Choose this option to start a new page at the beginning of each Site in the report. 

 Department: Choose this option to start a new page at the beginning of each Department in the report. 

 You can use a synonym for any level of your organization. 

Work Order/Batch Display 

 Work Order: Choose this option to display work orders in the report. 

 Batch: Choose this option to display batches in the report. 

 Work Order and Batch: Choose this option to display both work orders and batches in the report. 
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 None: Choose this option to display neither work orders nor batches in the report. 

Part/Process Display 

 Part: Choose this option to display parts in the report. 

 Process: Choose this option to display processes in the report. 

 Part and Process: Choose this option to display both parts and processes in the report. 

 None: Choose this option to display neither parts nor processes in the report. 

 For the purposes of this Help file, time-costing levels are sometimes referred to by the following names:  

 Level 1 Level 2 Level 3 Level 4 

 Work order Batch Part Process 

Send Report To 

You can choose where to display the report output: 

 Print Preview: Choose this option to view the report on the screen page by page, exactly as it will appear in the printer output. 

 The Print Preview begins by displaying the first page of the report. Click Next to see the next page of the 

report, unless you are viewing the last page of the report. Click Close to close the Print Preview. 

 Printer: Choose this option to send the report to a printer. If you choose this option, make sure your print setup is correct by 

choosing Print Setup from the File Menu in the Report menu bar. For Help using Print Setup, click here. 

 Screen: Choose this option to display the report output on your screen. This option allows you to review the report without 

producing a hard copy. For Help reading the Screen display of your report, click here. 

 File: Choose this option to send the report output to a plain text file. When you choose this option, a new field is displayed to 

the right of the arrow on this line. Click that field and type the name of the file. 

 The report output is sent to a plain text file in the Tk5win folder or directory. This file can then be easily 

accessed for use by other applications, such as word processors. 

Footer Text 

The last two fields in this dialog box are text fields for the Footer text which is displayed at the 
bottom of each page of the report output. This text is optional. 

 You can use this Footer text for the name and signature of the supervisor checking the report printout, for 

notes relating to the content of the report, or for holiday messages. 

If you want to include a line of text in the Footer, click the Footer Text 1 field and type the desired 
text. If you want to add a second line of text, click the Footer Text 2 field and type the desired text. 
You may type up to 40 characters in each field. 

After you choose the desired options from all ten fields, click OK to close the Output Options 
dialog box. The options you have chosen are displayed in the right-hand panel of the Report 
Parameters box. 

Daily Transactions Report Menu Bar 

The following options are displayed on the TC Daily Transactions Report menu bar. Click any 
highlighted option on this list for Help using that menu option. 
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File menu: 

 Change Report: Choose this option to open the Select Report to Process dialog box. Click to choose any TC Daily Activity 

Report from the list. For Help using TC Daily Activity Reports, click here.

 Fonts 

 Print Setup 

 Set Char. Width 

 Save 

 Restore Default Fonts: Choose this option to restore system default settings for report fonts. 

 Exit 

Date menu 

Report Range menus: 

 Plant 

 Site 

 Department 

Employee menu: 

 All 

 Select 

 Default 

 Sort By Number: Choose this option to sort the Employees by number on the list displayed by the Select option. 

 Sort By Name: Choose this option to sort the Employees by name on the list displayed by the Select option. 

Output Options 

Start Report: Choose this option to produce a report according to the parameters you have 
chosen. 

Daily Transactions Report -- Where Do I Go Next? 

If you wish to retain any modifications to the report parameters and have not yet saved them, click 
the Save Record icon now: 

 

You will be prompted by a small dialog box: "Save Changes To File?" Click Yes to save to the 
settings. 

Click the Exit icon to close the report dialog box: 

 

After you produce and read the Daily Transactions Report, you need to edit daily job transfers to 
modify Employee job transfers which are valid, but reflect incorrect information, and to add 
missing transfers. For Help editing daily job transfers, click here. 

What Other Reports Can I Produce? 

Editing Daily Job Transfers with the Daily Browser 
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What Is It? 

The Daily Browser (Department Daily Activity) displays Daily Activity files, which include Employee 
Absence Codes, Contract numbers, In and Out punches, initial pay calculations, and Error and 
Exception messages. You can display departmental (TC) daily activity in the Second File window 
of the Daily Browser. 

Use the Daily Browser to modify Employee job transfers which are valid, but reflect incorrect 
information. 

 An Employee begins work on one job, and enters the valid number of a different job. When the Employee's 

supervisor checks the TC Daily Transactions Report, the incorrect transfer is discovered. The supervisor 

can use the Daily Browser to modify the incorrect Employee job transfer. 

Use the Daily Browser to add missing job transfers. 

 An Employee begins work on a job and then moves to a different job, but forgets to punch into the new job. 

When the Employee's supervisor checks the TC Daily Transactions Report, the missing transfer is 

discovered. The supervisor can use the Daily Browser to add the missing Employee job transfer. 

Use the Daily Browser to delete transfers. 

 An Employee begins work on a job and then moves to a different job. The Employee's supervisor decides 

not to charge the time worked on the second job. The supervisor can use the Daily Browser to delete the 

second Employee job transfer. 

Why Do I Need It? 

The Daily Browser is also the most efficient way to modify valid but incorrect job transfers, to add 
missing transfers, and to delete transfers. 

The Daily Browser allows you to edit information only if it is based on valid punches. It is 
recommended that you also view and edit invalid punches on a daily basis. For Help viewing and 
editing invalid punches, click here. 

Advanced TimeCosting-PC functions allow you to edit Daily Activity by Employee, instead of by 
Department. For Help using advanced TC data editing, click here. 

Why Should I Produce the Daily Transactions Report First? 

When you print the Daily Transactions Report in a hard copy, you can then use that printed copy 
to make corrections by hand and add a supervisor's signature. Once they are reviewed and 
signed, job transfers are corrected using the Daily Browser. 

 

Editing a Daily Activity File 

Reading a Daily Activity File 

Where Do I Go Next? 

Editing a TC Daily Activity File 

 Before you edit daily job transfer activity, you need to produce both the Daily Transactions Report and the 

TC Errors & Exceptions Report. For Help producing the Daily Transactions Report, click here. For Help 

producing the TC Errors & Exceptions Report, click here. 

To Edit a Daily Activity File 
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1. Choose Daily Activity Data (by Department) from the Edit/View menu. The Select Range to Edit dialog box opens. 

2. Choose the Departments to be displayed. For Help choosing Departments, click here. 

3. Choose the date to be edited. For Help choosing a date to be edited, click here. 

4. Choose the Records Type to be displayed. For Help choosing a Records Type, click here. 

5. Click OK. The TC Daily Browser (Daily Activity File) dialog box opens. For Help reading the TC Daily Activity File, 
click here. 

6. Modify incorrect job transfers. For Help modifying job transfers, click here. 

7. Add missing job transfers. For Help adding missing job transfers, click here. 

8. Delete job transfers as you want. For Help deleting job transfers, click here. 

9. After you make all desired changes, click the Save Record icon: 

 

You have now edited the Daily Activity File. 

Choosing a Record Type for the TC Daily Browser 

You can choose which data records are displayed in the TC Daily Browser. 

An Error shows that TC cannot calculate costs because of an incorrect Contract definition, 
uncalculated Record, or invalid pay category definitions. 

An Exception shows that TC cannot calculate costs because pay categories or rate codes have 
been disabled. 

 All Records: Choose this option to edit data for all Employees, including those who are not labeled with any Errors or 

Exceptions. 

 Exceptions Only: Choose this option to edit data for only those Employees labeled with an Exception. 

 Errors Only: Choose this option to edit data for only those Employees labeled with an Error. 

 Errors And Exceptions: Choose this option to edit data for all Employees labeled with an Error or an Exception. 

To Choose a Record Type 

1. Click the drop-down arrow next to the Record Type field to open a list of Record Types. The currently selected 
Record Type is highlighted in blue with white characters. 

2. Click on any Record Type to choose it. The drop-down list closes, and the selected Record Type is displayed in the 
Record Type field. 

Reading the TC Daily Activity File 

When you choose Department Daily Activity Data from the Edit/View menu, choose options from 
the Select Range to Edit dialog box, and click OK, the Daily Browser opens. 
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The Daily Browser menu bar and tool bar are displayed at the top of the dialog box. The menu bar 
contains the menu options available for the Daily Browser. The tool bar contains the icons 
available for the Daily Browser. 

The numbers and names of the Departments selected in the Select Range to Edit dialog box are 
displayed below the tool bar. 

 If all Departments are selected, this text will read "Department: Selected All". 

 If one or two Departments are selected, their names and numbers will be displayed. 

 If more than two Departments are selected, the two with the lowest Department Numbers will be displayed, followed by a line 

of periods. 

 If you select Departments number 1, 3, 5, 7, and 9, the numbers and names of Departments 1 and 3 will be 

displayed, followed by "..............". 

Each line in the upper window of the Daily Browser is a TimeKeeper-PC Employee Record. A TK 
Employee Record contains time and attendance data for one Employee on one day. 

TimeCosting-PC Employee Records are displayed in the lower (Second File) window of the Daily 
Browser. If the Second File window is not displayed, choose TCDAY (Daily Job Transfers/TC) 
from the Second File menu on the Daily Browser menu bar to display the Second File window. 

The Second File window displays all the TC Employee Records for the Employee's TK Record 
(one Employee on one date) currently selected in the upper window. A TC Employee Record 
contains time and attendance data for that Employee in one job on that day, including start and 
end times, initial pay calculations, and Error and Exception messages. Pay calculations are made 
according to tables in the Employee's Contract. 

 When you make any change in a Record, it is flagged for recalculation and displayed in red characters until 

you save or calculate the Record. This does not necessarily mean that your change has caused an Error in 

TimeCosting-PC's calculations. 

 If no other information has been entered, the default jobs and percentages are the Employee's default job 

assignments as defined in TC Setup. These default values are displayed in purple characters. For Help 

assigning Default Jobs to Employees, click here. 
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Since the Second File window displays TC Employee Records for only one Employee at a time, 
you must first select the TK Employee Record which corresponds to the desired Employee. The 
TK Employee Records in the upper window are sorted by Employee Number. Click any Record to 
select it. The currently selected Record is marked with a black triangle: 

 

TC Employee Records in the lower (Second File) window are sorted chronologically. Click any 
Record to select it. The currently selected Record is marked with a black triangle: 

 

When you enter data or calculate the Record, the black triangle symbol changes to a pencil 
symbol, which is displayed until you select another Record: 

 

Press <Tab> to move forward to the next column and select it. Hold <Shift> and press <Tab> to 
move backward to the previous column and select it. You can also use the horizontal scroll bar at 
the bottom of the dialog box to scroll across columns. 

 Click the Go To Next Record icon to move to the beginning of the next Record in the 
Second File window. The first column is usually the Record Date column. This can be useful if you 
are viewing columns on the far right end of the Record and want to return to the left-hand 
columns. 

Columns can be defined in the system configuration as non-scrolling, meaning that they are 
continuously displayed as you scroll across other columns. These columns are displayed with a 
gray background. In the example below, the Record Date column is displayed as you scroll across 
other columns, but the Work Order and Process columns are not. 

 

If the first (left-hand) column of the Daily Browser is non-scrolling, you can use it to return to the 
other (scrolling) left-hand columns. Click the non-scrolling column to select it, and press <Tab> 
repeatedly until the first scrolling (white background) column is displayed. 

You can modify the screen structure of the Daily Browser to find certain information more easily. 
For Help modifying the screen structure of the TC Daily Browser, click here. 

The exact columns included in the TC Daily Browser are defined in the system configuration in 
TimeKeeper-PC Set-Up. For Help reading TC Daily Browser columns, click here. 

 

For Help modifying job transfers, click here. 

For Help adding missing job transfers, click here. 

For Help deleting job transfers, click here. 

A TC Employee Record contains time and attendance data for one Employee in one Department 
on one day, including start and end times, initial pay calculations, and Error and Exception 
messages. Pay calculations are made according to tables in the Employee's Contract. 

Modifying the Screen Structure of the TC Daily 

Browser 
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You can modify the screen structure of the TC Daily Browser by either collapsing or resizing 
columns. 

If you modify the screen structure of the Daily Browser, you will be prompted by a small dialog box 
when you exit the Daily Browser: "The Screen Structure was Modified! Save It?" 

 Click Yes to save the new screen structure. The next time you open the Daily Browser, it will be displayed with the new screen 

structure. 

 Click No to ignore the new screen structure. The next time you open the Daily Browser, it will be displayed with the previous 

screen structure. 

Collapsing Columns 

You can right-click any column header (blue text) in the Daily Browser to collapse that column. 
This allows you to view non-contiguous columns without using the horizontal scroll bar. 

 You can also use the Daily Browser Preferences in TimeKeeper-PC Set-Up to determine which columns are 

displayed in the Daily Browser, and in which order. 

For example, here is how the first five columns in the TC Daily Browser might appear: 

 

If you right-click the headers of the five columns with Work Order, Process, Start Time, End Time, 
and Absence Code, those columns will be collapsed. You can then view Duration and TC Pay 
Categories without using the horizontal scroll bar: 

 

To restore a collapsed column to its original width, right-click the header of the collapsed column. 
You cannot restore column widths in this manner after you exit and save the screen structure of 
the Daily Browser. 

 If you exit and then reenter the Daily Browser, collapsed columns in a saved screen structure cannot be 

restored to their original width by right-clicking their headers. To restore those columns, resize them 

according to the following instructions. 

Resizing Columns 

You can change the width of any column in the Daily Browser. This allows you to shrink a 
column's width and fit more columns onto the visible screen. 

When you place the cursor on the left or right border of any column header, it changes into the 
Width symbol: 

 

Hold down the left mouse button and drag the column border to the desired width. Release the 
mouse button to drop the border in that position. 

TC Daily Browser Columns 

The exact columns included in the TC Daily Browser are defined in the system configuration in 
TimeKeeper-PC Set-Up.  
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Following are the most common TC Daily Browser columns: 

 Record Date 

 the currently active levels (Work Order, Batch, Part, and Process). These can be edited manually. For Help editing time-

costing levels, click here. 

 Start and End Times. These are always in pairs, and can be edited manually. For Help editing Start and End Times, click 

here. 

 Absence Code: If you have set this field to display only the Absence Code number, you can click the column to display the 

ellipsis button . Click this button to display the Absence Code name. 

 Duration: the Duration of hours between the Start and End times (in the case of Errors, this column is blank) 

 Regular and Overtime Hours: the division of the Net Duration into a series of pay categories. The Duration is divided into pay 

categories according to Table E (Daily Work Schedules), Table F (Daily Overtime Rules) and Table T (Weekly Overtime 
Rules). These categories appear as separate columns in the Daily Browser: O.T. 1, O.T. 2, etc. For Help setting up 
TimeKeeper-PC tables, click here. 

 You can use Table F to define O.T. 1 to be the first three hours of daily Overtime, and O.T. 2 to be the next 

three hours of daily Overtime. You can use Table T to define Weekly O.T. 1 to be the first four hours of 

weekly Overtime, and O.T. 2 to be the next four hours of weekly Overtime. All of these categories can be 

displayed as separate columns in the Daily Browser. 

 Percent: the percent of that day's Paid Hours included in this Record 

 Rates: TC can define up to three different rate structures for costing, billing, and so on. The rates displayed in these columns 

are determined by TC Setup. For Help setting up Rates and Rate structures, click here. 

 Costs: The Cost for time worked on a job is the rate multiplied by the Duration. 

 TC Setup defines the Billing rate to be 100.00 for an Employee working Regular hours on a given job. If the 

Employee works three Regular hours on that job, then the Billing Cost will be 300.00. 

 Record Type 

 Calc Type 

 Update Code: indicates whether the Record has been manually updated. An Update Code of Not Closed indicates that the 

Record has been manually updated, but not yet calculated. Otherwise, the Update Code is Closed. 

 Manual Update: indicates whether the Record has been manually updated. A Manual Update value of Manually Edited 

indicates that the Record has been manually updated, but not yet calculated. Otherwise, the Manual Update value is No 
Edits. 

 Errors 

 Exceptions  

The TC Record Type indicates the original source of a RecordTC_Record_Definition. The options 
are: 

 0: original punch clock transaction 

 1: original data transaction entered manually in the Daily Browser 

 5: punch clock transaction which has been edited 

 6: data transaction entered manually in the Daily Browser, then edited 

TC Calculation Type 

The TC Calculation Type indicates the status of the Duration or Percent value for the Record. 
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Some punch clocks can report the Duration or Percent of total hours spent in that Department, 
instead of having these values calculated by the Daily Browser. 

 A punch clock can report that an Employee spent three hours on a job. This value is displayed as the 

Duration in the Daily Browser, regardless of the Employee's Start and End times. Depending on clock 

settings, this value may or may not be able to be recalculated by the Daily Browser. 

The options for the Calculation Type are: 

 0: standard Duration and Percent calculation, based on Start and End times 

 3: Duration acquired directly from punch clock, without calculations. Enables Duration recalculation by the Daily Browser. 

 4: Duration acquired directly from punch clock, without calculations. Disables Duration recalculation by the Daily Browser. 

 5: Percent acquired directly from punch clock, without calculations. Enables Percent recalculation by the Daily Browser. 

 6: Percent acquired directly from punch clock, without calculations. Disables Percent recalculation by the Daily Browser. 

A Calculation type which is 100 greater than any of these values indicates that the first rate has 
been manually updated, and cannot be recalculated by the Daily Browser. A Calculation type 
which is 200 greater indicates the same for the second rate. A Calculation type which is 300 
greater indicates the same for the third rate. 

 A Calculation rate of 206 indicates that the Percent has been acquired directly from the punch clock, the 

second rate has been manually updated, and neither the Percent nor the second rate can be recalculated 

by the Daily Browser. 

Editing Time-Costing Levels in the TC Daily 

Browser 

For each Record in the TC Daily Browser, you can choose elements from each of the active levels 
defined in TC Setup. Depending on how you set up TC Rates for each level and TC Configuration, 
changing those elements may change rates assigned to that Record. For Help setting up TC 
levels and configuration, click here. 

When you edit the levels for a Record, it is flagged for recalculation and displayed in red 
characters until you save or calculate the Record. This does not necessarily mean that your 
change has caused an Error in TimeCosting-PC's calculations. 

To Choose Elements for a TC Record 

1. Click the Work Order column to display a drop-down arrow in the column. Click the drop-down arrow to open a list of 
work orders defined in TC Setup. 

2. Use the vertical scroll bar on the right to scroll up and down the list. 

3. To choose a work order, click anywhere on that work order's line. The drop-down list closes, and the number and 
name of the selected work order are displayed in the work order column. 

You can use the same procedure to choose batches, parts, and processes. Each of these levels 
displays the full list defined in TimeKeeper-PC for that level. 

Depending on how you set up combined rates in the TC Configuration File, levels can be 
combined with other values to set rates. For Help defining combined rates, click here. 

 For the purposes of this Help file, time-costing levels are sometimes referred to by the following names:  

 Level 1 Level 2 Level 3 Level 4 

 Work order Batch Par Process 
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Editing Start and End Times in the TC Daily 

Browser 

You can edit the Start or End Time for a Record. To edit the Start or End Time, click the Start or 
End Time column and enter the time as HH:MM. 

TimeKeeper-PC tracks both In and Out punches, but TimeCosting-PC needs only one value to 
calculate the start and end of a job. You can set TC to calculate job times either by starting a job 
when an Employee punches in to that job, or by ending the job (and starting the next one) when 
the Employee punches out from that job. Although it is not recommended, you can also set TC to 
require a punch in and out of each job. For Help setting TC to calculate job times by Start or End 
Times, click here. 

When you edit the Start or End Time for a Record, it is flagged for recalculation and displayed in 
red characters until you save or calculate the Record. This does not necessarily mean that your 
change has caused an Error in TimeCosting-PC's calculations. 

Modifying Job Transfers 

Use the Daily Browser to modify Employee job transfers which are valid, but reflect incorrect 
information. 

 An Employee begins work on one job, and enters the valid number of a different job. When the Employee's 

supervisor checks the Daily Transactions Report, the incorrect transfer is discovered. The supervisor can 

use the Daily Browser to modify the incorrect Employee job transfer. 

As in the example above, most corrections in job transfers are in the index codes for TC levels. 
For Help editing time-costing levels, click here. 

You can also manually edit the Start or End Time columns. For Help editing Start and End times, 
click here. 

After you modify the TC Record, calculate or save the Record. 

You can also use the Daily Browser to add missing job transfers. 

 An Employee who begins work on a job and then moves to a different job, but forgets to punch into the 

new job. When the Employee's supervisor checks the Daily Transactions Report, the missing transfer is 

discovered. The supervisor can use the Daily Browser to add the missing Employee job transfer. 

For Help adding new Records, click here. 

You can also use the Daily Browser to delete transfers. 

 An Employee begins work on a job and then moves to a different job. The Employee's supervisor decides 

not to charge the time worked on the second job. The supervisor can use the Daily Browser to delete the 

second Employee job transfer. 

For Help deleting Records, click here. 

TC Daily Browser Menu Bar 

The following options are displayed on the Daily Browser menu bar. Click any highlighted option 
on this list for Help using that menu option. 

File menu: 
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 Refresh Data 

 Specify Required Range 

 Exit 

Record Menu: 

 Edit/View Exceptions 

 Add New Record 

 Calculate Record 

 Save Current Record 

 Move Punches Right: This function is disabled in TimeCosting-PC. 

 Move Punches Left: This function is disabled in TimeCosting-PC. 

 Copy Value to Next Record 

 Add General File Audit Record 

 Delete Current Record 

Records Type Menu 

Options Menu: 

 Automatic Calculation 

 Add/Edit File SALDAY 

Second File Menu 

Help Menu 

To View and Edit a Different Set of Records 

1. Choose Specify Required Range from the File menu, or press <F9>. If you have not made any changes in the current 
Record, or if you have saved them already, the Select Range to Edit dialog box opens. 

2.  If you have made changes but not saved them, you will be prompted by a small dialog box: "Current Record Has 
Been Changed! Save?" Click Yes to save the changes you have made in the current Record, or No to close the Daily 
Activity File without saving those changes. The Select Range to Edit dialog box opens. 

3. Choose the Departments to be displayed. For Help choosing Departments, click here. 

4. Choose the date to be edited. For Help choosing a date to be edited, click here. 

5. Choose the Records Type to be displayed. For Help choosing a Records Type, click here. 

6. Click OK. The TC Daily Browser (Daily Activity File) dialog box opens. For Help reading the TC Daily Activity File, 
click here. 

 You can open a new dialog box to specify a different set of records for viewing and editing. TimeKeeper-PC 

will prompt you to save changes for the current set of records. 

Adding New Records 

You can add TC Records for an Employee. When you add a new Record and recalculate, the 
Duration, Percentage, and division into TC Pay Categories are changed to match the new Start 
and End Times, and the Records are resorted into chronological order. For Help calculating TC 
Records, click here. 

When you add a TC Record, it is flagged for recalculation and displayed in red characters until 
you save or calculate the Record. This does not necessarily mean that your change has caused 
an Error in TimeCosting-PC's calculations. 



  51 

If no other information has been entered, the default jobs and percentages are the Employee's 
default job assignments as defined in TC Setup. These default values are displayed in purple 
characters. For Help assigning Default Jobs to Employees, click here. 

In the following example, the Employee has two TC Records for the current TK Record: 

 

Note that in this case, the current Records are based on the Employee's default job assignments. 
If you add a new Record with a Start Time of 11:00 and an End Time of 12:00, the Second File 
window will display the Records as follows: 

 

Note that at this point, before recalculation, there is no change in the previous two Records. After 
you recalculate the Records, they are displayed as follows: 

 

The Duration and Percentage for the previous two Records have been recalculated to fit the new 
Record within the Employee's Net TK Duration. 

You can add a new Record with a Start Time either before the Employee's TK In Punch or after 
the Employee's TK Out Punch. After recalculation, the TC Records are displayed with the new 
information, but the punches in the Employee's TK Record are unchanged. 

 In the example above, you can add a new Record with a Start Time of 7:00. After recalculation, a new 

Record is displayed with a Start Time of 7:00, but the In Punch value in the Employee's TK Record remains 

8:28. 

To Add a New Record 

1. Choose Add New Record from the Record menu, press <F7>, or click the Add Record icon:  

2. You will be prompted by a small dialog box: Add New Record To File TCDAY. Click Yes. A new Record is displayed 
at the top of the Second File window. Except for the Record Date column, all the columns are blank. 
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 When you add a new Record, it is displayed in red characters until you save or calculate the Record. This 

does not necessarily mean that your change has caused an Error in TimeCosting-PC's calculations. 

3. Enter values for all active levels, Start Time, and End Time. For Help adding and editing values in TC Daily Browser 
Columns, click here. 

4. Calculate or save the new Record. 

 If you try to add another new Record without calculating or saving, you will be warned to save your 

changes. If you do not calculate or save, the entered information in the unsaved new Record will be lost. 

You can also use the Daily Browser to modify Employee job transfers which are valid, but reflect 
incorrect information. 

 An Employee begins work on one job, and enters the valid number of a different job. When the Employee's 

supervisor checks the Daily Transactions Report, the incorrect transfer is discovered. The supervisor can 

use the Daily Browser to modify the incorrect Employee job transfer. 

For Help modifying job transfers, click here. 

You can also use the Daily Browser to delete transfers. 

 An Employee begins work on a job and then moves to a different job. The Employee's supervisor decides 

not to charge the time worked on the second job. The supervisor can use the Daily Browser to delete the 

second Employee job transfer. 

For Help deleting Records, click here. 

Calculating TC Records 

The Calculate Record command recalculates Duration, Percentage, Rates, Costs and the division 
of the Duration among TC Pay Categories, based on changes you have made to the Daily Activity 
File. 

When you calculate a Record, all TC Records for the Employee's TK Record (one Employee on 
one date) currently selected in the upper window are calculated and resorted into chronological 
order. 

 When you add a new Record, it appears above the existing TC Records in the Second File window until you 

calculate the Records. Once you calculate the Records, the new Record is displayed in its proper place in 

the chronological order. 

Start and End Times 

When you change Start or End Times and recalculate, the Duration and Percentage values are 
changed. In the following example, the Employee has five TC Records for the current TK Record: 

 

In the example above, if you change the first End Time and the second Start Time to 11:15 and 
recalculate, the Duration and Percentage values for the first two Records are switched. For Help 
editing Start and End Times, click here. 



  53 

Time-Costing Levels 

When you change time-costing levels and recalculate, the Rate and Cost values may change, 
depending on how you set up the TC Configuration File. For Help editing the TC Configuration 
File, click here.. In the following example, the Employee has two TC Records for the current TK 
Record: 

 

In the example above, if you change the first Work Order to 8000 and recalculate, the Costing 
Rate for the first Record is reduced to 12.500, and the Costing Cost is reduced to 75.60. For Help 
editing time-costing levels, click here. 

New Records 

When you add new Records and recalculate, the Duration and Percentage values are changed. In 
the following example, the Employee has two TC Records for the current TK Record: 

 

Note that in this case, the current Records are based on the Employee's default job assignments. 
In the example above, if you add a new Record with a Start Time of 11:00 and an End Time of 
12:00 and recalculate, the Duration for the previous two Records is reduced to 3:30, and the 
Percentage for the previous two Records is reduced to 0.44. For Help adding new Records, click 
here. 

Calculating and Saving Records 

When you calculate a Record, it is saved automatically. When you save a Record, it is not 
calculated automatically unless you have enabled the Automatic Calculation option. 

For Help saving Records, click here. 

For Help calculating Records automatically, click here. 

To calculate a Record, choose Calculate Record from the Record menu, press <F3>, or click the 
Calculate Record icon: 

 

Automatic Calculation in TC 

The Automatic Calculation option allows you to immediately see the results of your changes to the 
Daily Activity File. When Automatic Calculation is enabled, the current Record is calculated 
whenever you save it or select another TK Employee Record. 

 Automatic Calculation calculates only when you save or select another TK Employee Record. It does not 

calculate when you select another TC Employee Record for the same Employee on the same day. 
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 If you change the Start Time for a Record, the Record will be displayed in red characters. If you then save it 

or select another TK Employee Record, the corrected Record will be calculated automatically and be 

displayed in black characters. Selecting another TC Employee Record for the same Employee on the same 

day does not activate calculation. 

For Help calculating Records, click here. 

Since the Calculate Record command automatically saves the Record, the Automatic Calculation 
option ensures that your changes are saved whenever you click to select another TK Employee 
Record. 

 In the example above, the changed Record will be saved as soon as you click to select another TK 

Employee Record. 

The Automatic Calculation option does not calculate the Record until you save it or select another 
one. If you try to refresh data or exit the Daily Activity File without selecting another Record, you 
will be warned to save your changes. 

To enable the Automatic Calculation option when it is disabled, choose Automatic Calculation 
from the Options menu. The enabled option is displayed with a check-mark beside it. To disable 
the Automatic Calculation option when it is enabled, choose Automatic Calculation from the 
Options menu, and the check-mark disappears. 

Copying a TC Value to the Next Record 

The Copy Value To Next Record command copies a value from a Record into the Record (line) 
immediately below it. This can be useful for entering identical data in a number of Records. 

 The Copy Value To Next Record command always copies the value into the Record (line) immediately 

below it. If there is already a value in the Record below it, that value will be superseded by the new value, 

and the old value will be lost. 

In the example below, the Employee has been assigned to Work Order 100 for the first Record, 
and to Work Order 8000 for the second Record: 

 

To copy the first Record's Work Order into the second Record, click to select the first Record's 
Work Order, and then choose Copy Value To Next Record from the Records menu, or press 
<F5>. 

The corrected Records display the Work Order 100. Note that the Record is displayed in red 
characters until you save or calculate the Record. 

To Copy a Value to the Next Record 

1. Click to select the value to be copied. 

2. Choose Copy Value To Next Record from the Records menu, or press <F5>. 

Deleting the Current Record 

The Delete Current Record command deletes the currently selected TC Employee Record from 
the Daily Browser. 

 Once you delete the Record and recalculate, the old value is lost. 
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In the following example, the Employee has two TC Records for the current TK Record: 

 

If you delete the first Record, the Second File window will display only the remaining Record, with 
the Percentage 1.00. 

To Delete a TC Record 

1. Click to select the Record to be deleted. 

2. Choose Delete Current Record from the Records menu, or press <Ctrl> + <F6>. The Record is no longer displayed. 

You can also use the Daily Browser to modify Employee job transfers which are valid, but reflect 
incorrect information. 

 An Employee begins work on one job, and enters the valid number of a different job. When the Employee's 

supervisor checks the Daily Transactions Report, the incorrect transfer is discovered. The supervisor can 

use the Daily Browser to modify the incorrect Employee job transfer. 

For Help modifying job transfers, click here. 

You can also use the Daily Browser to add missing job transfers. 

 An Employee who begins work on a job and then moves to a different job, but forgets to punch into the 

new job. When the Employee's supervisor checks the Daily Transactions Report, the missing transfer is 

discovered. The supervisor can use the Daily Browser to add the missing Employee job transfer. 

For Help adding new Records, click here. 

To display TC Records in the Second File window, choose TCDAY (Daily Department 
Transfers/TC) from the Second File menu. 

To close the Second File window, choose No Second File from the Second File menu. 

TC Daily Browser Tool Bar 

The following icons are displayed on the Daily Browser tool bar. 

 Click the Help icon for Help editing the Daily Activity File. 

 Click the Refresh Data icon to update the Daily Activity File with the newest data from all 
sources. 

 Click the Specify Range icon to view and edit a different set of records. 

 Click the Add Record icon to add a new TC Record. 

 Click the Calculate Record icon to calculate the current Record. 

 Click the Save Record to File icon to save your changes to the current Record. 

 Click the Delete Record icon to delete the current Record. 
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 Click the Edit/View Exceptions icon to edit and view Exceptions. 

 Click the Show SalDay Browser icon to enter auxiliary information which is not based on 
time -- for example, tips or commissions to be divided among Employees, mileage, per diem, 
travel allowance, etc. 

 The Move Punches Left icon is disabled when working in the lower (Second File) window. 

 The Move Punches Right icon is disabled when working in the lower (Second File) 
window. 

 Click the Display Previous Employee icon to display the previous Employee by Employee 
Number. This icon is enabled only when viewing daily activity by Employee (Advanced TC Data 
Editing), not by Department. 

 Click the Display Next Employee icon to display the next Employee by Employee Number. 
This icon is enabled only when viewing daily activity by Employee, not by Department. 

 Click the Go To Next Record icon to move to the beginning of the next Record in the Daily 
Activity File. 

 Click the Exit icon to close the Daily Browser. 

 This green exit door icon is used to close the dialog box. Only the red exit door on the main tool bar exits 

the TimeKeeper-PC program. 

Click the Go To Next Record icon to move to the beginning of the next Record in the Daily Activity 
File. The first column is usually the Record Date column. This can be useful if you are viewing 
columns on the far right end of the Record and want to return to the left-hand columns. 

Editing TC Daily Activity -- Where Do I Go Next? 

Click the Exit icon to close the Daily Activity File: 

 

If you have changed any Records but not saved them, you will be prompted by a small dialog box: 
"Current Record Has Been Changed! Save?" 

 If you want to save the changes you have made to the current Record, click Yes. 

 If you want to exit without saving those changes, click No. 

 If you want to continue working in the current Record, click Cancel. 

You can also view and edit a different set of records without having to close the dialog box. For 
Help viewing and editing a different set of records, click here. 

After you edit daily activity, you need to export the corrected summary for use in payroll, billing, or 
costing. For Help exporting TC data, click here. 

Exporting TC Data 
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You can export corrected TC summary data for use by your Payroll Department. For Help 
exporting TC payroll data, click here. 

You can also export TC data for use in billing, costing, or any other use that requires time-costing 
of hours. For Help exporting TC data for non-payroll uses, click here. 

Where Do I Go Next? 

TC Payroll Data 

What Is It? 

The Payroll Output File contains all the information your payroll department needs to pay 
Employees. The file, which is in simple text format, contains the following information: 

 Employee Number 

 Pay Period 

 Payroll Data 

 Auxiliary Payroll Data 

Payroll Data includes all paid hours, such as Regular Hours, Overtime Hours, Paid Vacation, Paid 
Sick Leave, and so on. 

Auxiliary Payroll Data includes tips, bonuses, commissions, and so on. These data can be 
expressed in one of three formats: 

 as a number of hours 

 as a sum of money 

 as a number of points 

 You can define Auxiliary Payroll Data to give an Employee one point for each use of public transportation. 

For Help creating Auxiliary Payroll Data, click here. 

Why Do I Need It? 

Your payroll department uses the Payroll Output File to determine employee salaries. 

Exporting TC Payroll Data 

Viewing Payroll Files and Reports 

Exporting TC Payroll Data 

 Before you can export payroll data, the Employees included in the Pay Period need to be assigned to 

Payroll Tables in their Employee Profiles. For Help assigning an Employee to a Payroll Table, click here. 

Choose Export Payroll Data from the Activities menu. Choose TC - Export Payroll Data to open 
the Export Payroll Data dialog box: 
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The menu bar contains the menu options available for Payroll Files and Reports. 

The tool bar contains the icons available for Payroll Files and Reports. 

The Output File panel contains options for creating the Payroll Output File. 

The Pay Period panel contains options for choosing the Pay Period included in the Payroll Output 
File. 

The Payroll Report panel contains options for producing the Payroll Report. 

Payroll Output Files and Payroll Reports -- What's the Difference? 

A Payroll Output File exports payroll data in text format to your payroll department. You need to 
design the payroll form to match the software used in your payroll department. 

A Payroll Report displays payroll data for your own use. You can design the Payroll Report to 
display data in any form you choose. 

To Export Payroll Data 

1. Choose Export Payroll Data from the Activities menu. 

2. Choose TC - Export Payroll Data. The TC Export Payroll Data dialog box is displayed. 

2. Choose options from the Output File panel. 

3. Choose options from the Pay Period panel. 

4. If you enabled the Print Payroll Report box, choose options from the Payroll Report panel. 

5. Click the Execute Transfer Program icon to produce the Payroll Output File (and Payroll Report, if enabled): 

 

You have now produced the Payroll Output File. 

Exporting TC Data for Billing and Costing 
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[To be completed] 

Exporting TC Data -- Where Do I Go Next? 

Congratulations! Once you export TC data, you have successfully completed the Seven Easy 
Steps of TimeCosting-PC. 

To review the Seven Easy Steps, click here. 

What Else Can TimeCosting-PC Do? 

TimeCosting-PC Advanced Functions 

 

TC Reports & Graphs 

 You can generate reports on work hours and time-costing. You can also generate reports on 
Employee data, organizational structure, and TC Setup. Reports can be presented graphically and 
exported to Microsoft Excel files. 

Advanced TC Data Editing 

 You can edit and correct time-costing input data for a single Employee over any length of time. 

TC Maintenance 

 You can back up and restore data and system files. You can globally update and recalculate TC 
Daily Activity Files. You can use the Edit/View Invalid Punches option to change the structure of 
raw data input. 

TC Reports 

TimeCosting-PC offers you many reports to choose from. These reports are organized into three 
main groups: 

Organizational structure 

Employee Lists sort Employees according to their place of work, profession, and other personal 
information. Shared Files Set-Up Reports display all the levels of your organization, as well as the 
personal categories by which your Employees are sorted. 

 You can view a list of the Employees who are assigned to the Chef Profession. 

TimeCosting-PC Setup 

TC Setup Reports display rules and definitions used for time-costing. 

 You can view your current levels definitions. 

Daily activity and pay-period summary 

These are organized according to time periods. TC Daily Activity Reports compare an Employee's 
work hours, job transfers, and Contract definitions. TC Pay-Period Summary Reports summarize 
an Employee's job transfers over a period for which s/he is to be paid. 
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 You can view a list of Employees from the Electrical Department who worked on Machine Rewiring. 

Report Dialog Box 

When you choose any of these reports, the corresponding report dialog box is displayed, with the 
current report parameters displayed in the white Report Parameters box. You can use the menus 
on the Report Menu Bar to change any of these parameters. 

You can also change parameters without using the report menus. Double-click any black or blue 
text in the Report Parameters box to open the dialog box for the corresponding parameter. Click 
OK to close a dialog box, and the parameter displayed in the Report Parameters box is 
automatically updated. 

 To change the default dates covered by the report, double-click the word Date in the top panel of the box. 

The Date dialog box is displayed, allowing you to change the default dates. 

If you have used the Select option to change Dates or Report Ranges during the current run of the 
report, double-clicking will open the Select dialog box instead of the Default dialog box. 

You can also open Date and Report Range menus with the right mouse button. Right-click any 
black or blue text in the top or left-hand panels to open the corresponding Report menu within the 
Report Parameters box. 

Report Tool Bar 

The Report Tool Bar at the top of the dialog box contains the icons available for reports. 

TC Setup Reports 

What Are They? 

TC Setup Reports display rules and definitions used for time-costing. The following TC Setup 
Reports are available: 

 Levels (Work Order, Batch, Part, Process) 

 Automatic levels (1 and 2) 

 Department 

 Cost Center 

 Machine 

 Rate 

 Cell 

 Combined rates for up to three rate structures 

 For the purposes of this Help file, time-costing levels are sometimes referred to by the following names:  

 Level 1 Level 2 Level 3 Level 4 

 Work order Batch Part Process 

Why Would I Want Them? 

These reports are useful for viewing information about the current setup for TC in your system. 

To Produce a TC Setup Report 
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1. Choose Module Specific Set-Up Reports from the TimeKeeper-PC Set-Up menu. 

2. Choose TC Set-Up Reports. The Select Report To Process dialog box is displayed. 

3. Choose one of the reports. For Help about these reports, click here. 

4. Click OK. The corresponding dialog box is displayed, with the current report parameters displayed in the white Report 
Parameters box, below the Report Tool Bar. 

5. For the Rate and Combined Rate Set-up Reports only, choose the From and To dates for the report. For Help 
choosing Report Dates, click here. 

6. For the Work Order and Batch Set-up Reports only, choose the Date for the report. For Help choosing a single report 
date, click here. 

7. For the Work Order and Batch Set-up Reports only, choose the Status for the report. For Help choosing a status for 
reports, click here. 

8. Depending on the report chosen, choose the range for the elements in the report. For example, for the Cost Center 
Set-up Report, choose the range of cost centers. For Help choosing Report Range values, click here. 

9. Choose a destination for the report. For Help choosing TC Setup Report destinations, click here. 

10. Choose Start Report from the Report menu bar, or click the Start Report icon: 

 

If You Need Help Making Changes in the Report: 

 If part of the report is cut off, or if some of the characters are not visible, click here. 

 If you want to change the fonts used in the report, click here. 

To Produce a Different TC Setup Report 

1. Select Change Report from the File menu of the Set-Up Report dialog box. The Select Report To Process dialog box 
is displayed. 

2. Repeat steps 3-8. 

 

What Other Reports Can I Produce? 

TC Setup Reports to Process 

Work Orders and Batches 

These reports display information about Levels 1 and 2 as they are defined in your system. The 
information displayed includes active and suspended dates, planned vs. actual costs, and default 
Rate codes for the various Rate structures. For Help viewing and editing Work Orders, click here. 
For Help viewing and editing Batches, click here. 

Parts and Processes 

These reports display information about Levels 3 and 4 as they are defined in your system. The 
information displayed includes associated cost centers and machines, and default Rate codes for 
the various Rate structures. For Help viewing and editing Parts, click here.For Help viewing and 
editing Processes, click here. 

Automatic levels (1 and 2) 

These reports display the numbers and names of auto levels defined in your system. For Help 
viewing and editing auto level files, click here. 

Department 
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This report displays information about the Departments defined in your system. The information 
displayed includes standard budgeted hours and default Rate codes for the various Rate 
structures. For Help viewing and editing Departments, click here. 

Cost Center 

This report displays the numbers and names of cost centers defined in your system. For Help 
viewing and editing cost centers, click here.  

Machine 

This report displays information about the machines defined in your system. The information 
displayed includes numbers, names, machine loads, and RPM coefficients. For Help viewing and 
editing machines, click here. 

Rate 

This report displays information about the Rates defined in your system. The information 
displayed includes the name, From Date, and value of each Rate. For Help Adding and Editing TC 
Rates, click here. 

Cell 

[To be completed] 

Combined rates 

These reports display information about the combined rates defined in your system. You can 
generate a separate report for each of three rate structures. The information displayed includes 
the names of the elements which make up a combined rate, and the code and value of the 
resultant Rate. For Help Adding and Editing Combined Rates, click here. 

Choosing a Single Report Date 

The Report Date Menu determines the date to be included in the report. The date you choose will 
be displayed in the top panel of the Report Parameters box. 

The Select option allows you to choose a date based on a calendar, and applies only to the 
current run of the program. For Help choosing a date with the Select option, click here. 

The Default option allows you to choose a date based on its proximity to the current date, and can 
be saved for future use. For Help choosing a date with the Default option, click here. 

 The Save option in the Report File Menu saves your changes to the Default value, but not to the Select 

value. 

Choosing a Single Date with the Select Option 

The Select option allows you to choose a date based on a calendar. Choose Select from the 
Report Date Menu to open the Date dialog box. The From date is the date used in the report. 

You can choose a date in any of three ways: 

 by typing a date into the From Date field 

 by using the up and down arrows next to the From Date field 

 by using a graphic calendar display (the Calendar) 
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Choosing a Single Date by Typing It In 

You can choose a date by typing it into the From Date field. 

For Help using date formats, click here. 

To Choose a Date by Typing It In 

1. Choose Select from the Date Menu in the Report Menu Bar. The Date dialog box will open. 

2. Double-click the From Date field. 

3. Enter the beginning date of the report. 

 Enter August 15th, 1996 as "08151996" for a U.S. date, or 15081996 for an International date. The field will 

automatically add the slashes to display "08/15/1996" or "15/08/1996". 

4. After you enter the desired date, click OK to close the Date dialog box. The date you have chosen will be displayed in 
the top panel of the Report Parameters box. 

Choosing a Single Date with the Up and Down 

Arrows 

You can choose a date by clicking the up and down arrows next to the From Date fields. Each 
click up or down changes the date by one day. Click and hold the arrow to scroll through dates. 

To Choose a Date with the Up and Down Arrows 

1. Choose Select from the Date Menu in the Report Menu Bar. The Date dialog box will open. 

2. To set the From date for earlier, click or hold the down arrow next to the From field. 

3. To set the From date for later, click or hold the up arrow next to the From field. 

4. When you reach the desired date, click OK to close the Date dialog box. The date you have chosen will be displayed 
in the top panel of the Report Parameters box. 

Choosing a Single Date with the Calendar 

TimeKeeper-PC's Calendar dialog box allows you to choose a date from a convenient graphic 
calendar display. Click Calendar in the Date dialog box to open the Calendar dialog box: 

 

To Choose a Date with the Calendar Dialog Box 
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1. Choose Select from the Date Menu in the Report Menu Bar. The Date dialog box will open. 

2. Click the From Date field. 

3. Click Calendar. The Calendar dialog box will open, displaying the current year, month, and date. In the Date dialog 
box in the background, the From date will change from black to red. 

 If you change the From date before clicking Calendar, the Calendar will display the new values you have 

chosen. 

4. On the bar displaying the current year, click the arrow to the left for the preceding year, or the arrow to the right for 
the following year. The display will change by one year with each click. 

5. On the bar displaying the current month, click the arrow to the left for the preceding month, or the arrow to the right 
for the following month. The display will change by one month with each click. 

6. On the calendar display in the center of the dialog box, click the desired date. The selected date will be displayed as 
a raised gray button with a blue number. 

7. When the desired date is displayed, click OK to close the Calendar dialog box. In the Date dialog box, the From date 
will change from red to black, and the same date will now be displayed as the To date. 

8. When the desired date is displayed, click OK to close the Date dialog box. The date you have chosen will be 
displayed in the top panel of the Report Parameters box. 

Choosing a Single Date with the Default Option 

The Default option allows you to choose a date based on its proximity to the current date. This 
allows you to always produce reports with the same relationship to the current date. 

 If the Default From value is -7, then the report will always include dates beginning one week before the day 

the report is produced. 

Choose Default from the Report Date Menu to open the Date dialog box. In the Date dialog box, 
the From date is displayed relative to the current date. A negative number shows the number of 
days before the current date, and a positive number shows the number of days after the current 
date. 

 If the report is produced on August 5th with a From value of -1, it will include dates from August 4th. 

You can change the Default Date value by double-clicking the current From date and typing in 
new values. 

You can also change the Default Date value by clicking the arrows next to the From date. Click 
the up arrow to raise the value by one. Click the down arrow to lower the value by one. Click and 
hold the arrow to scroll through values. 

To Choose a Date by Typing in Default Values 

1. Choose Default from the Date menu in the Report Menu Bar. The Date dialog box will open. 

2. Double-click the From field and enter a new value. 

3. After you enter the desired value, click OK to close the Date dialog box. The date you have chosen will be displayed 
in the top panel of the Report Parameters box, based on its proximity to the current date. 

To Choose a Date by Choosing a Default Value with the Up and Down Arrows 

1. Choose Default from the Date menu in the Report Menu Bar. The Date dialog box will open. 

2. Click the From field. 

3. To set the From value higher, click or hold the up arrow next to the From field. 

4. To set the From value lower, click or hold the down arrow next to the From field. 

5. After you enter the desired value, click OK to close the Date dialog box. The date you have chosen will be displayed 
in the top panel of the Report Parameters box, based on its proximity to the current date. 



  65 

Choosing a Status for TC Setup Reports 

You can place a work order (Level 1) or batch (Level 2) "on hold". The system cannot obtain or 
edit data for a work order or batch while it is on hold. 

When you produce a TC Setup Report for work orders or batches, you can choose whether or not 
to include work orders or batches whose status is "on hold" (referred to in reports as 
"suspended"). 

Choose Output Options to open the Output Options dialog box. Choose one of the following 
options from the drop-down list for displaying the report output: 

 All: Choose this option to display all elements of the chosen level. 

 Active: Choose this option to display only those elements which are not "on hold". 

 Suspended: Choose this option to display only those elements which are "on hold". 

Choosing TC Setup Report Destinations 

Choose Output Options to open the Output Options dialog box. Choose one of the following 
options from the drop-down list for displaying the report output: 

 Print Preview: Choose this option to view the report on the screen page by page, exactly as it will appear in the printer output. 

 The Print Preview begins by displaying the first page of the report. Click Next to see the next page of the 

report, unless you are viewing the last page of the report. Click Close to close the Print Preview. 

 Printer: Choose this option to send the report to a printer. If you choose this option, make sure your print setup is correct by 

choosing Print Setup from the File Menu in the Report menu bar. For Help using Print Setup, click here. 

 Screen: Choose this option to display the report output on your screen. This option allows you to review the report without 

producing a hard copy. For Help reading the Screen display of your report, click here. 

 File: Choose this option to send the report output to a plain text file. When you choose this option, a new field is displayed to 

the right of the arrow on this line. Click that field and type the name of the file. 

 The report output is sent to a plain text file in the Tk5win folder or directory. This file can then be easily 

accessed for use by other applications, such as word processors. 

TC Daily Activity Reports 

What Are They? 

TC Daily Activity Reports compare an Employee's work hours, time-costing, and Contract 
definitions. 

Why Would I Want Them? 

These reports are useful for following all aspects of time-costing. 

For Help producing and reading any report, click on its title. 

There are six TC Daily Activity Reports: 

 TC Errors & Exceptions 

 TC Daily Transactions 

 TC Attendance vs. Job Changes 
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 TC Default Daily Activity Reports (three reports) 

Attendance vs. Job Changes Report 

What Is It? 

The Attendance vs. Job Changes Report compares each Employee's hours on a given job with 
that Employee's total attendance data for the day. 

Why Would I Want It? 

Job supervisors can check the total hours an Employee who worked on a given job was paid for 
on that day. 

 The Painting Supervisor can check if the Employees who worked on painting spent all or most of their day 

there. 

 

Producing the Report 

Reading the Report 

What Other Reports Can I Produce? 

TC Default Daily Activity Reports 

What Are They? 

TC Default Daily Activity Reports are a base for creating user-defined TC Daily Activity Reports. 
They are comprehensive reports including all relevant data parameters. 

There are three types of TC Default Daily Activity Report: 

 TC Default Daily Activity Report: This report displays all time-costing data for the selected days, sorted by organizational 

levels (Employee, Department, Site, Plant). 

 TC Default Daily Activity Report By All Levels: This report displays all time-costing data for the selected days, sorted by all 

active time-costing levels (Process, Part, Batch, Work Order). 

 TC Default Daily Activity Report By 2 Levels: This report displays all time-costing data for the selected days, sorted by only 

two of the active time-costing levels. 

Why Would I Want Them? 

Based on any of these reports, you can create your own user-defined TC Daily Activity Report and 
choose to use only some of the parameters included in the basic report. 

 

Producing the Report 

Reading the Report 

What Other Reports Can I Produce? 

To Produce TC Daily Activity Reports 

1. Choose Reports & Graphs from the Main Menu Bar. 

2. Choose TC Daily Activity Reports. 

3. Choose the desired report from the sub-menu. The appropriate report dialog box is displayed, with the current report 
parameters displayed in the white Report Parameters box, below the Report Tool Bar. 
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4. Choose dates for the report. For Help choosing report dates, click here. 

5. Choose report ranges for organizational and time-costing levels. For Help choosing report range values, click here. 

6. Choose report output options. For Help choosing TC Daily Activity Report output options, click here. 

7. Choose Start Report or click the Start Report icon: 

 

If You Need Help Making Changes in the Report: 

 If part of the report is cut off, or if some of the characters are not visible, click here. 

 If you want to change the fonts used in the report, click here. 

TC Activity Report Output Options 

Following are the output options available for various TC Activity Reports. Not all of the following 
options are available for all of the reports. 

Format 

Choose to print the report in either Landscape (recommended) or Portrait format. 

Calculate TCDAY Records 

When you produce any Daily Activity Report in TimeCosting-PC , the program can automatically 
recalculate Records in the TC  Daily Activity File. However, the TC Daily Activity File can contain a 
large number of Records for a single day, and it can be unwieldy and time-consuming to 
recalculate all of them every time you produce a report. 

Normally, there is no need to recalculate the records in the TC Daily Activity file prior to running 
the report (as the calculations are automatically performed whenever data is either entered or 
modified). However, if you are unsure that the calculations are current or valid, enable this option. 

 Type 0 (recommended) to produce a report without calculating TCDAY Records. In some reports, this is the Disabled option 

in a drop-down list. 

 Type 1 to calculate TCDAY Records automatically when you produce a report. In some reports, this is the Enabled option in a 

drop-down list. 

In the TC Default Pay-Period Summary By 2 Levels, the equivalent field is the Calculate TCPER 
Records field. As in the Calculate TCDAY Records field, it is recommended to disable this option. 

Print Hours In 

You can choose to display hours in either decimal format or HH.MM format. 

 A Net Duration of one hour and thirty minutes can be displayed as either 1.50 (decimal format) or 1.30 

(HH.MM format). 

In some reports, this is the Values in HH.MM field. Choose No for decimal format, or Yes for 
HH.MM format. 

Level Output Format 

You can display level elements by number and name, or by number only. 

 If you choose Number, then Process # 345 Wheel Alignment will be displayed on this report as Process 

345. 

 Choose Number to display level elements by number only. 
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 Choose Name to display level elements by number and name. 

Display Statistics and Payroll Auxiliaries 

You can display four levels of detail in the TC Attendance vs. Job Changes Report. 

Statistics include summaries for Employees, Departments, Sites, and Plants. 

Auxiliary Payroll Data includes tips, bonuses, commissions, and so on. These data can be 
expressed in one of three formats: 

 as a number of hours 

 as a sum of money 

 as a number of points 

 You can define Auxiliary Payroll Data to give an Employee one point for each use of public transportation. 

The options for Statistics and Payroll Auxiliaries are: 

 Statistics: Choose this option to display statistics. 

 Payroll Auxiliaries: Choose this option to display auxiliary payroll data. 

 Statistics and Payroll Auxiliaries: Choose this option to display both statistics and auxiliary payroll data. 

 None: Choose this option to display neither statistics nor auxiliary payroll data. 

Summary Levels 

You can display three levels of detail and summaries (sub-Totals) in the TC Default Daily Activity 
Report. The options for Summary Levels are: 

 Detailed: Choose this option to display details for all organizational levels (Employee, Department, Site, Plant) and individual 

job transfers. 

 Lowest Level Totals: Choose this option to display details and totals for Employees, without individual job transfers. 

 2nd Lowest Level Totals: Choose this option to display details and totals for Departments, without Employees or individual job 

transfers. 

 You can use a synonym for any level of your organization. 

Detail Levels 

You can display two levels of detail and summaries (sub-Totals) in the TC Default Daily Activity 
Report By All Levels. The options for Detail Levels are: 

 Details: Choose this option to display details and totals for Employees and individual job transfers. 

 Date Totals: Choose this option to display details and totals for dates, without Employees or individual job transfers. 

You can display four levels of detail and summaries (sub-Totals) in the TC Default Daily Activity 
Report By 2 Levels. The options for Detail Levels are: 

 Date: Choose this option to display all details and totals. 

 Totals for 3rd Level: Choose this option to display details and totals for Levels 1-3. 

 Totals for 2nd Level: Choose this option to display details and totals for Levels 1-2. 

 Totals for 1st Level: Choose this option to display details and totals for Level 1 only. 

Sort Levels 
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You can display data in the TC Default Daily Activity Report By 2 Levels sorted by time-costing 
level. 

 You can display data sorted by Work Order, within Work Order by Process, and within Process by 

Employee. 

This report supports three levels of sorting. For each level, choose from the following options: 

 Any active time-costing level (Work Order, Batch, Part, Process) 

 Employee number 

 For the purposes of this Help file, time-costing levels are sometimes referred to by the following names:  

 Level 1 Level 2 Level 3 Level 4 

 Work order Batch Part Process 

Page Break On Change Of 

You can choose where to place page breaks in the report output. Depending on the report 
chosen, choose from the following options: 

 Date 

 Any active time-costing level (Work Order, Batch, Part, or Process) 

 Any organizational level (Employee, Department, Site, or Plant) 

 Without page breaks 

Work Order/Batch Display 

 Work Order: Choose this option to display work orders in the report. 

 Batch: Choose this option to display batches in the report. 

 Work Order and Batch: Choose this option to display both work orders and batches in the report. 

 None: Choose this option to display neither work orders nor batches in the report. 

Part/Process Display 

 Part: Choose this option to display parts in the report. 

 Process: Choose this option to display processes in the report. 

 Part and Process: Choose this option to display both parts and processes in the report. 

 None: Choose this option to display neither parts nor processes in the report. 

Send Report To 

You can choose where to display the report output: 

 Print Preview: Choose this option to view the report on the screen page by page, exactly as it will appear in the printer output. 

 The Print Preview begins by displaying the first page of the report. Click Next to see the next page of the 

report, unless you are viewing the last page of the report. Click Close to close the Print Preview. 

 Printer: Choose this option to send the report to a printer. If you choose this option, make sure your print setup is correct by 

choosing Print Setup from the File Menu in the Report menu bar. For Help using Print Setup, click here. 
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 Screen: Choose this option to display the report output on your screen. This option allows you to review the report without 

producing a hard copy. For Help reading the Screen display of your report, click here. 

 File: Choose this option to send the report output to a plain text file. When you choose this option, a new field is displayed to 

the right of the arrow on this line. Click that field and type the name of the file. 

 The report output is sent to a plain text file in the Tk5win folder or directory. This file can then be easily 

accessed for use by other applications, such as word processors. 

Footer Text 

Footer text is displayed at the bottom of each page of the report output. This text is optional. 

 You can use this Footer text for the name and signature of the supervisor checking the report printout, for 

notes relating to the content of the report, or for holiday messages. 

If you want to include a line of text in the Footer, click the Footer Text 1 field and type the desired 
text. If you want to add a second line of text, click the Footer Text 2 field and type the desired text. 
You may type up to 40 characters in each field. 

After you choose the desired options from all fields, click OK to close the Output Options dialog 
box. The options you have chosen are displayed in the right-hand panel of the Report Parameters 
box. 

Reading TC Activity Reports 

 Before you can read a TC Activity Report, you need to produce it. For Help producing TC Activity Reports, 

click here. 

Header 

The top of each page of the report (the Header) displays: 

 at the top center, the User Name (for example, "Punctual Products, Inc."), which is the User Name defined in the system 

configuration 

 on the top left, the number and title of the report and the date or period range covered by the report 

 on the top right, the current page number and the date and time that the report was produced 

Sub-Header 

Some reports include a sub-Header, which displays the numbers and names of the organizational 
and time-costing levels included in the report. 

 You can use a synonym for any level of your organization. 

 For the purposes of this Help file, time-costing levels are sometimes referred to by the following names:  

 Level 1 Level 2 Level 3 Level 4 

 Work order Batch Part Process 

Body 

The Body of the report is comprised of columns. Following are the columns displayed in various 
TC Activity Reports. Not all of the following columns are displayed in all of the reports. Report 
columns include: 
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 the Date or Period

 the Employee Number and Name 

 the Start and End times for the job 

 Numbers and Names of organizational levels

 Numbers and Names of time-costing levels

 the Net Duration of hours between the Start and End times 

 Rates and Costs 

 Record Status: A value of 1 indicates that the Record has been calculated. A value of 2 indicates that the Record either has 

an Error, or has been corrected but not recalculated. 

 Manual Update: A value of 1 indicates that the Record has been manually edited. A value of 0 indicates that the Record has 

not been manually edited. 

 TK In and Out punches 

 TC pay categories 

A summary (the sub-Total) can be displayed at the end of report sections. The summary of the 
entire report can be displayed at the end of the report. Depending on the report chosen, and the 
settings chosen in the Report Output Options dialog box, the summary can include: 

 the total number of hours 

 the total cost 

 the total Net Duration 

Footer 

The bottom of each page of the report (the Footer) displays: 

 on the bottom left, above the line: the Footer text which was defined in the Output Options dialog box 

 on the bottom left, below the line: copyright information regarding TimeCosting-PC 

 on the bottom right, below the line: the name and creation date of the executable program used to produce the report, the font 

name and size chosen in the Fonts dialog box, and the character width chosen in the Percents dialog box 

When you send a report to the Screen or Print Preview, TimeCosting-PC tells you which page you 
are viewing. On the bottom right of your screen, below the horizontal scroll bar, the current page 
number and total number of pages are displayed. 

 If you are viewing the third page of a five-page report, the legend "Page 3 of 5" will be displayed. 

After You Read the Report 

If you sent the report to the Screen or Print Preview, you need to close the report to return to the 
report dialog box. 

To close a Screen report, click the Exit Program icon: 

 

To close a Print Preview, click Close. 

TC Pay-Period Summary Reports 
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What Are They? 

TC Default Pay-Period Summary Reports are a base for creating user-defined reports. They are 
comprehensive reports including all relevant data parameters. 

There are three types of TC Default Pay-Period Summary Report: 

 TC Default Pay-Period Summary Report: This report displays all time-costing data for the selected periods, sorted by 

organizational levels (Employee, Department, Site, Plant). 

 TC Default Pay-Period Summary By All Levels: This report displays all time-costing data for the selected periods, sorted by all 

active time-costing levels (Process, Part, Batch, Work Order). 

 TC Default Pay-Period Summary By 2 Levels: This report displays all time-costing data for the selected periods, sorted by 

only two of the active time-costing levels. 

Why Would I Want It? 

You can create your own user-defined TC Pay-Period Summary Report and choose to use only 
some of the parameters included in these reports. 

 

Producing the Reports  

Reading the Reports  

What Other Reports Can I Produce? 

To Produce TC Default Pay-Period Summary Reports 

1. Choose Reports & Graphs from the Main Menu Bar. 

2. Choose TC Pay-Period Summary Reports. 

3. Choose the desired report from the sub-menu. The appropriate report dialog box is displayed, with the current report 
parameters displayed in the white Report Parameters box, below the Report Tool Bar. 

4. Choose Pay Periods for the report. For Help choosing report periods, click here. 

5. Choose report ranges for the parameters in the left-hand panel. For Help choosing report range values, click here. 

6. Choose report output options. For Help choosing report output options, click here. 

7. Choose Start Report or click the Start Report icon: 

 

If You Need Help Making Changes in the Report: 

 If part of the report is cut off, or if some of the characters are not visible, click here. 

 If you want to change the fonts used in the report, click here. 

Choosing Pay Periods for the TC Default Pay-

Period Summary Report 

The TC Default Pay-Period Summary Report displays data for a range of Pay Periods. The Report 
Period Menu determines the periods to be included in the report. The periods you choose are 
displayed in the top panel of the Report Parameters box. 

The Select option allows you to choose periods based on a calendar. The Default option allows 
you to choose periods based on their proximity to the current period. 
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 If the current monthly period is August, 1997, you can choose the months of July to October, 1997 with the 

Select option by entering the Period numbers of 7 to 10 in 1997. You can also choose those months with 

the Default option by entering a range of -1 to 2. 

 The Save option in the Report File Menu saves your changes to the Default value, so it can be saved for 

future use. It does not save your changes to the Select value, which applies only to the current run of the 

program. 

For Help choosing periods with the Select option, click here. 

For Help choosing periods with the Default option, click here. 

Choosing Periods with the Select Option 

Choose Select from the Report Period Menu to open the Period dialog box: 

 

The current period is displayed until new values are selected. 

The Period Code field displays the length of the selected periods. You can change the Period 
Code by clicking the arrow immediately to the right of the Period Code field to open a drop-down 
list of Period Codes. 

You can also use the up and down arrows to the right of the drop-down arrow to scroll through the 
list of Period Codes. Click the down arrow for the next shortest Period Code. Click the up arrow 
for the next longest Period Code. 

 When you change the Period Code, the From and To Period Numbers change automatically to keep the 

current period displayed. 

The From and To fields indicate the first and last periods in the range. 

The From and To Period Number fields display the positions of the selected periods in the 
selected years. 

 In the example above, the month of August is the 8th Monthly Period in 1997, so the Period Number is 8. 

The From and To Year fields display the selected years. 

You can choose periods with the Select option in either of two ways: 

 by choosing Period Codes, Numbers, and Years 

 by using a graphic calendar display (the Calendar) 
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To Choose Period Codes, Numbers, and Years 

1. Choose Select from the Period menu in the Report Menu Bar. The Period dialog box is displayed. 

2. Choose the Period Code, either by typing it, by clicking the drop-down arrow to open a drop-down list of Period 
Codes, or by clicking the up and down arrows to scroll through the list of Period Codes. 

 When you change the Period Code, the Period Number and the From and To dates change automatically to 

keep the current period displayed. 

3. Click the From Period # field. 

4. Choose the From Period Number, either by typing it or by clicking the up and down arrows. 

5. Choose the From Year, either by typing it or by clicking the up and down arrows. 

6. Repeats steps 3-5 for the To Period. 

7. After you select the desired range, click OK to close the Period dialog box. The periods you have chosen are 
displayed in the top panel of the Report Parameters box. 

Choosing Report Periods with the Calendar 

TimeKeeper-PC's Calendar allows you to choose periods from a convenient graphic calendar 
display. Click Calendar in the Period dialog box to open the Calendar dialog box: 

 

The Calendar dialog box displays the Period Type in the top left corner, the Period Type Name in 
the top center, and the Selection Color in the top right corner. The Calendar displays the full 
calendar year, with the Period highlighted by the Selection Color. 

 The example above highlights the weekly period of March 2nd to 8th, 1997. 

The default value for the Period Type is displayed until a new value is selected. The current year 
and period are displayed until new values are selected. 

 The example above will be displayed if you open this dialog box on March 6th, 1997, with Weekly as the 

Default value for the Period Type. 

Click and hold the right mouse button on any day in the Calendar to display that date, the Period 
Number it belongs to, and the Year. When you release the right mouse button, this display 
disappears. 

This right-click feature enables you to see which Period Number a date belongs to, without having 
to close the Calendar and return to the Period dialog box. 

 In the example above, if you click and hold the right mouse button on March 6th, you will see the display: 

"03/06/1997 Period:10 Year:1997". 
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To Choose Report Periods with the Calendar 

1. Choose Select from the Period Menu in the Report Menu Bar. The Period dialog box is displayed. 

2. Click the From Period # field. 

3. Click Calendar. The Calendar is displayed, displaying the current From Year and From Period highlighted by the 
Selection Color. 

 If you change the values in the Period dialog box before clicking Calendar, the Calendar will display the 

new values you have chosen. 

4. Click the arrow under Period Type to open a drop-down list of Period Types and their corresponding Names. The 
currently selected Period Type and Name are displayed as raised gray buttons with white characters. 

5. Click anywhere on any Period Type or Name to choose it. The drop-down list closes, and the new Period Type and 
Name are displayed at the top of the Calendar. No period is highlighted by the Selection Color. 

6. Use the vertical scroll bar on the right side of the screen to move upward to a preceding year, or downward to a 
following year. 

7. Click on any day within the desired From Period. The selected period is highlighted by the Selection Color. 

8. When the desired From Period is displayed, click OK to close the Calendar dialog box. In the Period dialog box, the 
new selections for Period Type, From Period Number, and From Year are displayed. 

9. Repeats steps 6-8 for the To Period. 

10. Click OK to close the Period dialog box. The Periods you have chosen are displayed in the top panel of the Report 
Parameters box. 

Choosing Periods with the Default Option 

The Default option allows you to choose periods based on their proximity to the current period. 
This allows you to always produce reports with the same relationship to the current period. 

 If the Period Code is Monthly and the Period Number range is -6 to -2, then the report will always cover a 

range between six and two months before the current period. 

Select Default from the Report Period Menu to open the Period dialog box: 

 

The Period Code field displays the length of the selected period. You can change the Period Code 
by clicking the arrow to the right of the Period Code field to open a drop-down list of Period Codes. 

You can also use the up and down arrows to the right of the drop-down arrow to scroll through the 
list of Period Codes. Click the down arrow for the next shortest Period Code. Click the up arrow 
for the next longest Period Code. 

The Period Numbers are displayed relative to the current period. A negative number shows the 
number of periods before the current period, and a positive number shows the number of periods 
after the current period. 
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 In the example above, the From Period is two periods before the current period, and the To Period is one 

period before the current period. If this Monthly period report is produced in August, it will be produced for 

the months of June and July. 

You can change Default Period values by double-clicking a Period Number and typing a new 
value. 

You can also change Default Period values by clicking the arrows next to a Period Number. Click 
the up arrow to raise the value by one. Click the down arrow to lower the value by one. Click and 
hold the arrow to scroll through values. 

To Choose Period with the Default Option 

1. Select Default from the Period menu in the Report Menu Bar. The Period dialog box is displayed. 

2. Choose the Period Code, either by typing it, by clicking the drop-down arrow to open a drop-down list of Period 
Codes, or by clicking the up and down arrows to scroll through the list of Period Codes. 

3. Choose the From Period Number, either by typing it or by clicking the up and down arrows. 

4. Choose the To Period Number, either by typing it or by clicking the up and down arrows. 

5. After you enter the desired values, click OK to close the Period dialog box. The periods you have chosen are 
displayed in the top panel of the Report Parameters box, based on its proximity to the current period. 

Advanced TC Data Editing 

What Is It? 

As part of TimeCosting-PC in seven easy steps, you need to edit TC Daily Activity files by 
Department. For Help editing TC Daily Activity files by Department, click here. 

You can also edit TC Daily Activity files by Employee. Instead of using the Daily Browser to edit 
files for a number of Employees on a single day, you use it to edit files for a single Employee on a 
number of days. 

Why Would I Want It? 

Regular TC data editing is useful for job supervisors correcting cost charges made for Employees 
to their jobs. Advanced TC data editing is useful for Employee supervisors correcting time-costing 
for each Employee under their supervision. 

When you edit Daily Activity by Employee, the Daily Browser displays all Records from a specified 
date until the present. 

 

Editing an Employee Daily Activity File 

Reading an Employee Daily Activity File 

Where Do I Go Next? 

Editing an Employee TC Daily Activity File 

 Before you edit Employee daily activity, it is recommended that you produce the Daily Transactions Report. 

For Help producing the Daily Transactions Report, click here.  

To Edit an Employee Daily Activity File 

1. Choose Daily Activity Data (by Employee) from the Edit/View menu. The Select Range to Edit dialog box opens. 

2. Choose the Employee to be displayed. For Help choosing an Employee, click here. 

3. Choose the first date to be edited. For Help choosing the first date to be edited, click here. 
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4. Choose the Records Type to be displayed. For Help choosing a Records Type, click here. 

5. Click OK. The TC Daily Browser (Daily Activity File) dialog box opens. For Help reading the TC Daily Activity File, 
click here. 

6. Modify incorrect job transfers. For Help modifying job transfers, click here. 

7. Add missing job transfers. For Help adding missing job transfers, click here. 

8. Delete job transfers as you want. For Help deleting job transfers, click here. 

9. After you make all desired changes, click the Save Record icon: 

 

You have now edited the Employee's Daily Activity File. 

Choosing an Employee for the TC Daily Browser 

To Choose an Employee by Number 

1. Click the drop-down arrow next to the Number field to open a list of Employees sorted by number. The currently 
selected Employee will be displayed as a raised gray button with white characters. If no Employee has been chosen 
yet, the first Employee on the list will be selected. 

2. Use the vertical scroll bar on the right to scroll up and down the list. 

3. To choose an Employee, click anywhere on that Employee's line. The drop-down list will close, and the number of the 
selected Employee will be displayed in the Number field. The name of the selected Employee will be displayed in the 
Last Name and First Name fields. 

 You cannot edit the First Name field, which displays the corresponding first name for the Employee you 

have chosen. 

4. You can also choose an Employee by entering the Employee's number in the Number field. The corresponding name 
will be displayed in the Last Name and First Name fields only after you click another field or button in the dialog box. 

To Choose an Employee by Name 

1. Click the drop-down arrow next to the Last Name field to open a list of Employees sorted by last name. The currently 
selected Employee will be displayed as a raised gray button with white characters. If no Employee has been chosen 
yet, the first Employee on the list will be selected. 

2. Use the vertical scroll bar on the right to scroll up and down the list. 

3. To choose an Employee, click anywhere on that Employee's line. The drop-down list will close, and the name of the 
selected Employee will be displayed in the Last Name and First Name fields. The number of the selected Employee 
will be displayed in the Number field. 

 You cannot edit the First Name field, which displays the corresponding first name for the Employee you 

have chosen. 

4. You can also choose an Employee by entering the Employee's last name in the Last Name field. The corresponding 
number will be displayed in the Number field only after you click another field or button in the dialog box. 

 Employee last names are case-sensitive to their definition in the Employee Profile. 

 Employees with the same last name will be displayed in the Last Name drop-down list in alphabetical order 

of first name. 

Choosing a Beginning Date for the TC Daily 

Browser 
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You can choose the date from which daily activity is to be edited either by typing it in, or by 
choosing it from a convenient graphic calendar display. 

To choose a date by typing it in, click the Daily Records From Date field and enter the date. For 
Help using date formats, click here. 

To choose a date with the Calendar, click the Calendar icon:  

The Calendar dialog box will open: 

 

To Choose a Date with the Calendar Dialog Box 

1. Click the Calendar icon. The Calendar dialog box will open, displaying the current year, month, and date. In the 
Select Range to Edit dialog box in the background, the Date to Search will change from black to red. 

 If you change the values in the Select Range to Edit dialog box before clicking the Calendar icon, the 

Calendar will display the new values you have chosen. 

2. On the bar displaying the current year, click the arrow to the left for the preceding year, or the arrow to the right for 
the following year. The display will change by one year with each click. 

3. On the bar displaying the current month, click the arrow to the left for the preceding month, or the arrow to the right 
for the following month. The display will change by one month with each click. 

4. On the calendar display in the center of the dialog box, click the desired date. The selected date will be displayed as 
a raised gray button with a blue number. 

5. When the desired date is displayed, click OK to close the Calendar dialog box. In the Select Range to Edit dialog 
box, the Daily Records From Date will change from red to black. 

Reading an Employee TC Daily Activity File 

When you choose Employee Daily Activity Data from the Edit/View menu, choose options from 
the Select Range to Edit dialog box, and click OK, the Daily Browser opens. 



  79 

 

The Daily Browser menu bar and tool bar are displayed at the top of the dialog box. The menu bar 
contains the menu options available for the Daily Browser. The tool bar contains the icons 
available for the Daily Browser. 

The number and name of the Employee selected in the Select Range to Edit dialog box are 
displayed below the tool bar. 

Each line in the upper window of the Daily Browser is a TimeKeeper-PC Employee Record. A TK 
Employee Record contains time and attendance data for the selected Employee on one day. 

TimeCosting-PC Employee Records are displayed in the lower (Second File) window of the Daily 
Browser. If the Second File window is not displayed, choose TCDAY (Daily Job Transfers/TC) 
from the Second File menu on the Daily Browser menu bar to display the Second File window. 

The Second File window displays all the TC Employee Records for the Employee's TK Record 
(one Employee on one date) currently selected in the upper window. A TC Employee Record 
contains time and attendance data for that Employee in one job on that day, including start and 
end times, initial pay calculations, and Error and Exception messages. Pay calculations are made 
according to tables in the Employee's Contract. 

 When you make any change in a Record, it is flagged for recalculation and displayed in red characters until 

you save or calculate the Record. This does not necessarily mean that your change has caused an Error in 

TimeCosting-PC's calculations. 

 If no other information has been entered, the default jobs and percentages are the Employee's default job 

assignments as defined in TC Setup. These default values are displayed in purple characters. For Help 

assigning Default Jobs to Employees, click here. 

Since the Second File window displays TC Employee Records for only one date at a time, you 
must first select the TK Employee Record which corresponds to the desired date. The TK 
Employee Records in the upper window are sorted by date. Click any Record to select it. The 
currently selected Record is marked with a black triangle: 

 

TC Employee Records in the lower (Second File) window are sorted by time. Click any Record to 
select it. The currently selected Record is marked with a black triangle: 
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When you enter data or calculate the Record, the black triangle symbol changes to a pencil 
symbol, which is displayed until you select another Record: 

 

Press <Tab> to move forward to the next column and select it. Hold <Shift> and press <Tab> to 
move backward to the previous column and select it. You can also use the horizontal scroll bar at 
the bottom of the dialog box to scroll across columns. 

 Click the Go To Next Record icon to move to the beginning of the next Record in the 
Second File window. The first column is usually the Record Date column. This can be useful if you 
are viewing columns on the far right end of the Record and want to return to the left-hand 
columns. 

 Click the Display Previous Employee icon to display the previous Employee by Employee 
Number. 

 Click the Display Next Employee icon to display the next Employee by Employee Number. 

Columns can be defined in the system configuration as non-scrolling, meaning that they are 
continuously displayed as you scroll across other columns. These columns are displayed with a 
gray background. In the example below, the Record Date column is displayed as you scroll across 
other columns, but the Work Order and Process columns are not. 

 

If the first (left-hand) column of the Daily Browser is non-scrolling, you can use it to return to the 
other (scrolling) left-hand columns. Click the non-scrolling column to select it, and press <Tab> 
repeatedly until the first scrolling (white background) column is displayed. 

You can modify the screen structure of the Daily Browser to find certain information more easily. 
For Help modifying the screen structure of the TC Daily Browser, click here. 

The exact columns included in the TC Daily Browser are defined in the system configuration in 
TimeKeeper-PC Set-Up. For Help reading TC Daily Browser columns, click here. 

 

For Help modifying job transfers, click here. 

For Help adding missing job transfers, click here. 

For Help deleting job transfers, click here. 

Editing Employee TC Daily Activity -- Where Do I 

Go Next? 

Click the Exit icon to close the Daily Activity File: 

 

If you have changed any Records but not saved them, you will be prompted by a small dialog box: 
"Current Record Has Been Changed! Save?" 

 If you want to save the changes you have made to the current Record, click Yes. 

 If you want to exit without saving those changes, click No. 
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 If you want to continue working in the current Record, click Cancel. 

You can also view and edit a different set of records without having to close the dialog box. For 
Help viewing and editing a different set of records, click here. 

After you edit daily activity, you need to export the corrected summary for use in payroll, billing, or 
costing. For Help exporting TC data, click here. 

To View and Edit a Different Set of Employee Records 

1. Choose Specify Required Range from the File menu, or press <F9>. If you have not made any changes in the current 
Record, or if you have saved them already, the Select Range to Edit dialog box opens. 

2.  If you have made changes but not saved them, you will be prompted by a small dialog box: "Current Record Has 
Been Changed! Save?" Click Yes to save the changes you have made in the current Record, or No to close the Daily 
Activity File without saving those changes. The Select Range to Edit dialog box opens. 

3. Choose the Employee to be displayed. For Help choosing an Employee, click here. 

4. Choose the first date to be edited. For Help choosing the first date to be edited, click here. 

5. Choose the Records Type to be displayed. For Help choosing a Records Type, click here. 

6. Click OK. The TC Daily Browser (Daily Activity File) dialog box opens. For Help reading the TC Daily Activity File, 
click here. 

 You can open a new dialog box to specify a different set of records for viewing and editing. TimeKeeper-PC 

will prompt you to save changes for the current set of records. 

TC Maintenance 

The Maintenance menu allows you to carry out the following tasks: 

 back up and restore data and system files 

 globally update and recalculate TC Daily Activity Files 

 create and change transactions files 

Backing Up And Restoring Files 

What Is It? 

You can back up and restore data and system files. 

Why Would I Want It? 

Data and system files which are vital to your daily operation can be lost or corrupted over time. 
Backing up files ensures that you have valid copies of all system information. In case of file loss or 
corruption, you can restore backed up files. 

For Help backing up and restoring daily and pay-period activity files, click here. 

For Help backing up and restoring Setup tables and system files, click here. 

Backing Up And Restoring Activity Data Files 

Choose Backup/Restore Daily & Pay-Period Files from the Maintenance menu. The Select File to 
Process dialog box is displayed. 

The large panel displays a list of available files and their descriptions. Click to choose the file to process. 

Click to choose one of the following actions: 
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 Back Up: Backs up the selected file to a zipped archive file. 

 Restore: Restores the selected file from a zipped archive file. 

 Back Up and Delete: Backs up the selected file to a zipped archive file, and deletes the records that were backed up from the 

file. 

The Backup/Restore dialog box is displayed. The dialog box title corresponds to the selected 
action. 

The Backup/Restore Parameters box is the white box at the bottom of the dialog box with black 
and blue characters. The blue characters display parameter names, and the black characters 
display the values currently chosen for them. When you first load the program, the values 
displayed are the default values. 

The values displayed in the Backup/Restore Parameters box correspond to menus on the menu 
bar. For Help using the Backup/Restore menu bar, click here. 

You can also change parameters without using the menus. Double-click any black or blue text in 
the Backup/Restore Parameters box to open the dialog box for the corresponding parameter. 
Click OK to close a dialog box, and the parameter displayed in the Backup/Restore Parameters 
box is automatically updated. 

 To change the backup file name, double-click the words Backup File Name in the Backup/Restore 

Parameters box. The Select Backup File dialog box is displayed, allowing you to change the backup file 

name. 

If you have used the Select option to change parameters while the dialog box is open, double-
clicking opens the Select dialog box instead of the Default dialog box. 

You can also open parameter menus with the right mouse button. Right-click any black or blue 
text in the Backup/Restore Parameters box to open the corresponding menu within the 
Backup/Restore Parameters box. 

 To open the Employee menu, right-click the word Employee in the Backup/Restore Parameters box. The 

Employee menu is displayed within the Backup/Restore Parameters box, allowing you to choose the Select 

or Default option. 

After you choose parameters for the data files to back up or restore, click Begin on the menu bar 
to begin backing up or restoring. You can also click the Backup icon: 

 

Backup/Restore Menu Bar 

The following options are displayed on the Backup/Restore menu bar. 

File menu: 

 Select Standard File: Choose this option to open the Select File to Process dialog box and choose another backup or restore 

action. When you choose a new file and action, you will be prompted by a small dialog box: "Change Current Settings?" Click 
Yes. 

 Select Backup File: Choose this option to open the standard Windows file dialog box. Choose a backup file to back up to or 

restore from, and click OK. Use this option when the file you wish to backup or restore either has a non-standard name or is 
not located in the standard sub-directory. 

 Save: Choose this option to save the current backup file. 

 Exit: Choose this option to close the Backup/Restore dialog box. You can also click the Exit icon: 
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Backup/Restore Parameter menus: There is a separate menu for each parameter displayed in the 
Backup/Restore Parameters box. For time parameters (Date, Period, or Year), the options are 
Select and Default. For other parameters (organizational levels and Employee-specific data), the 
options are All, Select, and Default. 

Begin: The Begin command corresponds to the selected action (Back Up, Restore, or Back Up 
and Delete). Click to begin backing up or restoring. You can also click the Backup icon: 

 

Backing Up And Restoring System Files 

You can back up and restore three types of system files: 

 System Configuration Files 

 System Files 

 System Tables 

For Help backing up system files, click here. 

For Help restoring system files, click here. 

Backing Up System Files 

Choose Back Up Tables and System Files from the Maintenance menu. The Back Up Tables & 
Files dialog box is displayed. 

The Back Up Tables & Files dialog box consists of three large panels, corresponding to the three 
types of system files: 

 System Configuration Files 

 System Files 

 System Tables 

Each panel contains a list of all of the files of that type currently available in the system. Files 
which are selected for backing up are highlighted in blue. 

When you open the Back Up Tables & Files dialog box, all files in all three panels are selected. To 
select individual files in a panel, click Selected to deselect all of the files. Click any file to select it. 
You can select as many files as you want. Once a file is selected, you can deselect it by clicking it 
again. Click All to select all of the files in a panel. 

The name of the currently selected backup file is displayed in the Backup File Name field. To 
choose a different backup file, double-click the field and type the full file path and name. You can 
also choose a file by clicking the Browse button to display the standard Windows file dialog box. 
Choose a backup file and click OK. 

After you choose files to back up and choose the backup file, click the Begin Backup icon to begin 
backing up: 

 

After you finish backing up, click the Exit icon to close the Back Up Tables & Files dialog box: 
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Restoring System Files 

Choose Restore Tables and System Files from the Maintenance menu. The Restore Tables & 
Files dialog box is displayed. 

The Restore Tables & Files dialog box consists of three large panels, corresponding to the three 
types of system files: 

 System Configuration Files 

 System Files 

 System Tables 

Each panel contains a list of all of the files of that type currently available in the selected backup 
file. Files which are selected for restoring are highlighted in blue. 

When you open the Restore Tables & Files dialog box, all files in all three panels are selected. To 
select individual files in a panel, click Selected to deselect all of the files. Click any file to select it. 
You can select as many files as you want. Once a file is selected, you can deselect it by clicking it 
again. Click All to select all of the files in a panel. 

The name of the currently selected backup file is displayed in the Backup File Name field. To 
choose a different backup file, double-click the field and type the full file path and name. You can 
also choose a file by clicking the Browse button to display the standard Windows file dialog box. 
Choose a backup file and click OK. 

After you choose files to restore and choose the backup file, click the Begin Restore icon to begin 
restoring files: 

 

After you finish restoring files, click the Exit icon to close the Restore Tables & Files dialog box: 

 

Globally Updating and Recalculating TC Daily 

Activity Files 

You can update TC Daily Activity files. 

 You are currently using 3-digit department numbers, but your expanding organization needs to add an 

extra digit to current Department numbers, to allow for new Departments. You can add 1000 to the current 

Department numbers in all existent TC Daily Activity files, to match the new 4-digit Department numbers. 

For Help updating TC Daily Activity files, click here. 

You can recalculate TC Daily Activity files. 

 You want to increase TC rates retroactively for the past six months. After you change the rate values, you 

can recalculate the relevant TC Daily Activity files. 

For Help recalculating TC Daily Activity files, click here. 

Updating TC Daily Activity Files 

What Is It? 
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You can edit matching fields in a large number of Daily Activity files with a single command. 

Why Would I Want It? 

This function enables you to edit matching fields in a large number of files, without having to open 
and edit each file individually. 

To update TC Daily Activity files, choose Global Update - TC Files from the Maintenance menu. 
Choose TC - Update Daily Activity File (By Date) from the sub-menu. The TcDay File Update 
dialog box is displayed. 

The Global Update Parameters box is the white box at the top of the dialog box with black and 
blue characters. The blue characters display parameter names, and the black characters display 
the values currently chosen for them. When you first load the program, the values displayed are 
the default values. 

The values displayed in the Global Update Parameters box correspond to menus on the menu 
bar. Use these menus to choose values for the data files to be globally updated. 

You can also change parameters without using the menus. Double-click any black or blue text in 
the Global Update Parameters box to open the dialog box for the corresponding parameter. Click 
OK to close a dialog box, and the parameter displayed in the Global Update Parameters box is 
automatically updated. 

 To change the Date, double-click the word Date in the Global Update Parameters box. The Default Date 

dialog box is displayed, allowing you to change the Date. 

If you have used the Select option to change parameters while the dialog box is open, double-
clicking opens the Select dialog box instead of the Default dialog box. 

You can also open parameter menus with the right mouse button. Right-click any black or blue 
text in the Global Update Parameters box to open the corresponding menu within the 
Backup/Restore Parameters box. 

 To open the Employee menu, right-click the word Employee in the Global Update Parameters box. The 

Employee menu is displayed within the Backup/Restore Parameters box, allowing you to choose the Select 

or Default option. 

Enter expressions to update fields in the lower panel of the dialog box. 

You can update fields with a simple mathematical expression. For Help updating fields with simple 
expressions, click here. 

You can also update fields with extended condition and calculation expressions. For Help 
Updating Fields with Extended Expressions, click here. 

You can automatically recalculate Records after updating data fields. To automatically recalculate 
Records, select the Automatically Recalculate Records check box. 

 The TC Daily Activity File can contain a number of job transfer records for a single day, and it can be 

unwieldy and time-consuming to calculate all of them every time you update a field. This is especially true 

if the change you are implementing has no effect on either the duration or the cost values in the records 

(for example, expanding job numbers from three to four digits). 

Instead of automatically recalculating TC Records, you can select the specific Records to 
recalculate by condition expression. For Help recalculating TC Daily Activity files, click here. 

After you choose global update parameters and enter a simple or extended expression, choose 
Begin from the menu bar to update the selected fields. 

You can save TcDay File Update dialog box settings by choosing Save from the File menu. 
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When you are done updating fields, choose Exit from the File menu. 

Updating Fields with Simple Expressions 

When you open the TcDay File Update dialog box, the lower panel displays the Simple 
Expression table. You can toggle between the Simple Expression and Extended Expression 
tables by clicking the radio buttons between the upper and lower panels of the dialog box. 

To Enter a Simple Expression for Globally Updating a Field 

1. Click the drop-down arrow in the Field To Update column to open a list of TC Daily Activity File fields. Click to choose 
a field. 

2. Type a constant by which the values in that field are to be multiplied in the Multiply by Constant column. 

3. Type a constant to be added to the values in that field in the Add Constant column. 

4. Type the lowest value in that field to be updated in the From Value column. 

5. Type the highest value in that field to be updated in the To Value column. 

6. You can repeat steps 1-5 for up to five separate Daily Activity File fields. 

Updating Fields with Extended Expressions 

When you open the TcDay File Update dialog box, the lower panel displays the Simple 
Expression table. Click the Extended Expression button to display the Extended Expression table 
in the lower panel. 

To Enter an Extended Expression for Globally Updating a Field 

1. Click the drop-down arrow in the Field To Update column to open a list of TC Daily Activity File fields. Click to choose 
a field. 

2. Click the Condition Expression field to display the ellipsis button . Type the Condition Expression in the Condition 
Expression field, or click the ellipsis button to display the Expression Builder dialog box. 

3. Use the Expression Builder dialog box to build the Condition Expression. 

4. When the Condition Expression is complete, press Verify to test the logic of the expression. If a problem is detected, 
an error message will be displayed. 

5. Click OK to confirm the expression and return to the Extended Expression table. 

6. Repeat steps 2-5 for the Calculation Expression field. 

7. You can repeat steps 1-6 for up to five separate Daily Activity File fields. 

Recalculating TC Daily Activity Files 

What Is It? 

You can recalculate a large number of Daily Activity files with a single command. 

Why Would I Want It? 

After you change a value which affects a large number of files, this function enables you to 
recalculate them all, without having to open and recalculate each file individually. 

To recalculate TC Daily Activity files, choose Global Update - TC Files from the Maintenance 
menu. Choose TC - Calculate Daily Activity File (By Date) from the sub-menu. The TcDay 
Calculate dialog box is displayed. 

The Global Calculate Parameters box is the white box at the top of the dialog box with black and 
blue characters. The blue characters display parameter names, and the black characters display 
the default values currently chosen for them. 
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The values displayed in the Global Calculate Parameters box correspond to menus on the menu 
bar. Use these menus to choose values for the data files to be globally updated. 

You can also change parameters without using the menus. Double-click any black or blue text in 
the Global Calculate Parameters box to open the dialog box for the corresponding parameter. 
Click OK to close a dialog box, and the parameter displayed in the Global Calculate Parameters 
box is automatically updated. 

 To change the Date, double-click the word Date in the Global Calculate Parameters box. The Default Date 

dialog box opens, allowing you to change the Date. 

If you have used the Select option to change parameters while the dialog box is open, double-
clicking opens the Select dialog box instead of the Default dialog box. 

You can also open parameter menus with the right mouse button. Right-click any black or blue 
text in the Global Update Parameters box to open the corresponding menu within the 
Backup/Restore Parameters box. 

 To open the Employee menu, right-click the word Employee in the Global Calculate Parameters box. The 

Employee menu is displayed within the Global Calculate Parameters box, allowing you to choose the 

Select or Default option. 

Type a Condition Expression for fields to be recalculated in the Condition Expression field, or click 
the ellipsis button  to display the Expression Builder dialog box. 

Use the Expression Builder dialog box to build the Condition Expression. You can include TK 
Daily Activity and Employee Profile fields in the Condition Expression. 

 You can recalculate TC Daily Activity files for Employees with an In punch between 8:00 AM and 10:00 AM. 

When the Condition Expression is complete, press Verify to test the logic of the expression. If a 
problem is detected, an error message will be displayed. 

Click OK to confirm the expression and return to the DaDay Calculate dialog box. 

After you choose global recalculation parameters and enter a Condition Expression, choose Begin 
from the menu bar to recalculate the selected fields. 

You can save TcDay Calculate dialog box settings by choosing Save from the File menu. 

When you are done recalculating fields, choose Exit from the File menu. 

Creating and Changing Transactions Files 

You can create new transactions files by manually entering job transfer activity data. For Help 
creating new transactions files, click here. 

You can also change the structure of transactions files. 

 Your current transactions files display the year as two digits. To display the year as four digits in 

transactions that have already been registered, you can add spaces for two additional digits in each 

transaction. 

For Help changing the structure of transactions files, click here. 

Creating New Transactions Files 

What Is It? 
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Normally, transactions files are created automatically from information acquired by punch clocks. 
You can manually create transactions files which the system processes in the same way it 
processes raw input data. 

Why Would I Want It? 

In case of clock failure or human error, you can manually enter information which was not 
acquired by punch clocks. 

To Create a New Transactions File 

1. Choose View/Edit Invalid Punches from the Maintenance menu. The Edit Erroneous Transactions window displays a 
blue bar which fills across a scale in the window. This bar marks the progress of the transfer of TK punch 
transactions to a temporary file. 

2. When the transfer of punch transactions is completed, the TK Transactions File (Edit Erroneous Transactions) is 
displayed. 

3. Choose New File from the File menu, or click the New File icon: 

 

4. You will be prompted by a small dialog box: "Update Invalid Punch File with Edits?" Click No. All data is cleared from 
both the upper and lower panels of the dialog box. 

5. Add new transactions to the transactions file. For Help adding new transactions to a transactions file, click here. 

6. When you are done adding new transactions, choose Save File As from the File menu, or click the Save File As icon: 

 

7. You will be prompted by a small dialog box: "Create New File From Current?" 

8. Click Yes. The Enter File Name To Save dialog box is displayed. 

9. Choose the file type and path, type the file name, and click OK. 

10. Choose Exit from the File menu, or click the Exit icon: 

 

11. You will be prompted by a small dialog box: "Update Invalid Punch File with Edits?" Click No. 

To Add a New Transaction to a Transactions File 

1. Choose Add New Transaction from the Edit menu. A new transaction line is displayed in the upper panel of the dialog 
box. 

2. Enter information about the transaction in the lower (Transaction to Edit) panel of the dialog box. 

3. You can also directly edit punch transaction data. For Help directly editing punch transaction data, click here. 

4. Save the transaction by choosing Save Transaction from the Record menu, pressing <Ctrl+S>, or clicking the Save 
Record icon: 

 

5. You will be prompted by a small dialog box: "Current Record Has Been Changed! Save?" Click Yes. 

Changing the Structure of Transactions Files 

What Is It? 

Transactions files are created automatically from information acquired by punch clocks. In certain 
situations, the standard structure of transactions files in your system can be updated. You can 
then change the structure of old transactions files which were entered before the standard 
structure was changed. 

Why Would I Want It? 
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If you do not change the the structure of old transactions files, the system will not be able to read 
them properly, once the standard structure is changed. 

When you open a transactions file, transactions are displayed in the upper panel of the dialog box. 
A ruler along the top of the upper panel indicates character position. An inverted black triangle 
above the ruler indicates the currently selected character. 

To select a character, first click to select a transaction. The selected transaction will be displayed 
in red characters. Click any character in that line to select the character. The inverted black 
triangle will move to that character's position on the ruler. 

In the following example, the character "9" in position 21 has been selected: 

 

You can change the structure of transactions files in any of three ways: 

 adding characters to a transaction 

 deleting characters from a transaction 

 replacing characters in a transaction 

To Add Characters to a Transaction 

1. Click to select a transaction. 

2. Click any character in that line to select the character. 

3. Choose Add Character from the Edit menu. The Add Character dialog box is displayed. 

4. Type the character to be added to the transaction in the Character to Add field. 

5. Choose to add the character before or after the currently selected character. 

6. Choose to add the character only to the currently selected transaction, or to all transactions in the file. 

7. Click Add to add the character and close the Add Character dialog box. 

8. Save the transaction by choosing Save Transaction from the Record menu, pressing <Ctrl+S>, or clicking the Save 
Record icon: 

 

9. You will be prompted by a small dialog box: "Current Record Has Been Changed! Save?" Click Yes. 

To Delete Characters from a Transaction 

1. Click to select a transaction. 

2. Click and drag to select any continuous range of characters in the transaction. 

3. Choose Delete Selected Characters from the Edit menu. The Select Editing Mode dialog box is displayed. 

4. Choose to delete the characters only from the currently selected transaction, or from all transactions in the file. 

5. Click OK to delete the characters and close the Select Editing Mode dialog box, or click Cancel to close the Select 
Editing Mode dialog box without deleting characters. 

6. Save the transaction by choosing Save Transaction from the Record menu, pressing <Ctrl+S>, or clicking the Save 
Record icon: 

 

7. You will be prompted by a small dialog box: "Current Record Has Been Changed! Save?" Click Yes. 

Replacing Characters in a Transaction 
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You can replace a string of characters in a transaction with another string. You can select the 
string to be replaced either according to its position in the transaction, or according to a specific 
string of text. 

 You can replace the characters in positions 23 to 27 with the character string 00972. You can also replace 

every occurrence of the character string 00972, regardless of its position, with the character string 87672. 

To Replace Characters in a Transaction 

1. Click to select a transaction. 

2. Click and drag to select any continuous range of characters in the transaction. 

3. Choose Replace from the Edit menu. The Replace dialog box is displayed. 

4. Choose Use Selection From - To Position to replace characters according to their position in the transaction. Choose 
Use Text Pattern to replace characters according to a specific string of text. 

5. If you choose Use Selection From - To Position, type the first position in the string in the From Position field. Type the 
last position in the string in the To Position field. The default values for these fields are the first and last positions of 
the range you selected in step 2. 

6. If you choose Use Text Pattern, type the string to be replaced in the Text To Replace field. 

7. Enter the text to be substituted for the selected character string in the New Text field. 

8. Select the Prompt Before Replace check box to generate a prompt message before every replacement is made 
(recommended). 

9. Choose to replace the characters only in the currently selected transaction, or in all transactions in the file. 

10. Click Replace to replace the characters. The dialog box will close after all prompts are answered. 

11. Save the transaction by choosing Save Transaction from the Record menu, pressing <Ctrl+S>, or clicking the Save 
Record icon: 

 

12. You will be prompted by a small dialog box: "Current Record Has Been Changed! Save?" Click Yes. 

TimeCosting-PC Setup 

 

The essence of TimeCosting-PC is that an employee works on a process which is part of a job. 
For examples of time-costing, click here. 

TimeCosting-PC can define multiple levels of jobs and processes. TC can assign default pay 
rates to a job, a process, an employee, or a department. TC can combine these and other fields to 
base a rate structure on up to five separate elements. TC can create up to three different rate 
structures, allowing you to separate costing, billing, payroll, and other considerations. 

 For the purposes of this Help file, time-costing levels are sometimes referred to by the following names:  

 Level 1 Level 2 Level 3 Level 4 

 Work order Batch Part Process 

You can use the The TC Configuration File to choose names for any level. All reports, menus, and 
dialog boxes will use the names you choose. 

The following files are defined in TimeCosting-PC Setup: 

The TC Configuration File determines general settings for TC, including the number of active 
levels, the number of rate structures, and how specified fields, either individually or in 
combination, determine the rates to be used. 
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Category Evaluation Parameters determine how pay categories in TimeKeeper-PC are converted 
into values for TC. 

Work Orders determine rates and other settings for the first level of time-costing. This level is 
usually used for jobs. Jobs can also be referred to as work orders, customers, and so on. 

Batches determine rates and other settings for the second level of time-costing. This level can be 
used to define a second level for jobs: batches, districts, and so on. 

Parts determine rates and other settings for the third level of time-costing. This level can be used 
define a third level for jobs: parts, sections, and so on. 

Processes determine rates and other settings for the fourth level of time-costing. This level is 
usually used for processes. 

TC Rates are defined by name and value for use by all TC functions. 

Departmental Rates determine up to three separate default rates for each Department defined in 
TC. 

Combined Rates determine rates to be used by a specified combination of field values. 

Cost Centers can be defined as a group of sub-departments, machines, or work stations used in a 
process. 

Machines can be defined to be used in a process. 

Cells  

Employee Default Job Assignments determine how an Employee's hours are automatically 
assigned to jobs by percentage of total time worked. 

TimeKeeper-PC Setup determines the contract rules and tables which reflect time and attendance 
policies, as well as definitions such as Shared Setup Files which TimeCosting-PC (TC) uses 
extensively. For Help with TimeKeeper-PC Setup, click here. 

Various icons are displayed on the tool bar at the bottom of TC Setup dialog boxes. For Help 
using those icons, click here. 

TC Setup Dialog Box Icons 

The following table lists the most common icons used to set up TimeCosting-PC. Point to an icon 
to display the name of the icon. Not all of the following icons appear on all of the dialog boxes. 

 Click the Help icon for Help editing the Daily Activity File. 

 Click the Memo Record icon to add annotations to system tables. 

 If a table already contains a memo, the Memo Record icon will be displayed in this form. 
Click this icon to display the current memo. 

 Click the Run Table icon to open the dialog box for an element within another dialog box 
without closing the current dialog box. For example, if the Rate Code field is selected in the 
Add/Edit Combined Rates dialog box, click this icon to open the Rates dialog box. 

 A dialog box table can be displayed in either Browse mode (as a table, which cannot be 
edited) or Edit mode (as a form, which can be edited). Click the Edit icon when a table is 
displayed in Browse mode to display the data in Edit mode. 
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 Click the Browse icon when a table is displayed in Edit mode to display the data in Browse 
mode. 

 Click the Top of File icon to go to the table with the lowest number. 

 Click the Previous Record icon to go to the table with the next lowest number. 

 Click the Next Record icon to go to the table with the next highest number. 

 Click the End of File icon to go to the table with the highest number. 

 Click the Save icon  to save your changes to a dialog box. 

 Click the Clear icon to clear all of the displayed fields. In some dialog boxes, default 
settings are displayed in the cleared fields. 

 Click the Delete icon to delete the currently selected record from a dialog box table. 

 Click the Exit icon to close the dialog box. 

TC Configuration File 

The TC Configuration File defines certain parameters that apply to TC as a whole. 

To View or Edit the TC Configuration File 

1. Choose Add/Edit TimeCosting Set-Up Files from the TimeKeeper-PC Set-Up menu. 

2. Choose Add/Edit TC Configuration File. 

The TC System Configuration dialog box is composed of five tabs: 

The Definition of Levels tab determines the number of active levels, their names, and other 
parameters. 

The Level Relations tab uses a graphic display to determine how levels are linked to each other. 

The TC Options tab determines general TC parameters, including the applicability of certain TK 
tables. 

The Combined Rates tab determines which fields are combined to define a rate within each rate 
structure. 

The Rate Orders tab determines which individual fields take precedence in defining rates within 
each rate structure. 

Definition of Levels Tab (TC Configuration File) 

The Definition of Levels tab determines the number of active levels, their names, and other 
parameters. 

The Definition of Levels tab contains the following fields: 

Version 4 TimeCosting Configuration  

Level 1  



  93 

Level 2  

Level 3  

Level 4  

Use Department  

Level Name (for each level)  

Index Type (for each level)  

Length (for each level)  

Auto File Use (for each level)  

Auto File Expression (for each level)  

You can click the Clear icon  to return all fields to their default settings. 

 When you click the Clear icon, all values in all five tabs (Definition of Levels, Level Relations, TC Options, 

Combined Rates, and Rate Orders) revert to their default values, clearing all existing definitions. Once you 

click the Clear icon, all information in all three tabs will be lost. 

When the desired values are displayed in all fields, click the Save icon  to save your changes 
to the Definition of Levels tab. 

Version 4 TimeCosting Configuration (Definition 

of Levels Tab) 

Users of TimeKeeper-PC Version 4 can convert their old data in such a way as to support Version 
4 six-digit job numbers. Version 4 data can be converted in this manner only under the following 
conditions: 

 The user was using Level 2 in Version 4 (Batches). 

 The user was using six-digit job numbers. 

 The Version 4.0 data has not yet been converted to Version 5 for Windows. 

 You must select the Version 4 TimeCosting Configuration check box before you convert data to Version 5 

for Windows. 

If you select Version 4 TimeCosting Configuration, Level 3 cannot be used. You must use Levels 
1 and 2, but you can change their names. You can choose to use Level 4. 

To use the configuration described above, select the Version 4 TimeCosting Configuration check 
box before you convert data to Version 5 for Windows. 

Determining Which Levels to Use (Definition of 

Levels Tab) 

Example 

You can use up to four levels. It is generally recommended to use Levels 1-3 for job-related 
activities: jobs, work orders, batches, customers, districts, and so on. It is generally recommended 
to use Level 4 for processes. 
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It is possible to have a configuration which uses only jobs. In that case, it is recommended to use 
Level 1 for jobs. 

Most simple configurations require the use of jobs and processes. In that case, it is recommended 
to use Level 1 for jobs and Level 4 for processes. 

Levels 2 and 3 allow increasing sophistication and differentiation of jobs. 

To use a level, select the check box next to that level. 

Example -- Determining Which Levels to Use     

 

A technical writing firm can define each manual it produces as a job. The simplest configuration of TimeKeeper-

PC would allow the firm to track the number of hours spent producing each manual. A more typical, two-level 

configuration would allow the firm to track the number of hours spent on each step (process) needed to produce 

a manual (job): researching, writing, testing, and proofreading. 

A large automotive plant can use Level 1 for each model of car or truck. Level 2 can be used for large parts of the 

car or truck, such as the transmission. Level 3 can be used for pieces of each large part, such as the differential. 

Level 4 can be used for processes used for each piece, such as welding. Each piece defined in Level 3 can 

require hundreds of individual Level 4 processes, such as stamping, welding, painting, and so on.  

Use Department (Definition of Levels Tab) 

Example 

You can make processes dependent on departments. In that case, the same process can have 
different rates when performed by different departments. 

You can also assign different names to the same process when performed by different 
departments. 

One advantage of making processes department-dependent is that employee hours can be 
assigned to a generic group of similar processes. This allows the use of a single index code for 
those similar processes. 

If one process is department-dependent, then all processes are department-dependent. If the Use 
Department check box is selected, TimeKeeper-PC automatically adds the Department number to 
the process's index code. If the Use Department check box is deselected, the Process (Level 4) 
dialog box does not display a Department field. For Help defining Level 4 elements, click here. For 
Help defining Departments, click here.  

To make all processes dependent on departments, select the Use Department check box. 

Example -- Use Department      

In a large automotive plant, you can cost welding in the Chassis Department at a higher rate than in the Camper 

Module Department. Even though a single index code is used for welding in all departments. TimeKeeper-PC will 

cost welding at different rates according to the department in which the welding was done. 

Level Name (Definition of Levels ) 

You can assign any name to an active level. For example, jobs (Level 1) can also be referred to 
as work orders, customers, and so on. You cannot assign a name to a level which is not active 
(selected). 

To asssign a name to an active level, select the name currently displayed in the Level Name field 
and type the new name for that level. 
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Level Index Type (Definition of Levels ) 

Example 

The index code for a level can be numeric or alphanumeric. The index code type is selected 
individually for each level. You cannot select an index code for a level which is not active 
(selected). 

Choose either Numeric or Character (alphanumeric) format from the drop-down list. 

Example -- Level Index Type      

In a chain of restaurants, Level 1 can be defined as states, identified by two-letter (alphanumeric) index codes. 

Level 2 can be defined as individual restaurants within each state, identified by five-digit (numeric) index codes. 

Length of Level Index Code (Definition of Levels ) 

Type the number of characters in each level's index code. An index code can be up to twenty 
characters long. You cannot determine the length of the index code for a level which is not active 
(selected). 

Auto Files (Definition of Levels ) 

Example 

You can define auto files to group a level's elements according to automatic keys embedded in a 
higher level's index codes. 

You can define up to two auto files. Each auto file can be assigned to only one active level. If you 
assign the same auto file to more than one level, TimeKeeper-PC will display an error message 
when you try to save the system configuration. You cannot assign an auto file to a level which is 
not active (selected). 

For each active level, choose one of the following from the drop-down list: Not In Use, AutoLevel 
File 1, or AutoLevel File 2. 

If you choose either AutoLevel File 1 or AutoLevel File 2 for a level, you must define the 
expression used to determine the automatic key for that level. Type the conditional expression 
used to determine the automatic key in the Auto File Expression field. You can also click the 
Define button next to the Auto File Expression field to build the expression using the Expression 
Builder dialog box. 

 

For Help using auto files for Level 3 (Parts), click here.  

Example -- Auto File      

In a chain of restaurants, Level 2 can be defined as individual restaurants, identified by six-character index 

codes. Two-letter state codes can be embedded within those six-character index codes. If Level 1 is defined as 

states, then restaurants can be assigned automatically to states on the basis on the state codes embedded in 

their index codes. 

Level Relations Tab (TC Configuration File) 
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Example 

The Level Relations tab uses a graphic display to determine how levels are linked to each other. 

You can link an active level to the active level above. In that case, the same element can have 
different rates when assigned to different elements on the level above. You cannot link a level 
which is not active (selected). 

You can also assign different names to the same element when assigned to different elements on 
the level above. 

You cannot skip active levels when linking one level to another. For example, you can link Level 3 
to Level 2 and Level 2 to Level 1, but you cannot link Level 3 directly to Level 1, unless Level 2 is 
inactive (deselected). 

You can have two pairs of linked levels. For example, you can link Level 4 to Level 3 and Level 2 
to Level 1, without linking Level 3 to Level 2. 

Linking levels is similar to making processes department-dependent. For Help making processes 
department-dependent, click here. 

One advantage of linking levels is that employee hours can be assigned to a generic group of 
similar elements. This allows the use of a single index code for elements which are each costed at 
a different rate. 

If two levels are linked, then all of the elements on the lower level are linked to elements on the 
higher level. 

 

Using the Level Relations tab  

Example -- Level Relations Tab      

In a chain of restaurants, Level 1 can be defined as states, and Level 2 can be defined as individual restaurants 

within each state. Since each restaurant must be located in a particular state, Level 2 must be linked to Level 1. 

In a technical writing firm, each manual can be defined as a job (Level 1), and the steps needed to produce a 

manual (researching, writing, testing, and proofreading) can be defined as processes (Level 4). If the steps are 

costed at the same rate for all manuals, then Level 4 should not be linked to Level 1. If Level 4 is linked to Level 

1, then the steps must be costed at specific rates for each manual. 

Another Example... 

Another Example -- Level Relations Tab      

In a chain of restaurants, Level 1 can be defined as states, Level 2 as individual restaurants within each state, 

Level 3 as different meals (breakfast, lunch, or supper) and Level 4 as the steps needed to produce a meal (salad 

prep, frying, beating eggs, and so on). If meals are costed identically throughout the chain, then Level 3 should 

not be linked to Level 2. If the steps needed to produce a meal are costed differently for different meals, then 

Level 4 must be linked to Level 3. Even if meals are costed differently for different restaurants, you cannot link 

Level 3 to Level 1 without linking both of them to Level 2. In other words, you cannot cost breakfasts according 

to state without assigning restaurants to states and breakfasts to restaurants. 

Using the Level Relations Tab 

Example 

The Level Relations tab uses a graphic display to determine how active levels are linked to each 
other. The tab displays current links between active levels, and can be used to change links. 
Levels which are not active (selected) are not displayed by the Level Relations tab. 

Solid lines are displayed above and below the currently selected level. Click any level to select it. 
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To unlink linked levels, select the lower of the two levels and click the left arrow: 

 

To link unlinked levels, select the lower of the two levels and click the right arrow: 

 

If you select the Use Department check box to make processes (Level 4) dependent on 
departments, then Department is displayed as a level in the Level Relations tab, linked to Level 4. 

In this case, Level 4 and Department work as a single unit in the Level Relations tab, and  you 
cannot unlink Level 4 from Departments. If you select Level 4 and click the left arrow to unlink, 
Department is unlinked from Level 3. 

You can click the Clear icon  to remove all levels from the display. 

 When you click the Clear icon, all values in all five tabs (Definition of Levels, Level Relations, TC Options, 

Combined Rates, and Rate Orders) revert to their default values, clearing all existing definitions. Once you 

click the Clear icon, all information in all three tabs will be lost. 

When the desired links are displayed between levels, click the Save icon  to save your 
changes to the Level Relations tab. 

Example -- Using the Level Relations Tab     

 

 

In this example, 

Level 4 is linked to 

Level 3 and Level 2 

is linked to Level 

1: 

 

Another 
Example... 

 

Another Example -- Using the Level Relations Tab      

If you select the 

Use Department 

check box to make 

processes (Level 

4) dependent on 

departments, then 

Department is 

displayed as a 

level in the Level 

Relations tab, 

linked to Level 4: 
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TC Options Tab (TC Configuration File) 

The TC Options tab defines general TC parameters, including the applicability of certain TK 
tables. 

The TC Options tab contains the following fields: 

Manual Categories 

Use Sort Code 

Auto Calculate Type  

Auto Build By Clock Data  

TK - Entry (In-Punch) is used 

TK - Exit (Out-Punch) is used  

TC - Job Start  

TC - Job End  

Daily Variance Rules (Table I) 

Daily Rounding Rules (Table R) 

Daily Break Rules (Table N)You can click the Clear icon  to return all fields to their default 
settings. 

 When you click the Clear icon, all values in all five tabs (Definition of Levels, Level Relations, TC Options, 

Combined Rates, and Rate Orders) revert to their default values, clearing all existing definitions. Once you 

click the Clear icon, all information in all three tabs will be lost. 

When the desired values are displayed in all fields, click the Save icon  to save your changes 
to the TC Options tab. 

Manual Categories (TC Options Tab) 

Example 

You can add user defined categories to the Daily Activity File in both TK and TC. These 
categories can only be edited manually, i.e. they are not overridden or recalculated by the 
Calculate command in the Daily Browser. 

TC can use up to the number of manual categories defined in TK. In order to leave manual 
categories for TK's use, you need to define more TK manual categories than TC manual 
categories. If you define more TC manual categories than TK manual categories, TC will use 
some of TK's automatic categories for its own calculations. 

Type the number of manual categories in this field. 

Example -- Manual Categories in TC      

If you set up TK with ten manual categories, then TC can be set up with between zero and ten manual categories. 

In that case, if you set up TC with five manual categories, then TK will be able use five manual categories. If you 

set up TC with ten manual categories, then TK will not have any manual categories for its own use. If you set up 

TC with fifteen manual categories, TC will use five of TK's automatic categories for its own calculations. 
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Use Sort Code (TC Options Tab) 

TC can combine up to five separate fields to determine each rate structure, and Sort Codes can 
be one of those fields. 

In addition, TC’s standard reports are normally sorted by either the Plant, Site, or Department (or 
Budget Code/Alternate Department) fields. You can choose to base user-specific reports on an 
alternate sorting order. To facilitate this choice, TC maintains an additional field in each Record 
called Sort Code. Since you can define up to three separate Sort Codes in an Employee Profile, 
you need to choose which Sort Code is used by TC. 

Choose the desired Sort Code from the drop-down list. 

Auto Calculate Type (TC Options Tab) 

Example 

Time and attendance accounting typically tracks cost as a function of time: 

Cost = Duration x Rate, where Duration is the time spent on a process and Rate is the cost per 
hour. 

TimeKeeper-PC can track cost as a function of Standard Unit Manufacturing Time (SUMT), which 
is the standard time needed to produce one unit in a job. This allows you to check production 
efficiency by comparing standard manufacturing time with the actual time spent on a job. In that 
case: 

Cost = Quantity x Rate, where Cost is the standard manufacturing time, Quantity is the number of 
units produced, and Rate is the SUMT. 

You can then compare Cost with Duration. If Cost is the greater value, then the Employee is more 
efficient than expected. If Duration is the greater value, then the Employee is less efficient than 
expected. 

You can also use this method to calculate cost by piecework by defining Rate as the sum paid for 
each unit produced. 

Click to choose either According to Duration or According to Quantity from the drop-down list. 

Example -- Auto Calculate Type      

In a chain of restaurants, the Standard Unit Manufacturing Time for a garden salad is four minutes. To calculate 

standard manufacturing time, define the rate for that process as 4.0. An Employee produces ten salads in half an 

hour. The Cost According to Quantity is 10x4=40. The Duration is 30. Since Cost is the greater value, the 

Employee is more efficient than expected. 

Auto Build By Clock Data (TC Options Tab) 

[To be completed] 

Using TK and TC Punches 

Example 

TimeKeeper-PC tracks both In and Out punches, but TimeCosting-PC needs only one value to 
calculate the start and end of a job. You can set TC to calculate job times either by starting a job 
when an Employee punches in to that job, or by ending the job (and starting the next one) when 
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the Employee punches out from that job. Although it is not recommended, you can also set TC to 
require a punch in and out of each job. 

The following four fields determine how punches are used by TC to start and end jobs: 

 TK - Entry (In-Punch) Is Used 

 TK - Exit (Out-Punch) Is Used 

 TC - Job Start 

 TC - Job End 

Following are the three possible combinations of choices for these fields. If you choose an 
incorrect combination, TC will display an error message. 

 TK punches are designated by the clock as In or Out punches, but TC punches are not designated by the 

clock as Start or End punches. Punches are interpreted as Start or End by TC. 

To Start Jobs by Punching In 

1. In the Entry (In-Punch) field, click to choose Only For TK. 

2. In the Exit (Out-Punch) field, click to choose Also As End Of Job. 

3. In the Job Start field, click to choose Start of Job Ends Previous Job. 

4. In the Job End field, click to choose Not In Use. 

To End Jobs by Punching Out 

1. In the Entry (In-Punch) field, click to choose Also As A Beginning Of Job. 

2. In the Exit (Out-Punch) field, click to choose Only For TK. 

3. In the Job Start field, click to choose Not In Use. 

4. In the Job End field, click to choose End of Job Starts New Job. 

To Start and End Jobs by Punching In and Out 

1. In the Entry (In-Punch) field, click to choose Only For TK. 

2. In the Exit (Out-Punch) field, click to choose Only For TK. 

3. In the Job Start field, click to choose Reported. 

4. In the Job End field, click to choose Reported. 

Example -- Using TK and TC Punches      

Time Event 

8:00 Employee punches in to work (TK In Punch). 

13:50 Employee punches out of Process # 101. 

17:00 Employee punches out of Process #102. 

19:00 Employee punches out of Process #103. 

19:10 Employee punches out of work (TK Out Punch). 

In this example, the Employee ends jobs by punching out. TC considers the In Punch as Also As A Beginning Of 

Job (in this case, Process # 101). Each TC punch ends the current job and immediately starts the next job. TC 

considers the Out Punch as Only For TK, and does not assign hours after the last End punch (from Process # 

103) at 19:00. 

Daily TK Rules in TC (TC Options Tab) 
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TimeKeeper-PC tracks all Employee hours and pays for them according to TK Setup. 
TimeCosting-PC does not have to allocate all paid TK hours to jobs. On the other hand, TC can 
allocate hours which are not paid for by TK. 

When you apply a Daily TK Rules table in TC, TC uses that same table during its calculations that 
allocate hours to jobs. TC uses the table number used by TK for the current Contract, unless 
otherwise defined by Offset. 

 If you are using TC for Payroll purposes, you will usually need to apply all TK Daily Rules tables. 

Choose how to apply three TK Daily Rules tables: 

 Daily Variance Rules (Table I) 

 Daily Rounding Rules (Table R) 

 Daily Break Rules (Table N) 

For each of these tables, choose one of three options: 

 No: TC does not use the TK table to allocate hours. 

 Yes: TC uses the TK table to allocate hours. 

 Offset: TC uses the TK table to allocate hours, but it uses a higher number table than the one used by TK for the current 

Contract. The offset value is always positive. 

More About Offset 

Example 

To be able to increase table numbers for TC, it is recommended that you set up the tables in TK 
with low numbers. 

You can choose Offset as an option for any or all of the three Daily TK Rules tables. 

When you choose Offset, the Offset field is displayed next to the Daily TK Rules Tables field. 
Type the difference between the number of the table used by TK for the Contract and the table 
used by TC for the Contract. 

Example -- Offset Daily Rules Table      

TC is set up to offset the Daily Rounding Rules Table (Table R) by 1000. TK is set up to apply Table R 200 to 

Contract 200. Table R 200 rounds punched times by 15 minutes, and Table R 1200 rounds punched times by 60 

minutes. An Employee assigned to Contract 200 punches in at 7:40 and punches out at 12:00. TK pays the 

Employee for 4 hours and 15 minutes (rounding to 7:45). TC allocates only the hours between 8:00 and 12:00 to 

jobs (rounding to 8:00). 

Daily Variance Rules (Table I) (Daily TK Rules in 

TC) 

Example 

TK Table I (Daily Variance Rules) specifies how daily variances are handled (i.e., when to pay or 
not pay early entries, late entries, early exits, late exits, and overtime hours). When you apply 
Table I, TC allocates only the hours paid by Table I. When you do not apply Table I, TC allocates 
actual hours. 

Example -- Daily Variance Rules in TC      
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In a technical writing firm, an Employee with a standard entry time of 8:00 punches in at 7:40 and begins work in 

Proofreading. At 8:00, the Employee punches into the Web Design. Since the TK Table I for that Employee's 

Contract pays early entries only if they are early by at least 30 minutes, the Employee is paid only for hours 

beginning at 8:00. If you set Daily Variance Rules to No in TC Setup, then TC will allocate the unpaid hours to 

Proofreading. 

Daily Rounding Rules (Table R) (Daily TK Rules in 

TC) 

TK Table R (Daily Rounding Rules) bases attendance calculations on rounded times, and not on 
the actual punch times. When you apply Table R, TC allocates only the rounded hours. When you 
do not apply Table R, TC allocates actual hours. 

Daily Break Rules (Table N) (Daily TK Rules in TC) 

Example 

In some companies, employees are allowed or required to punch out for breaks (usually short and 
paid) and/or meals (usually not paid) during the day. These parameters are defined in Table N 
(Daily Break Rules). 

Table N can automatically apply these parameters to an Employee's punched hours. If an 
Employee does not punch out for a required break, Table N can automatically adjust the 
Employee's attended hours to include the missing break, whether or not it is paid for. 

When you apply Table N, TC allocates hours after they are adjusted by Table N. When you do not 
apply Table N, TC allocates actual hours. 

Example -- Daily Break Rules in TC      

An Employee's Contract requires a paid break between 10:00 and 10:30. If the Employee does not punch out 

during that time, Table N will adjust the Employee's hours to add 30 minutes of paid time. If you set Daily Break 

Rules to No in TC Setup, then TC will not allocate those 30 minutes of paid time to any job. 

Combined Rates Tab (TC Configuration File) 

Example  

The Combined Rates tab determines which fields are combined to define a rate within each rate 
structure. 

A combined rate applies only when a specified combination of field values occurs. The Combined 
Rates tab determines only which fields are combined for each rate structure. The required values 
in each field and the resulting rate are determined by the Add/Edit Combined Rates option. 

Combined rates are the first default for a rate structure. If the required field values do not occur, 
TC will apply rates according to the Rate Orders tab. 

The Combined Rates tab displays three panels, corresponding to the three rate structures. Three 
buttons are displayed below each panel: Up, Down, and Select. These buttons are enabled only 
for the number of rate structures enabled by the Number of Rates in Use field. For example, if you 
set the Number of Rates in Use field at Two Rates, the buttons below the third panel in the 
Combined Rates tab will be disabled. 

You can click the Clear icon  to clear all fields from the three panels. 
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 When you click the Clear icon, all values in all five tabs (Definition of Levels, Level Relations, TC Options, 

Combined Rates, and Rate Orders) revert to their default values, clearing all existing definitions. Once you 

click the Clear icon, all information in all three tabs will be lost. 

Each panel in the Combined Rates tab can display up to five fields. When you click Select below a 
Combined Rates tab panel, the Select Fields dialog box opens, displaying a list of seven to ten 
fields: Employee, Plant, Site, Department, Profession, Sort Code, and all active levels. A check 
box is displayed beside each field. 

The Sort Code displayed is the one selected by the Use Sort Code field. 

To Add and Delete Fields in Combined Rates Tab Panels 

1. Click Select below the panel you want to edit. The Select Fields dialog box is displayed. 

2. Select a check box to add a field to the panel. Clear the check box to remove a field from the panel. 

3. When the desired fields are selected, click OK to close the Select Fields dialog box. The selected fields are displayed 
in the panel. 

The order of the fields displayed in each panel is not hierarchical (as in the Rate Orders tab), 
since all fields displayed must have their required values for the combined rate to apply. The order 
of the fields does determine the order in which they are displayed in the Add/Edit Combined Rates 
option (Data Entry For RATECMB# Files). Set this order for maximum ease of data entry. 

To Set The Order of Fields in Combined Rates Tab Panels 

1. Click to select the field you want to move up or down in the panel. 

2. Click Up to move the field one place up in the field order. Click Down to move the field one place down in the field 
order. 

When the desired fields are displayed in the desired order, click the Save icon  to save your 
changes to the Combined Rates tab. 

Number of Rates (Combined Rates Tab) 

TC can create up to three different rate structures, allowing you to separate costing, billing, 
payroll, and other considerations. Use this field to choose the number of rate structures, or to 
disable TC altogether. 

Choose one of four options from the drop-down list: 

 Not In Use: TC is disabled. 

 One Rate: TC calculates departmental cost according to one rate structure. 

 Two Rates: TC calculates departmental cost according to two rate structures. 

 Three Rates: TC calculates departmental cost according to three rate structures. 

Example -- Combined Rates      

In a large automotive plant, two rate structures are defined for TC: Billing and Costing. In the Combined Rates 

tab, Billing is determined by the Employee, Department, and Profession fields. Costing is determined by the 

Employee and Profession fields only. The Add/Edit Combined Rates option defines a Billing combined rate for 

Employee 32 in Job 101 and Profession 3, but not in any other job. The same option defines a Costing rate for 

Employee 32 in Profession 3. If Employee 32 works in Profession 3, but not in Job 101, the Costing combined 

rate will apply, but the Billing combined rate will not. 

Rate Orders Tab (TC Configuration File) 
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Example  

The Rate Orders tab determines the hierarchical order of individual fields to set rates for time-
costing. 

The fields determined in the Combined Rates tab are the first default for a rate structure. If the 
required field values do not occur, TC will apply rates according to the Rate Orders tab. 

The Rate Orders tab displays three panels, corresponding to the three rate structures. Two 
buttons are displayed below each panel: Up and Down. These buttons are enabled only for the 
number of rate structures enabled by the Number of Rates in Use field. For example, if you set 
the Number of Rates in Use field at Two Rates, the buttons below the third panel in the Combined 
Rates tab will be disabled. 

You can click the Clear icon  to disable all three panels. This automatically sets the Number 
of Rates field to Not In Use, and disables TC. 

 When you click the Clear icon, all values in all five tabs (Definition of Levels, Level Relations, TC Options, 

Combined Rates, and Rate Orders) revert to their default values, clearing all existing definitions. Once you 

click the Clear icon, all information in all three tabs will be lost. 

Each panel in the Rate Orders tab displays four to seven fields: Employee, Department, 
Profession, and all active levels. 

If the rate for a field in a Rate Orders tab panel is not defined in TC Setup, TC will determine rates 
according to the next field in that panel. At least one field in an enabled Rate Orders tab panel 
must be defined. 

Use the Up and Down buttons below each panel to set the hierarchical order of the fields in that 
panel. 

To Set The Order of Fields in Rate Orders Tab Panels 

1. Click to select the field you want to move up or down in the panel. 

2. Click Up to move the field one place up in the field order. Click Down to move the field one place down in the field 
order. 

When the fields are displayed in the desired order, click the Save icon  to save your changes 
to the Rate Orders tab. 

Example -- Rate Orders      

Two rate structures are defined for TC: Billing and Costing. In the Rate Orders tab, the rate order for Billing is 

Employee, Level 4, Profession, and the rate order for Costing is Level 4, Employee, Profession. If Employee 32 

works in Process 150 (Level 4) and Profession 3, the Billing rate will be set according to the rate for the 

Employee, and the Costing rate will be set according to the rate for the process. If the Employee has no defined 

rate, both Billing and Costing will be set according to the rate for the process. If neither the Employee nor the 

process has a defined rate, both Billing and Costing will be set according to the rate for the Profession. 

Category Evaluation Parameters 

Category Evaluation Parameters determine how pay categories in TimeKeeper-PC are converted 
into pay categories for TC. 

The Category Evaluation Parameters dialog box displays all of the pay categories defined in Table 
A of TK Setup. 

To View or Edit Category Evaluation Parameters 

1. Choose Add/Edit TimeCosting Set-Up Files from the TimeKeeper-PC Set-Up menu. 
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2. Choose Add/Edit Category Evaluation Parameters. 

The Category Evaluation Parameters dialog box contains the following fields: 

Contract No. 

Category Name 

Category Usage 

Source Category 

Multiply By 

Add 

When the desired values are displayed in all fields, click the Save icon  to save your changes 
to the Category Evaluation Parameters dialog box. 

Category Evaluation Parameters -- Contract No. 

(Category Evaluation Parameters)  

Choose the Contract for which you are determining Category Evaluation Parameters. Choose the 
Contract by one of the following methods: 

 Type the Contract Number in the Contract No. field. 

 Click the drop-down arrow next to the Contract No. field to display a list of Contracts whose Category Evaluation Parameters 

are already defined. Click to choose one of the Contracts on that list. 

 Click Contract List to display a list of all Contracts defined in TK Setup. 

When you choose a Contract Number by any of the above methods, the Contract Name is 
displayed in the Contract Name field. 

Contract Number 0 is the system-wide default. You can define any number of Contracts. 
Contracts not defined in this dialog box revert to the Contract 0 default. 

Category Evaluation Parameters -- Category Name 

(Category Evaluation Parameters)  

This field cannot be edited. The Category Evaluation Parameters dialog box displays all of the pay 
categories defined in Table A (General Data Definitions) of TK Setup. Each pay category is 
displayed on a separate line in the Category Evaluation Parameters dialog box. The Category 
Name field displays the name of the TC pay category whose Category Evaluation Parameters are 
defined on that line. 

Category Evaluation Parameters -- Category 

Usage (Category Evaluation Parameters)  

The Category Usage field determines the method by which TK pay categories are converted for 
TC. 

For each pay category, choose one of five options: 

 Not In Use: TC does not allocate hours for that pay category. 

 Self Value: The TC pay category Rate is based on the TK pay category of the same name, whose value can be multiplied 

and/or added to. 
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 Duplicate By Source: The TC pay category Rate pays hours which are not paid in TK. 

 Duplicate Non Zero: The TC pay category Rate pays hours based on TK hours. 

 Proportional: TC allocates the total cost of a day among Departments, without charging a higher rate to Departments 

assigned Overtime hours. 

TC Category Usage 

There are situations in TK where employee hours are allocated simultaneously to more than one 
pay category. For example, employee shift work hours can be allocated to both Regular and Shift 
Differential pay categories (e.g., 100% and 12.5% respectively), instead of being allocated to one 
Shift Hours pay category (e.g., 112.5%). 

8 hours worked in a shift would be reflected as 8 hours in the Regular pay category and also 8 
hours in the Shift Differential pay category. Obviously, the employee has not worked 16 hours, as 
the hours in the two pay categories are not sequential but concurrent. The second pay category 
(Shift Differential) can be viewed as a “shadow” pay category which mimics the source (Regular) 
pay category. 

In such situations, TC cannot automatically recognize that the two pay categories reflect 
concurrent hours. You need to explicitly instruct TC to to allocate both pay categories identically 
among jobs. 

TC is instructed to handle a pay category as a “shadow” pay category by setting its Category 
Usage to Duplicate Non-Zero and its Source Category to the source pay category in TK. Note that 
TC will not allocate hours to the TC “shadow” pay category unless its “shadow” counterpart in TK 
is non-zero. 

TC can also be set up to handle “shadow” pay categories which are not necessarily paid in TK 
(i.e., which are relevant only in TC). In such cases, set the Category Usage to Duplicate By 
Source and the Source Category to the source pay category in TK. Note that TC will allocate 
hours to the TC “shadow” pay category regardless of the value in its “shadow” counterpart in TK. 

TC Pay Categories Duplicated By Source 

(Category Usage) 

Example  

TC can be set up to pay for hours which are not paid in TK. In that case, TK does not assign any 
hours to the shadow pay category. 

Since all TC pay categories are based on TK pay categories, the shadow pay category must be 
created in Table A of TK Setup, even though it will not be assigned any hours. 

The TC shadow pay category is based on the Regular or Overtime pay category worked, and not 
on the equivalent (unassigned) TK shadow pay category. TC pays a direct monetary rate for its 
shadow pay category. 

The TC shadow pay category multiplies the TK Regular or Overtime pay category by 0, and adds 
the shift premium value. 

Unlike the Duplicate Non Zero method, Duplicate By Source can duplicate any field, whether or 
not its counterpart in TK has a time value. 

Example -- TC Pay Categories Duplicated By 

Source      
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An Employee's Contract gives a premium of $1.00 an hour for the afternoon shift of 16:00 to 24:00, regardless of 

whether the Employee is working overtime. The TC Afternoon Premium pay category is based on the Employee's 

Regular hours, and the TC Afternoon Premium Overtime pay category is based on the Employee's Overtime 

hours. Both TC shift premium pay categories pay $1.00 an hour by multiplying the TK source category by 0 and 

adding 1. 

TK does not pay the shift premium, so the equivalent TK shadow pay categories (TK Afternoon Premium and TK 

Afternoon Premium Overtime) are not assigned any hours. 

If the Employee works Regular hours from 17:00 to 21:00, TC will pay for four hours in the TC Regular pay 

category and four hours ($4.00) in the Afternoon Premium pay category. 

TC Non-Zero Duplicated Pay Categories (Category 

Usage) 

Example  

TK can be set up to assign the hours worked in the Regular or Overtime pay category to a 
shadow pay category. In that case, TK pays the Employee additional pay for those hours. This pay 
category must be converted for TC by the Duplicate Non Zero method, in order for TC to pay a 
shift premium. 

If the shadow pay-category is paid in TK but not in TC, the equivalent TC shadow pay category is 
defined as Not In Use. 

Unlike the Duplicate By Source method, Duplicate Non Zero will not allocate hours to a TC 
shadow pay category unless its counterpart in TK is non-zero. 

Example -- TC Non-Zero Duplicated Pay 

Categories      

An Employee's Contract gives a premium of 20% for the afternoon shift of 16:00 to 24:00, regardless of whether 

the Employee is working overtime. TK defines an Afternoon Premium pay category which mimics the Employee's 

Regular hours, and an Afternoon Premium Overtime pay category which mimics the Employee's Overtime hours. 

Both TK shift premium pay categories pay 20% of the equivalent Regular or Overtime pay categories. 

The equivalent TC shift premium pay categories are based on the TK shift premium pay categories. 

Proportional TimeCosting (Category Usage) 

Example  

TK can pay higher rates for Overtime pay categories. If the equivalent TC pay categories are 
based on the Self Value method, then the jobs in which the Employee worked overtime will bear 
the brunt of the extra overtime costs. To divide the cost of overtime proportionally among all the 
jobs worked in on that day, use the Proportional method. 

As in the Self Value method, the TK source category is the same as the TC target category. 
However, in the Proportional method, the Net Duration for the pay category is the total length of 
the work day. Since the total work day includes all jobs worked in on that day, the overtime cost 
included in that pay category is distributed proportionally among all the jobs. 

Example -- Proportional TimeCosting      

An Employee's Contract defines the first two hours after eight hours of daily work as OT1 at 150% pay, and all 

overtime hours after that as OT2 at 200% pay. The Employee works the following schedule in three jobs: 



  108 

Job Start Time End Time Net 

Duration 

Regular OT1 OT2 

100 8:00 14:00 6 6   

200 14:00 17:00 3 2 1  

300 17:00 19:00 2  1 1 

100 19:00 20:00 1   1 

If the equivalent TC pay categories are based on the Self Value method, the hour spent in Job 100 at the end of 

the day will be charged for as much as two hours spent in that job in the morning. To avoid that, the TC OT1 

category and TC OT2 category are defined by the Proportional method. The cost of the four hours worked in 

Overtime are allocated among the jobs according to the total hours worked that day: 7/12 of the cost to Job 100, 

3/12 to Job 200, and 2/12 to Job 300. 

Category Evaluation Parameters -- Source 

Category (Category Evaluation Parameters)  

The Source Category field displays the name of the TK pay category used to define the Category 
Evaluation Parameters for the TC pay category. 

When the Category Usage method is Not In Use, this field is blank. 

When the Category Usage method is Self Value or Proportional, this field displays the same name 
as the Category Name field, and cannot be edited. 

When the Category Usage method is Duplicate By Source or Duplicate Non Zero, click this field to 
display a drop-down arrow. Click the drop-down arrow to display a list of pay categories defined in 
Table A of TK Setup. Click to choose the desired pay category. 

This field displays the percentage by which the base rate (i.e., Rate for Regular hours) is 
multiplied to produce the TC pay category Rate. It is possible to both multiply and add to a base 
rate. 

This field displays the value added to the base rate (i.e., Rate for Regular hours) to produce the 
TC pay category Rate. It is possible to both multiply and add to a base rate. 

Adding and Editing Level 1 Rates 

The Work Order (Level 1) dialog box determines rates and other settings for the first level of time-
costing. This level is usually used for jobs. Jobs can also be referred to by other names, such as 
work orders, customers, and so on. 

To View or Edit Level 1 Rates 

1. Choose Add/Edit TimeCosting Set-Up Files from the TimeKeeper-PC Set-Up menu. 

2. Choose Add/Edit Work Order. 

The top panel of the Work Order (Level 1) dialog box contains the following fields: 

Number 

Name 

The main area of the Work Order (Level 1) dialog box is composed of two tabs: 

For each work order, the General tab determines active dates and rates for up to three different 
rate structures. Note that for every TC Record, at least one of the following elements must have a 
default rate code: Employee, Department, Profession, or one of the active levels. 
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For each work order, the Planned Vs. Actual tab compares standard manufacturing time with the 
actual time spent on a job. 

When the desired values are displayed in all fields, click the Save icon  to save your changes 
to Level 1 rates. 

Level 1 Number (Adding and Editing Level 1 

Rates) 

Type the number of a defined work order, or select a defined work order from a drop-down list by 
clicking the drop-down arrow to the right of the Number field. 

You can also define a new work order by typing a number which is not currently in use. 

When you select a defined work order's number, that work order's name is displayed in the Name 
field. When you define a new work order, type a name for the new work order in the Name field. 

Level 1 Name (Adding and Editing Level 1 Rates) 

When you select a defined work order's number, that work order's name is displayed in the Name 
field. You can edit the work order's name. 

When you define a new work order, type a name for the new work order in the Name field. 

Level 1 General Tab (Adding and Editing Level 1 

Rates) 

For each work order, the General tab determines active dates and rates for up to three different 
rate structures. Note that for every TC Record, at least one of the following elements must have a 
default rate code: Employee, Department, Profession, or one of the active levels. 

The General tab contains the following fields: 

Order's Entry Date  

Type of Order 

Scheduled Start Date  

Scheduled End Date 

Actual End Date 

On Hold From 

On Hold Till 

Rate Code 

Order's Entry Date (Level 1 General Tab) 

Enter the date that the work order (Level 1) was entered into the TimeCosting-PC system. The 
system cannot obtain or edit data for a work order before its entry date. 

 Enter August 15th, 1996 as "08151996" for a U.S. date, or 15081996 for an International date. The field will 

automatically add the slashes to display "08/15/1996" or "15/08/1996". 
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For Help using date formats, click here. 

Type of Order 

You can assign work orders (Level 1) and batches (Level 2) to a Type of Order to track certain 
elements of time-costing. This is a customer-designed grouping, identified by a code of up to 
three characters. 

To assign a work order or batch to a new or existing type of order, type that type's code into the 
field. 

Scheduled Start Date 

Enter the date that work is scheduled to start on the work order (Level 1) or batch (Level 2). The 
system can obtain or edit data for a work order or batch before its scheduled start date, as long as 
it is after its entry date. 

 Enter August 15th, 1996 as "08151996" for a U.S. date, or 15081996 for an International date. The field will 

automatically add the slashes to display "08/15/1996" or "15/08/1996". 

For Help using date formats, click here. 

Scheduled End Date 

Enter the date that work is scheduled to end on the work order (Level 1) or batch (Level 2). The 
system can obtain or edit data for a work order or batch after its scheduled end date, as long as it 
is before its actual end date. 

 Enter August 15th, 1996 as "08151996" for a U.S. date, or 15081996 for an International date. The field will 

automatically add the slashes to display "08/15/1996" or "15/08/1996". 

For Help using date formats, click here. 

Actual End Date 

Enter the date that the work actually ended on the work order (Level 1) or batch (Level 2). The 
system cannot obtain or edit data for a work order or batch after its actual end date. 

 Enter August 15th, 1996 as "08151996" for a U.S. date, or 15081996 for an International date. The field will 

automatically add the slashes to display "08/15/1996" or "15/08/1996". 

For Help using date formats, click here. 

On Hold 

You can place a work order (Level 1) or batch (Level 2) "on hold". The system cannot obtain or 
edit data for a work order or batch while it is on hold. 

To Place a Work Order or Batch on Hold 

1. Enter the date from which the work order or batch is on hold in the On Hold From field. 

 Enter August 15th, 1996 as "08151996" for a U.S. date, or 15081996 for an International date. The field will 

automatically add the slashes to display "08/15/1996" or "15/08/1996". 
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For Help using date formats, click here. 

2. Enter the date until which the work order or batch is on hold in the On Hold Till field. 

Rate Codes for Levels 

For each rate structure, select the default Rate Code. The dialog box displays a separate line for 
each rate structure, according to the Number of Rates field. 

Type the number of the desired rate code, or click the Rate Code field to display a drop-down 
arrow. Click the drop-down arrow to display a list of rate codes defined in TC Setup. Click to 
choose the desired rate code.  

When you type or select a rate code's number, that rate code's name, value, and From Date are 
displayed in the appropriate fields. 

If you type 0, there will be no default rate code for the selected rate structure. Note that for every 
TC Record, at least one of the following elements must have a default rate code: Employee, 
Department, Profession, or one of the active levels. 

Planned Vs. Actual Tab 

For each work order or batch, the Planned Vs. Actual tab compares standard manufacturing time 
with the actual time spent on a job. 

Time and attendance accounting typically tracks cost as a function of time: 

Cost = Duration x Rate, where Duration is the time spent on a process and Rate is the cost per 
hour. 

TimeKeeper-PC can track cost as a function of Standard Unit Manufacturing Time (SUMT), which 
is the standard time needed to produce one unit in a job. This allows you to check production 
efficiency by comparing standard manufacturing time with the actual time spent on a job. In that 
case: 

Cost = Quantity x Rate, where Cost is the standard manufacturing time, Quantity is the number of 
units produced, and Rate is the SUMT. 

You can then compare Cost with Duration. If Cost is the greater value, then the Employee is more 
efficient than expected. If Duration is the greater value, then the Employee is less efficient than 
expected. 

You can also use this method to calculate cost by piecework by defining Rate as the sum paid for 
each unit produced. 

The upper panel of the Planned Vs. Actual tab determines the Standard Unit Manufacturing Time. 

The left-hand (Planned) panel of the Planned Vs. Actual tab determines planned output, duration, 
and costs. 

The right-hand (Actual) panel of the Planned Vs. Actual tab displays actual output, duration, and 
costs. 

Planned Vs. Actual Tab -- Upper Panel 

The upper panelof the Planned Vs. Actual tab determines the Standard Unit Manufacturing Time. 

Use one of the following fields: 

Time Per Unit 

Units Per Hour: To set the units per hour, type a value in this field. 
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Planned Vs. Actual Tab -- Time Per Unit (Planned 

Vs. Actual tab) 

To Set the Time per Unit: 

1. Type a value in the left-hand field. 

2. From the right-hand field, click to choose one of the following options: 

 Hours.Minutes: for example, to set the time per unit as three and a half hours, type 03.30 in the left-hand field. 

 Minutes.Seconds: for example, to set the time per unit as three and a half minutes, type 03.30 in the left-hand field. 

 Seconds 

 Decimal Hours: for example, to set the time per unit as three and a half hours, type 03.50 in the left-hand field. 

 Decimal Minutes: for example, to set the time per unit as three and a half minutes, type 03.50 in the left-hand field. 

Planned Vs. Actual Tab -- Planned Panel (Planned 

Vs. Actual tab) 

The left-hand (Planned) panelof the Planned Vs. Actual tab determines planned output, duration, 
and costs. 

Type values in the following fields: 

 Planned Units 

 Planned Duration 

 Cost of Labor 

 Cost of Materials 

Planned Vs. Actual Tab -- Actual Panel (Planned 

Vs. Actual tab) 

The right-hand (Actual) panelof the Planned Vs. Actual tab displays actual output, duration, and 
costs. 

The system automatically enters values in the following fields: 

 Units Produced 

 Actual Duration 

 Billing Value 

You can manually override the automatic values in these fields by entering new values. 

Type a value in the Actual Cost of Materials field. 

Adding and Editing Level 2 Rates 

The Batch (Level 2) dialog box determines rates and other settings for the second level of time-
costing. This level is usually used for batches. Batches can also be referred to by other names, 
such as districts. 



  113 

To View or Edit Level 2 Rates 

1. Choose Add/Edit TimeCosting Set-Up Files from the TimeKeeper-PC Set-Up menu. 

2. Choose Add/Edit Batch. 

The top panel of the Batch (Level 2) dialog box contains the following fields: 

Work Order Number 

Work Order Name 

 The Work Order fields are displayed only if batches (Level 2) are linked to work orders (Level 1). For Help 

linking levels, click here. 

Batch Number 

Batch Name 

The main area of the Batch (Level 2) dialog box is composed of two tabs: 

For each batch, the General tab determines active dates and rates for up to three different rate 
structures. Note that for every TC Record, at least one of the following elements must have a 
default rate code: Employee, Department, Profession, or one of the active levels. 

For each batch, the Planned Vs. Actual tab compares standard manufacturing time with the actual 
time spent on a job. 

When the desired values are displayed in all fields, click the Save icon  to save your changes 
to Level 2 rates. 

Work Orders in Level 2 (Adding and Editing Level 

2 Rates) 

The Work Order Number and Name fields are displayed only if batches (Level 2) are linked to 
work orders (Level 1). When batches are linked to work orders, every batch must be assigned to 
a work order. If you try to save a batch without assigning it to a work order, you will receive an 
error message. 

 For Help linking levels, click here. For Help defining work orders, click here. 

To assign a batch to a work order, type the number of the work order, or select a work order from 
a drop-down list by clicking the drop-down arrow to the right of the Number field. 

When you select a work order's number, that work order's name is displayed in the Name field. 

Level 2 Number (Adding and Editing Level 2 

Rates) 

Type the number of a defined batch, or select a defined batch from a drop-down list by clicking 
the drop-down arrow to the right of the Number field. 

You can also define a new batch by typing a number which is not currently in use. 

When you select a defined batch's number, that batch's name is displayed in the Name field. 
When you define a new batch, type a name for the new batch in the Name field. 

Level 2 Name (Adding and Editing Level 2 Rates) 
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When you select a defined batch's number, that batch's name is displayed in the Name field. You 
can edit the batch's name. 

When you define a new batch, type a name for the new batch in the Name field. 

Level 2 General Tab (Adding and Editing Level 2 

Rates) 

For each batch, the General tab determines active dates and rates for up to three different rate 
structures. Note that for every TC Record, at least one of the following elements must have a 
default rate code: Employee, Department, Profession, or one of the active levels. 

The General tab contains the following fields: 

Scheduled Start Date  

Scheduled End Date 

Actual End Date 

On Hold From 

On Hold Till 

Type of Order 

Rate Code 

Adding and Editing Level 3 Rates 

The Part (Level 3) dialog box determines rates and other settings for the third level of time-
costing. This level is usually used for parts. Parts can also be referred to by other names, such as 
sections. 

To View or Edit Level 3 Rates 

1. Choose Add/Edit TimeCosting Set-Up Files from the TimeKeeper-PC Set-Up menu. 

2. Choose Add/Edit Part. 

The top panel of the Part (Level 3) dialog box contains the following fields: 

Work Order Number 

Work Order Name 

Batch Number 

Batch Name 

 The Work Order fields are displayed only if batches (Level 2) are linked to work orders (Level 1) and parts 

(Level 3) are linked to batches. The Batch fields are displayed only if parts are linked to batches. For Help 

linking levels, click here. 

Part Number 

Part Name 

The main area of the Part (Level 3) dialog box is composed of three tabs: 

For each batch, the Auto Level File tab defines names for defined character positions in Batch 
(Level 2) index codes. 

For each batch, the Planned Vs. Actual tab compares standard manufacturing time with the actual 
time spent on a job. 
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For each batch, the Rates tab determines rates for up to three different rate structures. Note that 
for every TC Record, at least one of the following elements must have a default rate code: 
Employee, Department, Profession, or one of the active levels. 

When the desired values are displayed in all fields, click the Save icon  to save your changes 
to Level 3 rates. 

Work Orders in Level 3 (Adding and Editing Level 

3 Rates) 

The Work Order Number and Name fields are displayed only if batches (Level 2) are linked to 
work orders (Level 1) and parts (Level 3) are linked to batches. When parts are linked through 
batches to work orders, every part must be assigned to a work order. If you try to save a part 
without assigning it to a work order, you will receive an error message. 

 For Help linking levels, click here. For Help defining work orders, click here. 

To assign a part to a work order, type the number of the work order, or select a work order from a 
drop-down list by clicking the drop-down arrow to the right of the Number field. 

When you select a work order's number, that work order's name is displayed in the Name field. 

Batches in Level 3 (Adding and Editing Level 3 

Rates) 

The Batch Number and Name fields are displayed only if parts (Level 3) are linked to batches 
(Level 2). When parts are linked to batches, every part must be assigned to a batch. If you try to 
save a part without assigning it to a batch, you will receive an error message. 

 For Help linking levels, click here. For Help defining batches, click here. 

To assign a part to a batch, type the number of the batch, or select a batch from a drop-down list 
by clicking the drop-down arrow to the right of the Number field. 

When you select a batch's number, that batch's name is displayed in the Name field. 

Level 3 Number (Adding and Editing Level 3 

Rates) 

Type the number of a defined part, or select a defined part from a drop-down list by clicking the 
drop-down arrow to the right of the Number field. 

You can also define a new part by typing a number which is not currently in use. 

When you select a defined part's number, that part's name is displayed in the Name field. When 
you define a new part, type a name for the new part in the Name field. 

Level 3 Name (Adding and Editing Level 3 Rates) 

When you select a defined part's number, that part's name is displayed in the Name field. You can 
edit the part's name. 

When you define a new part, type a name for the new part in the Name field. 
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Auto Level File Tab (Adding and Editing Level 3 

Rates) 

Example 

You can define auto files for any level. Auto files group a level's elements according to automatic 
keys embedded in a higher level's index codes. You cannot assign an auto file to a level which is 
not active (selected). 

When you define auto files for Level 3 (Parts), the Auto Level File tab displays fields for Auto-
Level numbers and names. The Auto-Level Number field includes a drop-down list of defined 
character positions from Batch (Level 2) index codes.  

Choose a character position from the drop-down list in the Number field, and type a definition of 
that character in the Name field. 

When you define auto files for Level 3 (Parts), the Planned Vs. Actual tab is blank, and you cannot 
compare standard manufacturing time with the actual time spent on a part. 

Example -- Auto File Level Tab      

In a chain of restaurants, Level 3 can be defined as individual restaurants, identified by six-character index 

codes. Two-letter state codes can be embedded within those six-character index codes. If Level 2 is defined as 

states, then restaurants can be assigned automatically to states on the basis on the state codes embedded in 

their index codes. In that case, choose the character position of the two-letter state code and name it "State". 

Level 3 Planned Vs. Actual Tab (Adding and 

Editing Level 3 Rates) 

For each work order or batch, the Planned Vs. Actual tab compares standard manufacturing time 
with the actual time spent on a job. 

Time and attendance accounting typically tracks cost as a function of time: 

Cost = Duration x Rate, where Duration is the time spent on a process and Rate is the cost per 
hour. 

TimeKeeper-PC can track cost as a function of Standard Unit Manufacturing Time (SUMT), which 
is the standard time needed to produce one unit in a job. This allows you to check production 
efficiency by comparing standard manufacturing time with the actual time spent on a job. In that 
case: 

Cost = Quantity x Rate, where Cost is the standard manufacturing time, Quantity is the number of 
units produced, and Rate is the SUMT. 

You can then compare Cost with Duration. If Cost is the greater value, then the Employee is more 
efficient than expected. If Duration is the greater value, then the Employee is less efficient than 
expected. 

You can also use this method to calculate cost by piecework by defining Rate as the sum paid for 
each unit produced. 

The upper panel of the Planned Vs. Actual tab determines the Standard Unit Manufacturing Time. 

The left-hand (Planned) panel of the Planned Vs. Actual tab determines planned costs per unit 
and duration. 

The right-hand (Actual) panel of the Planned Vs. Actual tab displays actual costs per unit, 
duration, and output. 
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Level 3 Planned Vs Actual Tab -- Planned Panel 

(Level 3 Planned Vs Actual Tab) 

The left-hand (Planned) panelof the Planned Vs. Actual tab determines planned costs per unit and 
duration. 

Type values in the following fields: 

 Cost Per Unit -- Labour 

 Cost Per Unit -- Material 

 Total Duration 

Level 3 Planned Vs Actual Tab -- Actual Panel 

(Level 3 Planned Vs Actual Tab) 

The right-hand (Actual) panelof the Planned Vs. Actual tab displays actual costs per unit, duration, 
and output. 

The system automatically enters values in the following fields: 

 Cost Per Unit -- Labour 

 Price Per Unit 

 Total Duration 

 Total Units Produced 

You can manually override the automatic values in these fields by entering new values. 

Adding and Editing Level 4 Rates 

The Process (Level 4) dialog box determines rates and other settings for the fourth level of time-
costing. This level is usually used for processes. 

To View or Edit Level 4 Rates 

1. Choose Add/Edit TimeCosting Set-Up Files from the TimeKeeper-PC Set-Up menu. 

2. Choose Add/Edit Process. 

The top panel of the Process (Level 4) dialog box contains the following fields: 

Work Order Number 

Work Order Name 

Batch Number 

Batch Name 

Part Number  

Part Name  

Department Number  

Department Name  
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 The Work Order fields are displayed only if batches (Level 2) are linked to work orders (Level 1), parts 

(Level 3) are linked to batches, and processes (Level 4) are linked to parts. The Batch fields are displayed 

only if parts are linked to batches and processes are linked to parts. The Parts fields are displayed only if 

processes are linked to parts. The Departments fields are displayed only if the Use Department check box 

is selected in the TC Configuration File. For Help linking levels, click here. 

Process Number 

Process Name 

The main area of the Process (Level 4) dialog box is composed of three tabs: 

For each process, the General tab determines auto levels, machines, cost centers, and types. 

For each process, the Unit Costs tab determines standard unit manufacturing time (SUMT). 

For each process, the Rates tab determines rates for up to three different rate structures. Note 
that for every TC Record, at least one of the following elements must have a default rate code: 
Employee, Department, Profession, or one of the active levels. 

When the desired values are displayed in all fields, click the Save icon  to save your changes 
to Level 4 rates. 

Work Orders in Level 4 (Adding and Editing Level 

4 Rates) 

The Work Order Number and Name fields are displayed only if batches (Level 2) are linked to 
work orders (Level 1), parts (Level 3) are linked to batches, and processes (Level 4) are linked to 
parts. When processes are linked through batches and parts to work orders, every process must 
be assigned to a work order. If you try to save a process without assigning it to a work order, you 
will receive an error message. 

 For Help linking levels, click here. For Help defining work orders, click here. 

To assign a process to a work order, type the number of the work order, or select a work order 
from a drop-down list by clicking the drop-down arrow to the right of the Number field. 

When you select a work order's number, that work order's name is displayed in the Name field. 

Batches in Level 4 (Adding and Editing Level 4 

Rates) 

The Batch Number and Name fields are displayed only if parts (Level 3) are linked to batches 
(Level 2) and processes (Level 4) are linked to parts. When processes are linked through parts to 
batches, every process must be assigned to a batch. If you try to save a process without 
assigning it to a batch, you will receive an error message. 

 For Help linking levels, click here. For Help defining batches, click here. 

To assign a process to a batch, type the number of the batch, or select a batch from a drop-down 
list by clicking the drop-down arrow to the right of the Number field. 

When you select a batch's number, that batch's name is displayed in the Name field. 

Parts in Level 4 (Adding and Editing Level 4 

Rates) 
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The Part Number and Name fields are displayed only if processes (Level 4) are linked to parts 
(Level 3). When processes are linked to parts, every process must be assigned to a part. If you try 
to save a process without assigning it to a part, you will receive an error message. 

 For Help linking levels, click here. For Help defining parts, click here. 

To assign a process to a part, type the number of the part, or select a part from a drop-down list 
by clicking the drop-down arrow to the right of the Number field. 

When you select a part's number, that part's name is displayed in the Name field. 

Departments in Level 4 (Adding and Editing Level 

4 Rates) 

The Departments fields are displayed only if the Use Department check box is selected in the TC 
Configuration File. When you make processes dependent on departments, every process must be 
assigned to a department, and all processes are department-dependent. If you try to save a 
process without assigning it to a department, you will receive an error message. 

For Help defining Departments, click here. 

To assign a process to a department, type the number of the department, or select a department 
from a drop-down list by clicking the drop-down arrow to the right of the Number field. 

When you select a department's number, that department's name is displayed in the Name field. 

Level 4 Number (Adding and Editing Level 4 

Rates) 

Type the number of a defined process, or select a defined process from a drop-down list by 
clicking the drop-down arrow to the right of the Number field. 

You can also define a new process by typing a number which is not currently in use. 

When you select a defined process's number, that process's name is displayed in the Name field. 
When you define a new process, type a name for the new process in the Name field. 

Level 4 Name (Adding and Editing Level 4 Rates) 

When you select a defined process's number, that process's name is displayed in the Name field. 
You can edit the process's name. 

When you define a new process, type a name for the new process in the Name field. 

Level 4 General Tab (Adding and Editing Level 4 

Rates) 

For each process, the General tab determines auto levels, machines, cost centers, and types. 

The General tab contains the following fields: 

Auto-Level  

Machine  

Cost Center  
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Process Type  

Auto Levels in Level 4 (Level 4 General Tab) 

Example 

You can define auto files for any level. Auto files group a level's elements according to automatic 
keys embedded in a higher level's index codes. You cannot assign an auto file to a level which is 
not active (selected). 

When you define auto files for Level 4 (Processes), the General tab displays the Auto-Level fields 
for numbers and names. The Auto-Level Number field includes a drop-down list of defined 
character positions from Part (Level 3) index codes.  

Choose a character position from the drop-down list in the Number field, and type a definition of 
that character in the Name field. 

Example -- Auto Levels in Level 4      

In a technical writing firm, each manual can be defined as a job (Level 1), and the steps needed to produce a 

manual (researching, writing, testing, and proofreading) can be defined as processes (Level 4). Three-digit 

manual codes can be embedded in the index codes for processes. In that case, choose the character position of 

the three-digit manual code and name it "Manual". 

Machines in Level 4 (Level 4 General Tab) 

You can assign a process to a machine. To assign a process to a machine, type the number of 
the machine, or select a machine from a drop-down list by clicking the drop-down arrow to the 
right of the Number field. 

When you select a machine's number, that machine's name is displayed in the Name field. 

For Help defining machines, click here. 

Cost Centers in Level 4 (Level 4 General Tab) 

Cost centers can be defined as a group of sub-departments, machines, or work stations used in a 
process. 

You can assign a process to a cost center. To assign a process to a cost center, type the number 
of the cost center, or select a cost center from a drop-down list by clicking the drop-down arrow to 
the right of the Number field. 

When you select a cost center's number, that cost center's name is displayed in the Name field. 

For Help defining cost centers, click here. 

Process Type (Level 4 General Tab) 

Example 

A process can be defined as either direct or indirect. 

An indirect process is not necessary for a specific job, but for the system as a whole. A direct 
process is necessary for a specific job. 

Choose either Indirect or Direct from the drop-down list. 
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Example -- Process Type      

In a large automotive plant, Sweeping and Testing Van Chassis Assembly are both processes (Level 4). 

Sweeping is necessary for the plant as a whole, but any one part (Level 3) can be assembled even if the floor has 

not been swept. Sweeping is therefore an indirect process. Testing van chassis assemblies is necessary for Van 

Chassis Assembly, and it is therefore a direct process. 

Unit Costs Tab (Adding and Editing Level 4 Rates) 

For each process, the Unit Costs tab determines standard unit manufacturing time (SUMT). 

Time and attendance accounting typically tracks cost as a function of time: 

Cost = Duration x Rate, where Duration is the time spent on a process and Rate is the cost per 
hour. 

TimeKeeper-PC can track cost as a function of Standard Unit Manufacturing Time (SUMT), which 
is the standard time needed to produce one unit in a job. This allows you to check production 
efficiency by comparing standard manufacturing time with the actual time spent on a job. In that 
case: 

Cost = Quantity x Rate, where Cost is the standard manufacturing time, Quantity is the number of 
units produced, and Rate is the SUMT. 

You can then compare Cost with Duration. If Cost is the greater value, then the Employee is more 
efficient than expected. If Duration is the greater value, then the Employee is less efficient than 
expected. 

You can also use this method to calculate cost by piecework by defining Rate as the sum paid for 
each unit produced. 

The Unit Costs tab contains the following fields: 

Time Per Unit  

Units Per Hour: To set the units per hour, type a value in this field. 

Cost Rate per Unit: To set the cost rate per unit, type a value in this field. 

Billing Rate per Unit: To set the billing rate per unit, type a value in this field. 

Unit Costs Tab -- Time Per Unit (Unit Costs Tab) 

To Set the Time per Unit: 

1. Type a value in the left-hand field. 

2. From the right-hand field, click to choose one of the following options: 

 Hours.Minutes: for example, to set the time per unit as three and a half hours, type 03.30 in the left-hand field. 

 Minutes.Seconds: for example, to set the time per unit as three and a half minutes, type 03.30 in the left-hand field. 

 Seconds 

 Decimal Hours: for example, to set the time per unit as three and a half hours, type 03.50 in the left-hand field. 

 Decimal Minutes: for example, to set the time per unit as three and a half minutes, type 03.50 in the left-hand field. 

Adding and Editing TC Rates 

Rates are created and edited using the Rate dialog box. 
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To View or Edit Rates 

1. Choose Add/Edit TimeCosting Set-Up Files from the TimeKeeper-PC Set-Up menu. 

2. Choose Add/Edit Rates. 

The Rate dialog box contains the following fields: 

Number 

From Date 

Name 

Rate 

When the desired values are displayed in all fields, click the Save icon  to save your changes 
to rates. 

TC Rate Number (Adding and Editing TC Rates) 

Type the number of a defined rate, or select a defined rate from a drop-down list by clicking the 
drop-down arrow to the right of the Number field. 

You can also define a new rate by typing a number which is not currently in use. 

When you select a defined rate's number, that rate's From Date and name are displayed in the 
From Date and Name fields. When you define a new rate, type a From Date and name for the 
new rate in the appropriate fields. 

Rate From Date (Adding and Editing TC Rates) 

When you select a defined rate's number, that rate's current From Date is displayed in the From 
Date field. You can edit the rate's From Date to change the value paid by a rate without defining a 
new rate code. 

 Rate Code 32, which has been active since June 1, 1994, costs $10 an hour. You can edit Rate Code 32 to 

have a new From Date of January 1, 1999 at the value of $11. All Records assigned to Rate Code 32 after 

the new From Date will be costed at the new value. 

When you define a new rate, type a From Date for the new rate in the From Date field. For Help 
using date formats, click here. 

TC Rate Name (Adding and Editing TC Rates) 

When you select a defined rate's number, that rate's name is displayed in the Name field. You can 
edit the rate's name. 

When you define a new rate, type a name for the new rate in the Name field. 

TC Rate Value (Adding and Editing TC Rates) 

Type the value by which the number of hours is multiplied. 

Adding and Editing Departmental Rates 

Departments are created and edited using the Departmental Rates dialog box. 
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To View or Edit Departments 

1. Choose Add/Edit TimeCosting Set-Up Files from the TimeKeeper-PC Set-Up menu. 

2. Choose Add/Edit Departmental Rate. 

The Departmental Rates dialog box is displayed. This is the same dialog box displayed by the 
Department Codes option in the Shared Setup Files sub-menu. 

The Departmental Rates dialog box contains the following fields: 

Number 

Name 

Standard Regular 

Standard OT 

Rate Code 

When the desired values are displayed in all fields, click the Save icon  to save your changes 
to  departmental rates. 

TC Department Number (Departmental Rates) 

Type the number of a defined Department, or select a defined Department from a drop-down list 
by clicking the drop-down arrow to the right of the Number field. 

You can also define a new Department by typing a number which is not currently in use. 

When you select a defined Department's number, that Department's name is displayed in the 
Name field. When you define a new Department, type a name for the new Department in the 
Name field. 

TC Department Name (Departmental Rates) 

When you select a defined Department's number, that Department's name is displayed in the 
Name field. You can edit the Department's name. 

When you define a new Department, type a name for the new Department in the Name field. 

TC Standard Regular (Departmental Rates) 

Type the planned Pay Period budget of Regular hours per Employee in this Department. 

This Pay Period budget of hours can be exceeded.  

TC Standard OT (Departmental Rates) 

Type the planned Pay Period budget of Overtime hours per Employee in this Department. 

This Pay Period budget of hours can be exceeded. 

TC Departmental Rate Code (Departmental Rates) 

For each rate structure, select the default Rate Code for this Department. The dialog box displays 
a separate line for each rate structure, according to the Number of Rates field. 
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Type the number of the desired rate code, or click the Rate Code field to display a drop-down 
arrow. Click the drop-down arrow to display a list of rate codes defined in TC Setup. Click to 
choose the desired rate code.  

When you type or select a rate code's number, that rate code's name, value, and From Date are 
displayed in the appropriate fields. 

If you type 0, the Department will have no default rate code for the selected rate structure. Note 
that for every TC Record, at least one of the following elements must have a default rate code: 
Employee, Department, Profession, or one of the active levels. 

Adding and Editing Combined Rates 

A combined rate applies only when a specified combination of field values occurs. The Combined 
Rates (Data Entry For RATECMB# Files) dialog box determines only the required values in each 
field and the resulting rate. The specific fields to be combined for each rate structure are 
determined by the Combined Rates Tab of the TC Configuration File. 

Combined rates are the first default for a rate structure. If the required field values do not occur, 
TC will apply rates according to the Rate Orders tab of the TC Configuration File. 

Combined rates are created and edited using the Combined Rates (Data Entry For RATECMB# 
Files) dialog box. 

To View or Edit Combined Rates 

1. Choose Add/Edit TimeCosting Set-Up Files from the TimeKeeper-PC Set-Up menu. 

2. Choose Add/Edit Combined Rates. 

The Combined Rates (Data Entry For RATECMB# Files) dialog box is composed of one to three 
tabs, according to number of rate structures enabled by the Number of Rates field in the TC 
Configuration File. When the number of rate structures is set at 0, the Combines Rates dialog box 
cannot be opened. 

The name of a rate structure is displayed at the top of each tab. 

Each tab contains up to five fields, according to the fields selected for that rate structure by the 
Combined Rates Tab. 

Choose an element for each field displayed in the tab. 

Choose a Rate Code for the Combined Rate. 

When the desired values are displayed in all fields, click the Save icon  to save your changes 
to combined rates. 

Choosing Elements for a Combined Rate Field 

(Adding and Editing Combined Rates) 

Choose an element for a Combined Rate field by one of the following methods: 

 Type the element's number in the appropriate field. For example, to choose Employee 1, type 1 in the Employee field. 

 Click the drop-down arrow next to the field to display a list of elements already defined by number and description or name. 

Click to choose one of the elements on that list. 

When you choose an element's number for a Combined Rate field, that element's description or 
name is displayed in the field to the right of the drop-down arrow. 



  125 

Choosing a Rate Code for a Combined Rate Field 

(Adding and Editing Combined Rates) 

Type the number of the desired rate code, or click the Rate Code field to display a drop-down 
arrow. Click the drop-down arrow to display a list of rate codes defined in TC Setup. Click to 
choose the desired rate code.  

When you type or select a rate code, that rate's description, From Date, and value are displayed 
in the appropriate fields. 

If you do not choose a rate code, the default rate code 0 will generate Exception# 226 (during the 
rate evaluation process no valid rate was found). 

Adding and Editing Cost Centers 

Example 

Cost centers can be defined as a group of sub-departments, machines, or work stations used in a 
process. 

Cost centers are created and edited using the Cost Center dialog box. 

To View or Edit Cost Centers 

1. Choose Add/Edit TimeCosting Set-Up Files from the TimeKeeper-PC Set-Up menu. 

2. Choose Add/Edit Cost Center. The Cost Center dialog box is displayed. 

3. Type the number of a defined cost center, or select a defined cost center from a drop-down list by clicking the drop-
down arrow to the right of the Number field. You can edit the cost center's name in the Name field. 

4. You can also define a new cost center by typing a number which is not currently in use. When you define a new cost 
center, type a name for the new cost center in the Name field. 

5. When the desired values are displayed in all fields, click the Save icon  to save your changes to  cost centers. 

Example -- Cost Centers     In a large automotive plant, welding robots can be grouped into cost 

centers according to their year of purchase. This allows you to compare the production efficiency of various 

model years of welding robots by comparing standard manufacturing time and actual manufacturing time for the 

various cost centers. 

Adding and Editing Machines 

Machines are created and edited using the Machine dialog box. 

To View or Edit Machines 

1. Choose Add/Edit TimeCosting Set-Up Files from the TimeKeeper-PC Set-Up menu. 

2. Choose Add/Edit Machine. The Machine dialog box is displayed. 

3. Type the number of a defined machine, or select a defined machine from a drop-down list by clicking the drop-down 
arrow to the right of the Number field. You can edit the machine's name in the Name field. 

4. You can also define a new machine by typing a number which is not currently in use. When you define a new 
machine, type a name for the new machine in the Name field. 

5. To view machine loads and RPM coefficients, click the Browse button . A list of machines and their 
corresponding machine loads and RPM coefficients is displayed. 

6. To edit values for machine loads and RPM coefficients, type the desired value in the appropriate field. 
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7. Click the Edit button  to return to the Machine dialog box. 

8. When the desired values are displayed in all fields, click the Save icon  to save your changes to  machines. 

Adding and Editing Cells 

[To be completed] 

Assigning Default Jobs to Employees 

Example 

Employee default job assignments determine how an Employee's hours are automatically 
assigned to jobs by percentage of total time worked. 

A single Employee can have many default job assignments, each valid from a specified From 
Date. 

The default job assignment cannot exceed 100%. The default job assignment can be less than 
100%, in which case not all hours are assigned to jobs. 

To View or Edit Default Job Assignments 

1. Choose Add/Edit TimeCosting Set-Up Files from the TimeKeeper-PC Set-Up menu. 

2. Choose Add/Edit Employee Default Job Assignment. 

The Default Job Assignment per Employee dialog box is composed of three panels. 

The top panel displays information about the selected Employee. 

The middle panel determines default job assignments according to level parameters. 

The borrom panel allows you to choose an Employee according to TC occupation type. 

When the desired values are displayed in all fields, click the Save icon  to save your changes 
to default job assignments. 

Example -- Employee Default Job Assignments          

 

In a restaurant, an Employee's hours can be automatically assigned as follows: 25% to Grilling Hamburgers, 70% 

to Grilling Cheeseburgers, and 5% to Cleaning Grill. If that Employee uses TK punches to punch in and out of an 

eight-hour day, TimeCosting-PC will automatically assign two hours to Grilling Hamburgers, 5.6 hours (five 

hours and 36 minutes) to Grilling Cheeseburgers, and 0.4 hours (24 minutes) to Cleaning Grill. 

If the grill tends to get dirtier during the summer, a new default job assignment (assigning 10% to Cleaning Grill) 

can be created with a From Date of July 1, 1999. If the Cleaning Grill assignment is increased to 10%, the other 

assignments must be reduced so that the total default job assignment does not exceed 100%. 

Default Job Assignment -- Top Panel (Assigning 

Default Jobs to Employees) 

The top panel of the Default Job Assignment per Employee dialog box displays information about 
the selected Employee. 

This panel contains the following fields: 
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Employee Number 

Employee Name  

From Date  

Occupation Type  

Default Job Assignment -- Employee Number and 

Name (Default Job Assignment -- Top Panel) 

The Employee Number and Name fields display the selected Employee. 

To choose an Employee using the Employee Number field, click the drop-down arrow next to the 
Employee Number field to display a list of Employees, names, and From Dates. Click to choose 
an Employee. The Employee's name, which cannot be edited in this dialog box, is displayed in the 
Name field. 

The Employee's current From Date is displayed in the From Date field. For Help defining the From 
Date for a default job assignment, click here. 

The Employee's occupation type, which cannot be edited in this dialog box, is displayed in the 
Occupation Type field. For Help about occupation types, click here. 

The parameters of the Employee's current default job assignment are displayed in the middle 
panel. For Help defining default job assignment parameters, click here. 

You can also choose Employees according to occupation type. For Help choosing Employees 
according to occupation type, click here. 

Default Job Assignment -- From Date (Default Job 

Assignment -- Top Panel) 

A single Employee can have many default job assignments, each valid from a specified From 
Date. 

To choose a From Date for a default job assignment, type the date in the From Date field. 

When you select a defined default job assignment, that assignment's current From Date is 
displayed in the From Date field. You can edit the assignment's From Date to change percentage 
parameters without defining a new default job assignment. 

 In a restaurant, 5% of an Employee's hours can be automatically assigned to cleaning the grill. If the grill 

tends to get dirtier during the summer, a new default job assignment (assigning 10% to Cleaning Grill) can 

be created with a From Date of July 1, 1999. 

When you define a new default job assignment, type a From Date for the new assignment in the 
From Date field. For Help using date formats, click here. 

Default Job Assignment -- Occupation Type 

(Default Job Assignment -- Top Panel) 

The Occupation Type field displays the occupation type chosen for the currently selected 
Employee. The occupation type determines how default job assignments are applied to actual 
hours. 

This field cannot be edited in this dialog box. 
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TC occupation types include combinations of the following elements: 

Indirect/Direct  

Default Jobs  

Clock Transactions  

TC occupation types include the following combinations: 

 TC-Indirect 

 TC-Indirect + Default Jobs only w/o Clock Transactions 

 TC-Indirect + Default Jobs only with Clock Transactions 

 TC-Indirect + Default Jobs 

 TC-Direct 

 TC-Direct + Default Jobs only w/o Clock Transactions 

 TC-Direct + Default Jobs only with Clock Transactions 

 TC-Direct + Default Jobs 

Default Job Assignment -- Middle Panel 

(Assigning Default Jobs to Employees) 

The middle panel of the Default Job Assignment per Employee dialog box determines default job 
assignments according to level parameters. 

This panel contains the following columns: 

 All active levels (work order, batch, part, process) 

 Department 

 Cost Center 

 Profession 

 Assignment % 

To Define Default Job Assignments 

1. For each assignment, choose the levels and elements to which hours are assigned. 

2. You can also specify the Department, cost center, and profession to which hours are assigned. These fields are 
optional. 

3. Enter the percentage of hours to be assigned to those levels and elements. 

4. Repeat steps 1-3 for each assignment. For example, to enter percentages for three processes, each process and its 
percentage must be defined on a separate line. 

Default Job Assignment -- Bottom Panel 

(Assigning Default Jobs to Employees) 

The borrom panel of the Default Job Assignment per Employee dialog box allows you to select an 
Employee according to TC occupation type. This can be useful for selecting an Employee from a 
large database.  

This panel displays the following buttons: 

 List of Employees (Sorted By Number) 
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 List of Employees (Sorted By Name) 

Click either button to display the Select Occupied Types dialog box. Choose All to display all 
employees, or Selected Types to display Employees from specific occupation types. 

If you choose Selected Types, choose types from the list displayed in the main area of the dialog 
box. 

The dialog box displays the six occupation types which use default job assignment tables: 

 TC-Indirect + Default Jobs only w/o Clock Transactions 

 TC-Indirect + Default Jobs only with Clock Transactions 

 TC-Indirect + Default Jobs 

 TC-Direct + Default Jobs only w/o Clock Transactions 

 TC-Direct + Default Jobs only with Clock Transactions 

 TC-Direct + Default Jobs 

The dialog box does not display the three occupation types which do not use the default job 
assignment tables. 

Click to select any occupation type on the list. Click to deselect any selected occupation type. 
When the list displays the occupation types whose Employees are to be displayed, click OK. The 
List of Employees dialog box displays the selected Employees, sorted by either number or name, 
according to the button clicked previously. 

The title bar of the List of Employees dialog box displays the sorting method and the occupation 
types from which the Employees are selected. 

Click to select any Employee on the list. Click OK to display the selected Employee in the default 
job assignment table. 

Choose Contents from the Help menu to view the Contents page of this Help file. 

Choose Search For Help On from the Help menu to search for Help on a specific topic. 

Choose About from the Help menu to view information of this version of TimeCosting-PC. 

A Contract is a set of rules and definitions which determine how an Employee is to be paid for 
work hours. 

General Tab -- Badge Number 

Usually, employees are assigned badges (magnetic stripe, bar code, or proximity) to enable them 
to "punch" an electronic time clock. Each badge has a unique identification number, and every 
Employee must have a Badge number. 

An Employee's Badge number can be changed during employment, most typically if the Employee 
loses a badge. When a new badge is given to the Employee, the new Badge number must be 
entered in the Employee Profile. 

Two Employees cannot be assigned the same Badge number, even if it is assigned to them 
during different periods. 

 Joe Johnson can be assigned Badge number 13 from the beginning of his employment until the end of 

1996, and Badge number 14 from the beginning of 1997 until the end of his employment. In that case, Jane 

Jackson cannot be assigned Badge number 14, even if its period of validity ends before 1997. 
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If you try to save an Employee Profile with a Badge number already assigned to another 
Employee, you will receive the error message: "Badge: Already in use by another employee." Click 
Cancel to return to the Employee Profile to make changes. 

 If you click OK, the Badge number will no longer be assigned to that other Employee. 

 If you try to save Jane Jackson's Employee Profile with Badge number 14 for any period, you will receive 

the error message: "Badge: 14 Already in use by another employee." If you click OK, Badge number 14 will 

be removed from Joe Johnson's Employee Profile. 

The Badge Number field displays the Employee's current Badge number. The Validity fields 
display the beginning and ending dates of the Employee's current Badge number. 

 In the example above, if Joe Johnson's Employee Profile is checked during 1998, his Badge number will be 

displayed as 14. 

TimeKeeper-PC can keep track of up to ten Badge numbers per Employee, whether expired, 
current, or future. 

For Help using date formats, click here. 

To Enter a Badge Number and Validity Dates 

1. Choose Add/Edit Employee Profile from the Activities menu. The Employee Master File is displayed. 

2. Choose the Employee whose Badge number is to be edited. For Help choosing an Employee, click here. 

3. Double-click the Badge Number field and enter the Employee's current Badge number. 

 Do not use an Badge number currently in use by another Employee. You can check the list of Badge 

numbers currently in use with the Badges yellow file tab in the Employee File Cabinet. 

For Help using the Badges yellow file tab to check Badge numbers, click here. 

4. Double-click the From field. 

5. Enter the beginning date of the Badge number displayed in the Badge Number field. 

 Enter August 15th, 1996 as "08151996" for a U.S. date, or 15081996 for an International date. The field will 

automatically add the slashes to display "08/15/1996" or "15/08/1996". 

6. Repeat step 3 to enter the ending date of the Badge number in the To field. 

You can also use the More button to edit and view Badge numbers and their dates. For Help using 
the More button, click here. 

Usually, employees are assigned badges (magnetic stripe, bar code, or proximity) to enable them 
to "punch" an electronic time clock. Each badge has a unique identification number, and every 
Employee must have a Badge number. 

General Tab -- Badge Number -- More Button 

If the Employee has been assigned to only one Badge number during employment, the word 
"More" will be displayed in black characters. If the Employee has been assigned to more than one 
Badge number during employment, the word "More" will be displayed in red characters. 

Click the More button next to the Validity fields to open the Badges dialog box. A list of Badge 
numbers and their From and To dates will be displayed: 
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The Badges dialog box displays each Badge number's Validity (From and To) dates. 

 In the example above, Badge number 1 is valid for the years 1990-1996, Badge number 11 for 1997-1999, 

and Badge number 21 thereafter. 

Every valid Badge number must have From and To dates. In the example above, the final To date 
which falls in the year 2099 ensures that the Badge number will be valid for the Employee's entire 
period of employment. 

You can enter a new Badge number and its From and To dates. For Help entering a new Badge 
number for an Employee, click here. 

 In the example above, you can add Badge number 31 to be valid for the years 2000-2002. In that case, you 

need to change the date range for Badge number 21 to begin in 2003, so that the two Badge numbers do 

not overlap. 

There are only ten rows in the Badges dialog box. If all ten rows are filled, you can enter a new 
Badge number only by replacing one of the current Badge numbers. Once you change a current 
Badge number and From and To dates and save the Employee Profile, the former information will 
be lost. 

You can change the Badge number for a particular date range. For Help changing the Banumber 
for a date range, click here. 

 In the example above, you can change Badge number 11 for 1997-1999 to Badge number 13. 

You can change the date range for a particular Badge number. For Help changing the date range 
for an Badge number, click here. 

 In the example above, you can change the date range for Badge number 11 to include the year 2000 as well 

as 1997-1999. In that case, you need to change the date range for Badge number 21 to begin in 2001, so 

that the two Badge numbers do not overlap. 

You can delete an Badge number from the list. For Help deleting an Badge number for an 
Employee, click here. 

 Once you delete an Badge number for an Employee and save the Employee Profile, that information will be 

lost. 

 In the example above, you can delete Badge number 11 from the list. In that case, you need to change the 

date range for either the preceding or the following Badge number, so that the years 1997-1999 are 

included in one of them. 

To Enter a New Badge Number for an Employee 



  132 

1. Click the More button next to the Validity fields. The Badges dialog box will open. 

2. Click the first blank field in the Number Column. 

 There are only ten rows in the Badges dialog box. If all ten rows are filled, you can enter a new Badge 

number only by replacing one of the current Badge numbers. Once you change a current Badge number 

and From and To dates and save the Employee Profile, the former information will be lost. 

3. Type in the new Badge number. 

4. In the From column, click the field to the right of the new Badge number. 

5. Enter the From date for the new Badge number. 

 Enter August 15th, 1996 as "08151996" for a U.S. date, or 15081996 for an International date. The field will 

automatically add the slashes to display "08/15/1996" or "15/08/1996". 

6. Repeat steps 4-5 to enter the To date for the new Badge number. 

7. Click Close to close the Badges dialog box. 

To Change the Badge Number for a Date Range 

1. Click the More button next to the Validity fields. The Badges dialog box will open. 

2. In the Number column, click to the right of the Badge number you want to change. The Badge number will be 
highlighted, and a drop-down arrow will appear in the field. 

 When you open the Badges dialog box, the first Badge number will already be highlighted. If you want to 

change that Badge number, do not click it. 

3. Type in the new Badge number for that date range 

4. Click Close to close the Badges dialog box. 

To Change the Date Range for a Badge Number 

1. Click the More button next to the Validity fields. The Badges dialog box will open. 

2. In the From column, click to the right of the date you want to change. The date will be highlighted. 

3. Enter the new From date for that Badge number. 

 Enter August 15th, 1996 as "08151996" for a U.S. date, or 15081996 for an International date. The field will 

automatically add the slashes to display "08/15/1996" or "15/08/1996". 

4. Repeat steps 2-3 to change the To date for the Badge number. 

5. Click Close to close the Badges dialog box. 

To Delete a Badge Number for an Employee 

1. Click the More button next to the Validity fields. The Badges dialog box will open. 

2. In the Number column, click to the right of the Badge number you want to delete. The Badge number will be 
highlighted, and a drop-down arrow will appear in the field. 

 When you open the Badges dialog box, the first Badge number will already be highlighted. If you want to 

change that Badge number, do not click it. 

3. Press <Delete>. 

4. Click Close to close the Badges dialog box. 

General Tab -- Contract 

Every Employee has a Contract: a set of rules and definitions which determine how that Employee 
is to be paid for work hours. A Contract can apply to only one Employee, or it can apply to an 
entire group of Employees. 
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You can assign an Employee to different Contracts during different periods of employment. 

 You can assign an Employee to a Contract for Groundskeepers at the beginning of employment. If the 

Groundskeeper is later promoted to Grounds Supervisor, you can then assign a new Contract. 

The Contract field displays the number of the Employee's current Contract. The name of that 
Contract is displayed below the Contract field. 

The Valid From field displays the beginning date of the Employee's current Contract. 

 In the example above, if you enter the current date as the Valid From date for the new Contract, then the 

new Contract number and name ("Grounds Supervisor") will be displayed, and not the former Contract 

("Groundskeeper"). 

TimeKeeper-PC can keep track of up to five Contracts per Employee, whether expired, current, or 
future. 

If you enter a date in the future as the Valid From date, that information will be saved when you 
save the Employee Profile. However, only the current Contract will be displayed in the Contract 
field. 

 In the example above, if you enter a date six months from now for the new Contract, then the former 

Contract ("Groundskeeper") will continue to be displayed until that future date. After six months, the 

Employee Profile will be updated automatically to display the new Contract ("Grounds Supervisor"). 

For Help using date formats, click here 

To Choose an Employee's Contract 

1. Choose Add/Edit Employee Profile from the Activities menu. The Employee Master File is displayed. 

2. Choose the Employee whose Badge number is to be edited. For Help choosing an Employee, click here. 

3. Click the drop-down arrow next to the Contract field to open a list of Contracts sorted by number. The currently 
selected Contract will be displayed as a raised gray button with white characters. 

4. Use the vertical scroll bar on the right to scroll up and down the list. 

5. To choose a Contract, click anywhere on that Contract's line. The drop-down list will close, and the number of the 
selected Contract will be displayed in the Contract field. The name of the selected Contract will be displayed below 
the Contract field. 

To Enter a Date in the Valid From Field 

1. Double-click the Valid From field. 

2. Enter the beginning date of the Contract displayed in the Contract field. 

 Enter August 15th, 1996 as "08151996" for a U.S. date, or 15081996 for an International date. The field will 

automatically add the slashes to display "08/15/1996" or "15/08/1996". 

You can also use the More button to edit and view Contracts and their Valid From dates. For Help 
using the More button, click here. 

General Tab -- Contract -- More Button 

If the Employee has been assigned to only one Contract during employment, the word "More" will 
be displayed in black characters. If the Employee has been assigned to more than one Contract 
during employment, the word "More" will be displayed in red characters. 

Click the More button below the Valid From field to open the Contracts dialog box. A list of 
Contracts and their Valid From dates will be displayed: 
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The Contracts dialog box displays each Contract's Number and Valid From date. A Contract is 
valid until the Valid From date of the next Contract, or until the Employee's termination date. 

 In the example above, Contract Number 100 is valid for all of 1996, and Contract 102 is valid for the first six 

months of 1997. If the current date is March 10, 1997, then Contract 102 is valid and will be displayed in the 

Contract field. 

You can enter a new Contract and its Valid From date. The new Contract will be valid until the 
Valid From date of the following Contract. The preceding Contract will be valid until the Valid From 
date of the new Contract. For Help entering a new Contract for an Employee, click here. 

 In the example above, you can add Contract Number 101 to be valid from June 30, 1996. In that case, 

Contract 100 will be valid for the first six months of 1996, and Contract 101 will be valid for the last six 

months of 1996. 

There are only five rows in the Contracts dialog box. If all five rows are filled, you can enter a new 
Contract only by replacing one of the current Contracts. Once you change a current Contract 
Number and Valid From date and save the Employee Profile, the former information will be lost. 

You can change the Contract for a particular Valid From date. For Help changing the Contract for 
a Valid From date, click here. 

 In the example above, you can change Contract 100 to Contract 105. In that case, Contract 105 will be valid 

for all of 1996. 

You can change the Valid From date for a particular Contract. For Help changing the Valid From 
date for a Contract, click here. 

 In the example above, you can change the Valid From date for Contract 103 to 09/30/1997. In that case, 

Contract 102 will remain valid for the first nine months of 1997. 

You can delete a Contract from the list. For Help deleting a Contract for an Employee, click here. 

 Once you delete a Contract for an Employee and save the Employee Profile, that information will be lost. 

 In the example above, you can delete Contract 103 from the list. In that case, Contract 102 will be valid for 

all of 1997. If you delete Contract 100, the Employee will have no valid Contract until the beginning of 1997. 

To Change the Contract for a Valid From Date 

1. Click the More button below the Valid From field. The Contracts dialog box will open. 

2. In the Number column, click the Contract Number you want to change. The Number will be highlighted, and a drop-
down arrow will appear in the field. 

 When you open the Contracts dialog box, the first Contract Number will already be highlighted. If you want 

to change that Contract, do not click it. 

3. Either type in the new Contract Number for that Valid From date, or click the drop-down arrow to open a list of 
Contracts sorted by number. The currently selected Contract will be displayed as a raised gray button with white 
characters. 
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4. Use the vertical scroll bar on the right to scroll up and down the list. 

5. To choose a Contract, click anywhere on that Contract's line. The drop-down list will close, and the selected Contract 
Number will be displayed in the Number column. 

6. Click Close to close the Contract dialog box. 

To Change the Valid From Date for a Contract 

1. Click the More button below the Valid From field. The Contracts dialog box will open. 

2. In the Valid From column, click to the right of the date you want to change. The date will be highlighted. 

3. Enter the new Valid From date for that Contract. 

 Enter August 15th, 1996 as "08151996" for a U.S. date, or 15081996 for an International date. The field will 

automatically add the slashes to display "08/15/1996" or "15/08/1996". 

4. Click Close to close the Contract dialog box. 

To Enter a New Contract for an Employee 

1. Click the More button below the Valid From field. The Contracts dialog box will open. 

2. Click the first blank field in the Number Column. A drop-down arrow will appear in the field. 

3. Either type in the new Contract Number, or click the drop-down arrow to open a list of Contracts sorted by number. 
The first Contract on the list will be displayed as a raised gray button with white characters. 

4. Use the vertical scroll bar on the right to scroll up and down the list. 

5. To choose a Contract, click anywhere on that Contract's line. The drop-down list will close, and the selected Contract 
Number will be displayed in the Number column. 

6. In the Valid From column, click the field to the right of the new Contract Number. 

7. Enter the Valid From date for the new Contract Number. 

 Enter August 15th, 1996 as "08151996" for a U.S. date, or 15081996 for an International date. The field will 

automatically add the slashes to display "08/15/1996" or "15/08/1996". 

8. Click Close to close the Contract dialog box. 

To Delete a Contract for an Employee 

1. Click the More button below the Valid From field. The Contracts dialog box will open. 

2. In the Number column, click the Contract Number you want to delete. The Number will be highlighted, and a drop-
down arrow will appear in the field. 

 When you open the Contracts dialog box, the first Contract Number will already be highlighted. If you want 

to delete that Contract, do not click it. 

3. Press <Delete>. 

4. Click Close to close the Contract dialog box. 

What Happens When TimeKeeper-PC Polls 

Clocks? 

When TimeKeeper-PC polls clocks, whether automatically or by user demand, the Create Daily 
File window opens. Progress of Daily File creation is marked by a blue bar which fills across a 
scale in the window. Titles above the bar indicate the stages of Daily File creation: 

Building the Daily Activity File 

TimeKeeper-PC checks if Daily Activity Files already exist for the dates being polled. If they do 
not, TimeKeeper-PC creates them. 

Complementing the Daily Activity File 
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TimeKeeper-PC checks if empty Records already exist for the Employees and dates being polled. 
If they do not, TimeKeeper-PC creates them. TimeKeeper-PC  then enters the information being 
polled into the appropriate Records. 

Polling creates empty Records only for Employees with the Absence Code "0 Active" (or "Regular 
Work Day") for that day. Polling does not create empty Records for Employees with the Absence 
Code “98 Optional Work Day”, unless they have a polled transaction on that day. 

Evaluating the Daily Activity File 

TimeKeeper-PC calculates all Records in the Daily Activity Files for the dates being polled. For 
Help calculating TC Records, click here. 

 TimeKeeper-PC will calculate a Record even if you are working on it at the time that the transaction is 

polled. 

When TimeKeeper-PC finishes polling clocks, the Create Daily File window closes. 

Reading Backup Punch Files 

Choose Read Backup Punch File (either TK or Clock Format) from the Activities menu to open 
the Read Backup Punch File dialog box: 

 

Input File Name 

This field displays the name and location of a file to be read. When you open the Read Backup 
Punch File dialog box, this field will display the default location (as defined in TimeKeeper-PC 
Setup) for backup files created by polling. You can read one file by entering its name and location 
in this field. 

If you do not know the backup punch file's name and location, click Browse. For Help using the 
Browse button, click here. 

TimeKeeper-PC can read more than one file at a time. You need to use the Browse button to 
select more than one file. If more than one file is selected, the Input File Name field will display the 
file name TEMPOUT.000. 

You can also use the Browse button to view the contents of a file. 

Date 

A backup punch file can contain transactions from a number of days. For Help using date formats, 
click here. 
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All dates between the From and To dates will be polled. 

Badge Number 

Usually, employees are assigned badges (magnetic stripe, bar code, or proximity) to enable them 
to "punch" an electronic time clock. Each badge has a unique identification number, and every 
Employee must have a Badge Number. You can use the Badge Number History dialog box to 
view a list of Employees sorted by Badge Number. For Help using Badge Number History to check 
Badge Numbers, click here. 

All Badges between the first and last numbers will be polled. 

Clock Number 

TimeKeeper-PC can poll punch data from up to 99 clocks, and each clock has a unique 
identification number. 

All Clocks between the first and last numbers will be polled. 

Icons 

 Click the Help icon for Help reading backup punch files. 

 Click the Run Program icon to read backup punch files according to the parameters 
chosen. 

 Click the Exit icon to close the Daily Browser. 

 This green exit door icon is used to close the dialog box. Only the red exit door on the Main Tool Bar exits 

the TimeKeeper-PC program. 

To Read Backup Punch Files 

1. Choose the files to be read. 

2. Choose either Read Backup Punch File (TK Format) or Read Backup Punch File (Clock Format) from the Activities 
menu. The Read Backup Punch File dialog box will open. 

3. Double-click the Date From field and enter the first date to be polled. Double-click the Date To field and enter the last 
date to be polled. 

4. Double-click the Badge Number From field and enter the first Badge Number to be polled. Double-click the Badge 
Number To field and enter the last Badge Number to be polled. 

5. Double-click the Clock Number From field and enter the first Clock Number to be polled. Double-click the Clock 
Number To field and enter the last Clock Number to be polled. 

6. Click the Run Program icon to read backup punch files according to the parameters chosen. 

What happens when TimeKeeper-PC Reads Backup Punch Files? 

Input File Name -- Browse Button 

If you do not know the correct name and location, click Browse to search for the backup punch 
file, and the Select Backup Punch File dialog box will open: 
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File Location 

The Drives field on the bottom left displays the drive currently selected. You can choose a 
different drive by clicking the drop-down arrow in this field to open a list of drives. 

The name of the directory currently selected is displayed under the title Directories. 

The path of the directory currently selected is displayed in the large Directories panel on the 
bottom right. The name of the directory currently selected is highlighted in this panel. 

 In the example above, the path indicates that the directory currently selected, trback, is a sub-directory of 

data, which is a sub-directory of tk5win, which is a directory in the c:\ drive. 

Double-click any level of the path to open a list of directories on the level below. 

 You can double-click the c:\ drive to open a list of all directories of c:\. You can also double-click the 

tk5win directory to open a list of all sub-directories of tk5win. 

Click to select any directory on the path displayed. The selected directory will be highlighted, and 
its name will be displayed under the title Directories. 

File Name 

The files contained in the directory currently selected are displayed in the large Files panel on the 
left. When you use the up and down arrows to scroll through file names, the name of the file 
currently outlined is displayed below this panel, along with the date and time it was created. 

 In the example above, the currently outlined file tr020797.025 was created on July 2, 1997. 

Click to select a file. The selected file will be highlighted, and the number of files selected will be 
displayed below the panel instead of a file name. Click to deselect a selected file. The file most 
recently selected or deselected will be outlined, whether or not it is selected. 

 In the example above, if you click to select the file, the words "1 File Selected" will be displayed in place of 

the file name and its creation time and date. If you click the same file again to deselect it, it will be outlined 

but not highlighted, and its name and creation time and date will be displayed again. 

You can select more than one file. The number of files selected will be displayed below the panel. 

Click View to view the contents of the file outlined in the Files panel. For Help viewing a backup 
punch file, click here. 
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When the desired file names are displayed in the left-hand panel, click OK to close the dialog box. 
Click the Run Program icon in the Read Backup Punch File dialog box to read the selected 
backup punch files. 

To Use the Browse Button to Select Backup Punch Files 

1. Click Browse. The Select Backup Punch File dialog box will open. 

2. Click the drop-down arrow in the Drives field to open a list of drives. 

3. Click to select a drive. The drop-down list will close, and the selected drive will be displayed in the Drives field. 

4. Click to select a directory from the path in the Directories panel. The selected directory will be highlighted, and its 
name will be displayed under the title Directories. 

5. Click each file you want to select from the Files panel. 

6. When you finish choosing files, click OK to close the dialog box. 

Viewing a Backup Punch File 

Click View to open the View Backup Punch File window. The file will be displayed in text format, 
with a separate line for each transaction: 

1100006190000024-06-970011238B 
1100002020000024-06-970011250E 
1100001910000024-06-970011253B 
1100002020000024-06-970011300B 
1100003520000024-06-970011338B 

1100002350000024-06-970011352E 

The letter "B" (for "Begin") indicates an In punch. The letter "E" (for "End") indicates an Out punch. 
Other data indicates Employee Number, Clock Number, date and time, and so on. 

For example, here is how the first two lines of data above would appear in the Daily Browser: 

 

The View Backup Punch File window displays the file most recently selected or deselected in the 
Select Backup Punch File dialog box. This file is outlined in the Files panel, whether or not it is 
selected. 

 You can click to select the file tr020797.025, click to select tr030697.016, and then click to deselect 

tr020797.025. The View Backup Punch File window will display the deselected file tr020797.025 and not the 

selected file, since the deselected file was the last one clicked. 

The percent of the file currently being viewed is displayed in the upper right corner of the window. 

Click PgUp and PgDn to scroll up and down through the file. 

Choose Exit from the File menu to close the window. 

Badge Number History -- Viewing a List Of 

Employees 

Usually, employees are assigned badges (magnetic stripe, bar code, or proximity) to enable them 
to "punch" an electronic time clock. Each badge has a unique idntification number, and every 
Employee must have a Badge Number. You can use the Badge Number History dialog box to 
view a list of Employees sorted by Badge Number. 
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When you choose Add/Edit Employee Profile from the Activities menu, the Employees File 
Cabinet is displayed instead of the Main Tool Bar, and the Employee Master File is displayed 
below the Employees File Cabinet: 

  

To View Badge Numbers with the Badge Number History Dialog Box 

1. Choose Add/Edit Employee Profile from the Activities menu. The Employees File Cabinet will be displayed instead of 
the Main Tool Bar, and the Employee Master File will be displayed below the Employees File Cabinet. 

2. Click the Badges yellow file tab in the Employee File Cabinet. The Badges dialog box will open. 

3. Click the Browse button in the Tool Bar at the bottom of the dialog box: 

 

4. A list of Badge Numbers and their corresponding Employees will be displayed. Use the vertical scroll bar on the right 
to scroll up and down the list. 

5. Click the Exit icon to close the Badges dialog box: 

 

6. Click the Exit icon to close the Employee Master File. 

7. Click the Close File Cabinet icon next to the Employees File Cabinet to close the Employees File Cabinet and display 
the Main Tool Bar again: 

 

What Happens When TimeKeeper-PC Reads 

Backup Punch Files? 

When TimeKeeper-PC reads backup punch files, the Punch Retrieval/Create Daily File window 
opens. Progress of punch retrieval and processing is marked by a blue bar which fills across a 
scale in the window. Titles above the bar indicate the stages of punch retrieval and processing: 

Reading Clock File 

TimeKeeper-PC reads, sorts, and backs up the transactions in the backup punch files. 

Reading Transerr.txt File 

TimeKeeper-PC reads invalid punches from previous time input data. For Help viewing and 
editing invalid punches, click here. 

Reading Trans.txt File 
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TimeKeeper-PC checks if the new backup punch files correct any of the previous invalid punches. 
TimeKeeper-PC creates a new transerr.txt file containing new invalid punches and uncorrected, 
old invalid punches. 

Evaluating Daily Record 

TimeKeeper-PC calculates all Records in the Daily Activity Files for the dates being polled. For 
Help calculating Records, click here. 

 TimeKeeper-PC will calculate a Record even if you are working on it at the time that the transaction is 

polled. 

When TimeKeeper-PC finishes reading backup punch files, the Create Daily File window closes. 

Choosing Fonts for Reports 

Choose Fonts to choose font types and sizes for the various sections of the report. 

Choose Fonts to open the Fonts dialog box. You can choose fonts for four different kinds of text in 
the report: 

Standard Font 

This is the font used in most of the report body, except as noted below. 

Emphasized Font 

This is the font used in the columns defined in the Report Image File as Emphasized. The default 
is the Standard Font in bold. 

 In the Errors & Exceptions Report, the Errors & Exceptions message column uses the Emphasized Font. 

Large Font 

This is the font used in the Report Header to display the User Name. The default is the Standard 
Font in bold, increased by one font size. 

Small Font 

This is the font used in the Report Footer to display the Footer text and copyright information 
regarding TimeKeeper-PC. The default is the Standard Font in italic. 

The options you choose for fonts will determine how they are displayed when you send the report 
to the Screen or to the Print Preview. If you are using a color printer, you can use the Fonts dialog 
box to choose colors for the various sections of your report. You would then use the Print Setup 
option to choose color printing. For Help using Print Setup, click here. 

 If you are using a color printer, you can first use the Fonts dialog box to choose a red font for the 

Emphasized Font. You can then use Print Setup to set your printer for color printing. 

The default values for fonts, which are set in your system configuration, have been chosen for 
maximum clarity and ease of reading. 

To Change a Font 

1. Choose Fonts from the File Menu in the Report Menu Bar. The Fonts dialog box will open. 

2. From the list of four fonts, choose the one you want to change . 

3. Click Change. The Windows Font dialog box will open with the current default options. 
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4. Choose options for Font, Font Style, Size, Effect, and Script. Click OK. 

 When entering data in a dialog box, you can press <Tab> to move forward to the next field and select it. 

Hold <Shift> and press <Tab> to move backward to the previous field and select it. 

5. Repeat steps 2-4 for any other fonts you want to change. 

6. After you finish changing fonts, click Close to close the dialog box. The changes you have made will take effect only 
after you close the dialog box, and will affect only the current report. The Standard Font settings you have chosen will 
be displayed at the bottom right of each page of the current report. 

Print Setup for Reports 

Choose Print Setup to choose print options such as paper size and orientation. Choose this option 
only if you choose Send Report To Printer in the Output Options dialog box. 

The Print Setup dialog box which is displayed will vary according to your Windows setup and 
printer type. However, certain features are common to all Print Setup dialog boxes: 

Printer 

The dialog box will indicate a list of printers to choose from. One of them will be selected as the 
Default Printer. When you print a report, TimeKeeper-PC will send the report to be printed on the 
Default Printer. Click a printer on the list of available printers to make that printer the Default 
Printer. If the printer you want to use is currently selected, you do not need to change this setting. 

Document Orientation 

The two options are Portrait (the page is taller than it is wide) or Landscape (the page is wider 
than it is tall). 

 You can allow especially wide reports to be printed in Landscape orientation. 

Paper Size 

Choose the size of paper currently loaded in the selected printer. 

Black-and-White/Color 

If you are using a color printer, you can print in black-and-white or in color. If you print in color, you 
can first use the Fonts dialog box to choose colors for the various sections of your report. For 
Help choosing fonts, click here. 

 If you are using a color printer, you can first use the Fonts dialog box to choose a red font for the 

Emphasized Font. You can then use Print Setup to set your printer for color printing. 

To Choose Print Options 

1. Choose Print Setup from the File Menu in the Report Menu Bar. The Print Setup dialog box will open. 

2. Choose Options for Default Printer, Document Orientation, Paper Size, and any other options your printer offers. 

 When entering data in a dialog box, you can press <Tab> to move forward to the next field and select it. 

Hold <Shift> and press <Tab> to move backward to the previous field and select it. 

3. Click OK. 

Setting Character Width 
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Choose Set Char. Width to change the width of letters and numbers in a report. This allows you to 
display information as clearly as possible on a single page. 

If part of a report is cut off on the edge of a screen or page, then the characters are too wide. To 
correct this, lower the "percent" value for character width. 

If numbers or letters are so crowded together that they are only partially visible (as in the example 
below), the characters are too narrow. To correct this, raise the "percent" value for character 
width. 

 

Choose Set Char. Width to open the Percents dialog box. The current value is displayed above 
the sliding bar. The left end of the bar is 0%, the smallest possible character width. The right end 
of the bar is 100%, the largest possible character width. 

You can change the Percents setting by clicking the left and right arrows at the ends of the bar. 
Each click raises or lowers the setting by one percent. Click and hold the arrow to scroll across 
the bar. You can also use the mouse to drag the box across the bar and drop it in place. 

You can test the new Percents setting by choosing Print Preview from the Output Options dialog 
box. 

The default value for Percents, which is set in your system configuration, is based on the 
experience of other TimeKeeper-PC users. 

To Change the Width of Characters 

1. Choose Set Char. Width from the File Menu in the Report Menu Bar. The Percents dialog box will open with the 
current default value. 

2. To lower the Percents setting (if part of the report is cut off), click or hold the left arrow, or use the mouse to drag the 
box to the left. 

3. To raise the Percents setting (if report characters are too crowded together), click or hold the right arrow, or use the 
mouse to drag the box to the right. 

4. When you reach the desired setting, click OK to close the Percents dialog box. The setting you have chosen will be 
displayed at the bottom right of each page of the report. 

Choosing Report Dates 

The Report Date Menu determines the dates to be included in the report. The dates you choose 
will be displayed in the top panel of the Report Parameters box. 

The Select option allows you to choose dates based on a calendar, and applies only to the current 
run of the program. For Help choosing dates with the Select option, click here. 

The Default option allows you to choose dates based on their proximity to the current date, and 
can be saved for future use. For Help choosing dates with the Default option, click here. 

 The Save option in the Report File Menu saves your changes to the Default value, but not to the Select 

value. 

Choosing Dates with the Select Option 
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The Select option allows you to choose dates based on a calendar. Choose Select from the 
Report Date Menu to open the Date dialog box. The From date is the first date included in the 
report. The To date is the last date included in the report. 

You can choose dates in any of three ways: 

 by typing dates into the From and To fields 

 by using the up and down arrows next to the From and To fields 

 by using a graphic calendar display (the Calendar) 

Choosing Dates by Typing Them in 

You can choose dates by typing them into the From and To fields. 

For Help using date formats, click here. 

To Choose Dates by Typing Them In 

1. Choose Select from the Date Menu in the Report Menu Bar. The Date dialog box will open. 

2. Double-click the From field. 

3. Enter the beginning date of the report. 

 Enter August 15th, 1996 as "08151996" for a U.S. date, or 15081996 for an International date. The field will 

automatically add the slashes to display "08/15/1996" or "15/08/1996". 

4. Repeat steps 2-3 to enter the ending date of the report in the To field. 

 When you double-click the To field, the date in the From field will be entered there automatically. If you 

want to produce a report for one day only, there is no need to enter the date again. 

5. After you enter the desired dates, click OK to close the Date dialog box. The dates you have chosen will be displayed 
in the top panel of the Report Parameters box. 

Choosing Dates with the Up and Down Arrows 

You can choose dates by clicking the up and down arrows next to the From and To fields. Each 
click up or down changes the date by one day. Click and hold the arrow to scroll through dates. 

To Choose Dates with the Up and Down Arrows 

1. Choose Select from the Date Menu in the Report Menu Bar. The Date dialog box will open. 

2. To set the From date for earlier, click or hold the down arrow next to the From field. 

3. To set the From date for later, click or hold the up arrow next to the From field. 

4. Repeat steps 2-3 to choose the To date. 

5. When you reach the desired dates, click OK to close the Date dialog box. The dates you have chosen will be 
displayed in the top panel of the Report Parameters box. 

Choosing Dates with the Calendar 

TimeKeeper-PC's Calendar dialog box allows you to choose dates from a convenient graphic 
calendar display. Click Calendar in the Date dialog box to open the Calendar dialog box: 
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To Choose Dates with the Calendar Dialog Box 

1. Choose Select from the Date Menu in the Report Menu Bar. The Date dialog box will open. 

2. Click the From field. 

3. Click Calendar. The Calendar dialog box will open, displaying the current year, month, and date. In the Date dialog 
box in the background, the From date will change from black to red. 

 If you change the values in the Date dialog box before clicking Calendar, the Calendar will display the new 

values you have chosen. 

4. On the bar displaying the current year, click the arrow to the left for the preceding year, or the arrow to the right for 
the following year. The display will change by one year with each click. 

5. On the bar displaying the current month, click the arrow to the left for the preceding month, or the arrow to the right 
for the following month. The display will change by one month with each click. 

6. On the calendar display in the center of the dialog box, click the desired date. The selected date will be displayed as 
a raised gray button with a blue number. 

7. When the desired date is displayed, click OK to close the Calendar dialog box. In the Date dialog box, the From date 
will change from red to black, and the same date will now be displayed as the To date. 

8. Repeat steps 2-7 to choose the To date. If you want to produce a report for one day only, there is no need to repeat 
these steps. 

9. When the desired dates are displayed, click OK to close the Date dialog box. The dates you have chosen will be 
displayed in the top panel of the Report Parameters box. 

Choosing Dates with the Default Option 

The Default option allows you to choose dates based on their proximity to the current date. This 
allows you to always produce reports with the same relationship to the current date. 

 If the Default From value is -7, then the report will always include dates beginning one week before the day 

the report is produced. 

Choose Default from the Report Date Menu to open the Date dialog box. In the Date dialog box, 
the From and To dates are displayed relative to the current date. A negative number shows the 
number of days before the current date, and a positive number shows the number of days after 
the current date. 
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 If the report is produced on August 5th with a From value of -1 and a To value of 20, it will include dates 

from August 4th to August 25th. 

You can change the Default Date values by double-clicking the current From and To dates and 
typing in new values. 

You can also change the Default Date values by clicking the arrows next to the From and To 
dates. Click the up arrow to raise the value by one. Click the down arrow to lower the value by 
one. Click and hold the arrow to scroll through values. 

To Choose Dates by Typing in Default Values 

1. Choose Default from the Date menu in the Report Menu Bar. The Date dialog box will open. 

2. Double-click the From field and enter a new value. 

3. Double-click the To field and enter a new value. 

4. After you enter the desired values, click OK to close the Date dialog box. The dates you have chosen will be 
displayed in the top panel of the Report Parameters box, based on their proximity to the current date. 

To Choose Dates by Choosing Default Values with the Up and Down Arrows 

1. Choose Default from the Date menu in the Report Menu Bar. The Date dialog box will open. 

2. Click the From field. 

3. To set the From value higher, click or hold the up arrow next to the From field. 

4. To set the From value lower, click or hold the down arrow next to the From field. 

5. Repeat steps 3-4 to choose the To value. 

6. After you enter the desired values, click OK to close the Date dialog box. The dates you have chosen will be 
displayed in the top panel of the Report Parameters box, based on their proximity to the current date. 

Choosing Report Ranges 

Each item on the left panel of the Report Parameters box corresponds to a menu on the Report 
Menu Bar. These determine the ranges of data included in the report. These parameters can 
include levels of your organization, such as Departments. They can also include data specific to 
the Employee, such as Seniority. 

Not every report includes the same parameters. This is reflected by the available menus on the 
Report Menu Bar. 

 The Errors & Exceptions Report includes data according to Plant, Site, Department, and Employee. In that 

report's dialog box, those four menus are displayed to the right of the Date menu. 

 You can use a synonym for any level of your organization. 

TimeKeeper-PC's system configuration can restrict a user's access to data for the various levels 
of your organization. These restrictions apply regardless of how you set Report Ranges. 

 If you are restricted by the system configuration to data for Plants 1-15, then even if you choose All Plants, 

your report will include only Plants 1-15. 

You can only choose elements on a level of your organization which are included in the range you 
set for the levels above. 

 If you set the range of Sites from 1 to 25, then you can only produce a report on the Departments assigned 

to those Sites. Even if you choose All Departments, your report will include only the Departments assigned 

to Sites 1-25. 
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All Report Range menus have three options: All, Select, and Default. 

 The Save option in the Report File Menu saves your changes to the Default value, but not to the Select 

value. 

Choosing Report Ranges with the All Option 

Choose All to include all input data from a selected level of your organization. 

 To include data on all of your Employees in the selected Departments, choose All from the Employees 

menu on the Report Menu Bar. 

The Select option allows you to choose individual elements for a report parameter. For Help 
choosing Report Ranges with the Select option, click here. 

The Default option allows you to choose a numbered range of elements for a report parameter. 
For Help choosing Report Ranges with the Default option, click here. 

Choosing Report Ranges with the Select Option 

Choose Select to include input data from selected elements within a report parameter. A dialog 
box will open with the title and information corresponding to that menu. 

Selected elements will be displayed in dark gray boxes with white characters. Use the vertical 
scroll bar on the right-hand side of the dialog box to scroll through the list of elements and find 
those selected. 

To select an element, click anywhere on that element's line, and it will be added to the range of 
values covered by the report. You can select as many elements as you want, one at a time. 

To deselect an element that is currently selected, click anywhere on that element's line, and it will 
be removed from the range of values covered by the report. 

You can also click Deselect All to deselect all elements, or click Select All to select all elements. 

 When several Employees are currently selected, clicking Deselect All is the fastest way to clear all 

selections and begin again. 

If no elements are selected, the range for that parameter will return automatically to the default 
value. If any elements are selected, the Report Parameters box will display the total number of 
elements selected, but not their individual numbers. 

 The Save option in the Report File Menu saves your changes to the Default value, but not to the Select 

value. 

To Choose Elements from a Report Range Menu 

1. Choose the desired menu on the Report Menu Bar. 

2. Choose Select. The corresponding dialog box for that range menu will be displayed. 

3. Click each of the elements you want to select, or click Select All to select all elements. 

4. Click each of the selected elements you want to deselect, or click Deselect All to deselect all elements. 

5. After you select the desired elements, click OK to close the dialog box. The total number of selected elements for 
that parameter will be displayed in the Report Parameters box. If you have deselected all elements, the default range 
for that parameter will be displayed in the Report Parameters box. 

Choosing Report Ranges with the Default Option 
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Choose Default to include input data from a range of elements within a report parameter. A dialog 
box will open with the title and information corresponding to that menu. 

The From and To values indicate the range of elements within that parameter to be covered by 
the report. 

 If the Plants default dialog box has a From value of 1 and a To value of 45, Plants 1 through 45 will be 

included in the report. 

 The Save option in the Report File Menu saves your changes to the Default value, but not to the Select 

value. 

To Change the Default Values for a Report Range Menu 

1. Choose the desired menu on the Report Menu Bar. 

2. Choose Default. The corresponding dialog box for that range menu will be displayed. 

3. Double-click the From field and enter a new value. 

4. Double-click the To field and enter a new value. 

5. After you enter the desired values, click OK to close the dialog box. The range of values you have chosen for that 
parameter will be displayed in the Report Parameters box. 

You can configure TimeKeeper-PC to use synonyms of your own choosing for any level of your 
organization. All reports, menus, and dialog boxes will use the synonyms you choose. For Help 
using TimeKeeper Set-Up to create synonyms, click here. 

 If you refer to Plants by the synonym "Companies", then a Company file tab will be displayed in place of the 

Plant file tab in the Employees File Cabinet. 

The Select option allows you to choose specific report dates or specific elements of report 
parameters. 

The Default option allows you to choose a range of dates based on their proximity to the current 
date, or numbered ranges of elements of report parameters. 

Report Tool Bar 

The following icons are displayed on the Report Tool Bar: 

 Click the Fonts icon to choose font names and sizes for the various sections of the Report. 

 Click the Percents icon to change the width of letters and numbers in a report.  

 Click the Save icon to save your changes to the settings in the Report Menu options.  

 Click the Print Setup icon to choose print options such as paper size and orientation. 

 Click the Start Report icon to produce a report according to the parameters you have chosen. 

 Click the Exit icon to close the Report dialog box. 

 This green exit door icon is used to close the dialog box. Only the red exit door on the Main Tool Bar exits 

the TimeKeeper-PC program. 
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Reading the Screen Display of a Report 

The screen display of a report, like the Print Preview, displays the report exactly as it would 
appear in a printer output. However, the screen display also offers several functions which make it 
possible to fully read and interpret a report without having to print it out. 

When you send a report to the screen, the Screen Menu Bar and the Screen Tool Bar are 
displayed above the report. 

The following options are available in the Screen menus. The corresponding icons next to the 
option descriptions are displayed on the Screen Tool Bar. 

File 

 Exit: Choose this option to close the screen display and return to the Report dialog box. 

Search 

 Find Text: Choose this option to open the Search dialog box. For Help filling in the Search 
dialog box, click here. You can also choose this option by pressing <F2>. 

 Find Again: Choose this option to find the next example of the string of text most recently 
searched for. You can also choose this option by pressing <F3>. 

 The Find Again option will not be available for a string of text after you search for it unsuccessfully. 

Report 

 First Page: Choose this option to go to the first page of a report. 

 Prev Page: Choose this option to go to the previous page of a report. 

 Next Page: Choose this option to go to the next page of a report. 

 Last Page: Choose this option to go to the last page of a report. 

To Fill in the Search Dialog Box 

1. Enter the text string you want to search for in the long white field. The search is case-sensitive, which means that you 
must enter upper-case and lower-case characters exactly as they will appear in the string. 

2. Click the check box for From This Page to search only from the current page until the end of the document. If this box 
is left blank, TimeKeeper-PC will search the entire report. 

 If you are on page 181 of a 200-page report, you can check this box to search for a string in the last 20 

pages only. This can be much faster than searching the entire report. 

3. Click Find to search for the string, or Cancel to cancel the search. 

An Absence Code indicates an Employee's work status. Typically, this value will be 0 for "Active". 
If an Employee goes on Paid Vacation for a month, that month can be marked with the Absence 
Code for Paid Vacation. 

Choosing Departments for the Daily Browser 



  150 

The Selection Type options are displayed at the top of the Select Range to Edit dialog box. Click 
one of the three options to choose it. A dot will appear in the circle next to the option you choose. 
Only one option can be chosen at a time. 

All 

Choose this option to open the Daily Browser for all Departments. 

By Number 

Choose this option to open the Daily Browser for a single Department. 

To Choose a Department by Number 

1. Click By Number. The Number and Name fields will open in the center of the Select Range to Edit dialog box. 

2. Click the drop-down arrow next to the Number field to open a list of Departments sorted by number. The currently 
selected Department will be displayed as a raised gray button with white characters. If no Department has been 
chosen yet, the first Department on the list will be selected. 

3. Use the vertical scroll bar on the right to scroll up and down the list. 

4. To choose a Department, click anywhere on that Department's line. The drop-down list will close, and the number of 
the selected Department will be displayed in the Number field. The name of the selected Department will be 
displayed in the Name field. 

 You cannot edit the Name field, which displays the corresponding name for the Department number you 

have chosen. 

5. You can also choose a Department by entering its number in the Number field. The corresponding name will be 
displayed in the Name field only after you click another field or button in the dialog box. 

Selection 

Choose this option to open the Daily Browser for a selection of Departments. 

Click Selection to open a dialog box with a list of Departments sorted by number. Selected 
Departments will be displayed in dark gray boxes with white characters. 

To select a Department, click anywhere on that Department's line, and it will be added to the 
range of Departments covered by the Daily Browser. You can select as many Departments as you 
want, one at a time. 

To deselect a Department that is currently selected, click anywhere on that Department's line, and 
it will be removed from the range of Departments covered by the Daily Browser. 

To Choose a Selection of Departments 

1. Click Selection. A dialog box will open with a list of Departments sorted by number. Selected Departments will be 
displayed in dark gray boxes with white characters. 

2. Click each of the Departments you want to select. 

3. Click each of the selected Departments you want to deselect. 

Choosing a Date for the Daily Browser 

You can choose a date for the Daily Browser either by typing it in, or by choosing it from a 
convenient graphic calendar display. 

To choose a date by typing it in, click the Date to Search field and enter the date. For Help using 
date formats, click here. 

To choose a date with the Calendar, click the Calendar icon:  

The Calendar dialog box will open: 
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To Choose a Date with the Calendar Dialog Box 

1. Click the Calendar icon. The Calendar dialog box will open, displaying the current year, month, and date. In the 
Select Range to Edit dialog box in the background, the Date to Search will change from black to red. 

 If you change the values in the Select Range to Edit dialog box before clicking the Calendar icon, the 

Calendar will display the new values you have chosen. 

2. On the bar displaying the current year, click the arrow to the left for the preceding year, or the arrow to the right for 
the following year. The display will change by one year with each click. 

3. On the bar displaying the current month, click the arrow to the left for the preceding month, or the arrow to the right 
for the following month. The display will change by one month with each click. 

4. On the calendar display in the center of the dialog box, click the desired date. The selected date will be displayed as 
a raised gray button with a blue number. 

5. When the desired date is displayed, click OK to close the Calendar dialog box. In the Select Range to Edit dialog 
box, the Date to Search will change from red to black. 

Refreshing Data 

The Daily Activity File can be edited and viewed simultaneously by multiple users. The Refresh 
Data command updates the Daily Activity File with the newest data from all sources. 

 If you edit Frank Foreman's Daily Record at the same time that an operator at another workstation is editing 

Sara Smith's Daily Record, you can refresh data to view the latest data for both Employees. 

When you make any change in a Record, it will be flagged for recalculation and displayed in red 
characters until you save or calculate the Record. However, a Record changed by the Refresh 
Data command will not be displayed in red characters unless the changed version has an Error, 
since data entered with that command has already been saved and calculated. 

Your unsaved changes to the Daily Activity File are not included in the sources used by the 
Refresh Data command. If you try to refresh data when you have made changes to the Daily 
Activity File but not yet saved them, you will be prompted by a small dialog box: "Current Record 
Has Been Changed! Save?" 

 If you want to save the changes you have made to the Daily Activity File and then refresh data, click Yes. 

 If you want to refresh data without saving the changes you have made to the Daily Activity File, click No. 

 If you want to continue editing the Daily Activity File without refreshing data, click Cancel. 
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To refresh data, choose Refresh Data from the File menu, press <F8>, or click the Refresh Data 
icon: 

 

Saving Records 

To save a record, choose Save Current Record from the Record menu, or click the Save Record 
to File icon: 

 

You will be prompted by a small dialog box: "Current Record Has Been Changed! Save?" Click 
Yes. 

Audit Trails 

What Is It? 

An Audit Trail is a line of text associated with a Record. When the Audit Trail function is enabled, 
you must add an Audit Trail for all changes made in the relevant fields. 

 If you have enabled Audit Trails for Contract Numbers, then you must add an Audit Trail every time you 

change an Employee's Contract Number. 

An Audit Trail can specify the reason for a change made in a Record, the name of the supervisor 
making a change, or any other text relevant to the Record. 

You can choose a standard reason (called a Justification) from a predefined list. You can define 
your own reason by entering a line of text. 

Audit Trail parameters and Justifications are defined in TimeKeeper-PC Set-Up. For Help defining 
Audit Trail parameters and Justifications, click here. 

 You do not need to save or calculate a Record to add an Audit Trail. 

How Do I Use It? 

When the Audit Trail function is enabled, the Audit Reason dialog box will open every time you 
change a Record and either press <Return> or move to another Record: 
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The Audit Reason dialog box displays the following information: 

 The file in which the change was made (i.e., the Daily Browser file) 

 The field in which the change was made 

 The old value for that field 

 The new value for that field 

 A list of standard reasons (Justifications) 

To Add an Audit Trail to a Record 

1. Click any standard reason to display that reason in the User Defined Reason field, or click the empty User Defined 
Reason field and enter your own reason. 

2. Click OK to close the dialog box. 

You can add an Audit Trail to a Record without making any changes. 

 If you choose not to correct an Exception, you can add an Audit Trail to that Record explaining your 

decision not to correct it. 

To add an Audit Trail to a Record without making any changes, choose Add General File Audit 
Record from the Record menu, or press <Ctrl + F8>. The Audit Reason dialog box will open. 

How Do I View It? 

You can view and print Audit Trails in one of three ways: 

 In the Pay-Period Detailed TimeCard (Extended) Report 

 In the Year-to-Date Absence Occurrences Report 

 With the Print Audit Trail Report options in TimeKeeper-PC Set-Up 

The Pay Period is the period for which an Employee is paid. Typical Pay Periods are Weekly, 
Biweekly, and Monthly, but other periods can be created in the system configuration. 
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Viewing Payroll Files and Reports 

Every time you export payroll data, TimeKeeper-PC creates two text files: the Payroll Output File, 
which exports payroll data in text format to your payroll department, and the Unpaid File, which 
displays Records within the Pay Period which were not transferred to the Payroll Output File. 

 An Employee Record which does not include any paid hours will be sent to the Unpaid File. 

If you enable the Print Payroll Report box in the Payroll Report Panel, TimeKeeper-PC will also 
create a Payroll Report. 

You can view any of these three files: 

View Output File 

View Payroll Report 

View Unpaid File 

 To view files, you must export payroll data each time you open the Export Payroll Data dialog box. 

Viewing Output Files 

To view the Payroll Output File, choose View Output File from the File menu, or click the View 
Output File icon: 

 

The Payroll Output File is displayed as text in a full-screen window: 

 

This simple code is the data which is transferred to your payroll software. 

The percent of the file currently being viewed is displayed in the upper right corner of the window. 

Use the horizontal scroll bar at the bottom of the window to scroll across the file. 

Click PgUp and PgDn to scroll up and down through the file. 

Choose Exit from the File menu to close the window. 

To close the window, choose Exit from the File menu. 

Viewing Payroll Reports 

To view the Payroll Report, choose View Payroll Report from the File menu, or click the View 
Payroll Report icon: 

 

The Payroll Report is displayed as text in a full-screen window: 
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On the bottom right of your screen, below the horizontal scroll bar, the current page number and 
total number of pages are displayed. 

 If you are viewing the third page of a five-page report, the legend "Page 3 of 5" will be displayed. 

You can design the Payroll Report to display data in any form you choose. Payroll forms are 
created by the Payroll Report Designer in TimeKeeper-PC Set-Up. 

 In the example above, the user has designed the first three columns of the Payroll Report to display the 

Employee's Badge Number, Regular Hours, and Overtime Hours for the Pay Period. 

Hours are displayed in the Payroll Report in digital form, as hundredths of an hour. 

 In the example above, the first Employee worked 43.25 Regular Hours, or 43 hours and 15 minutes, and one 

hour of Overtime. 

The screen display of a Payroll Report displays the report exactly as it would appear in a printer 
output. However, the screen display also offers several functions which make it possible to fully 
read and interpret the report without having to print it out. 

When you view a Payroll Report, the Payroll Report Menu Bar and the Payroll Report Tool Bar are 
displayed above the report. 

The following options are available in the Payroll Report menus. The corresponding icons next to 
the option descriptions are displayed on the Payroll Report Tool Bar. 

File 

 Open File: Choose this option to open another Payroll Report. 

 Print Report: Choose this option to print the Payroll Report to the printer chosen in Print 
Setup. 

 Print Setup 

 Select Font 

 Exit: Choose this option to close the window and return to the Export Payroll Data dialog 
box. 

Search 
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 Find Text: Choose this option to open the Search dialog box. For Help filling in the Search 
dialog box, click here. You can also choose this option by pressing <F2>. 

 Find Again: Choose this option to find the next example of the string of text most recently 
searched for. You can also choose this option by pressing <F3>. 

 The Find Again option will not be available for a string of text after you search for it unsuccessfully. 

Report 

 First Page: Choose this option to go to the first page of a report. 

 Prev Page: Choose this option to go to the previous page of a report. 

 Next Page: Choose this option to go to the next page of a report. 

 Last Page: Choose this option to go to the last page of a report. 

Opening Another File to View 

Choose Open File from the File menu, or click the Open File icon, to open the Open File To View 
dialog box: 

 

File Location 

The Drives field on the bottom right displays the drive currently selected. You can choose a 
different drive by clicking the drop-down arrow in this field to open a list of drives. 

The name of the directory currently selected is displayed under the title Directories. 

The path of the directory currently selected is displayed in the large Directories panel on the right. 
The name of the directory currently selected is highlighted in this panel. 

 In the example above, the path indicates that the directory currently selected, tk5win, is a directory in the 

c:\ drive. 
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Double-click any level of the path to open a list of directories on the level below. 

 You can double-click the c:\ drive to open a list of all directories of c:\. You can also double-click the 

tk5win directory to open a list of all sub-directories of tk5win. 

Click to select any directory on the path displayed. The selected directory will be highlighted, and 
its name will be displayed under the title Directories. 

File Type 

The file type is displayed in the List Files of Type field. You can choose a file type by clicking the 
drop-down arrow in this field to open a list of file types. The three options are: 

 User Defined: Choose this option to display a list of files with a given filename or extension using wild card characters. 

 If you choose User Defined for the File Type, and enter C*.D* in the File Name field, the Files panel will 

display only those files whose names start with C and whose suffixes start with D -- for example, 

calcday.dll. 

 After you enter the wild card characters in the File Name field, press <Tab> or <Enter> to see the results in 

the Files panel. 

 Only Files (*.REP): Choose this option to display all files with the REP suffix. 

 All Files: Choose this option to display all files. 

File Name 

The files of the selected type contained in the selected directory are displayed in the large Files 
panel on the left. Click to select a file. The selected file will be highlighted, and its name will be 
displayed in the File Name field. 

When the desired file name is displayed in the File Name field, click OK to close the dialog box. 
The file name you have chosen will be displayed in the File Name field. 

To Open Another File from the Report Viewer 

1. Choose Open File from the File menu, or click the Open File icon. The Open File To View dialog box will open. 

2. Click the drop-down arrow in the Drives field to open a list of drives. 

3. Click to select a drive. The drop-down list will close, and the selected drive will be displayed in the Drives field. 

4. Click to select a directory from the path in the Directories panel. The selected directory will be highlighted, and its 
name will be displayed under the title Directories. 

5. Click the drop-down arrow in the List Files of Type field to open a list of file types. 

6. Click to select a file type. The drop-down list will close, and the selected file type will be displayed in the List Files of 
Type field. The files of this type contained in the currently selected directory will be displayed in the Files panel on the 
left. 

7. Click the file you want to select from the Files panel. 

8. When you finish choosing a file, click OK to close the dialog box. 

Viewing Unpaid Files 

To view the Unpaid File, choose View Unpaid File from the File menu, or click the View Unpaid 
File icon: 

 

The Unpaid File is displayed as text in a full-screen window: 
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The Unpaid File displays Records within the Pay Period which were not transferred to the Payroll 
Output File. 

The following columns are displayed in the Unpaid File: 

 Plant Number 

 You can use a synonym for any level of your organization. 

 Site Number 

 Department Number 

 Employee Number 

 Employee Last Name 

 Employee First Name 

 Reason Record is Unpaid 

 The reasons a Record is unpaid can include: Record not found in selected period, Table Q is not defined 

for this Employee, and so on. 

On the bottom right of your screen, below the horizontal scroll bar, the current page number and 
total number of pages are displayed. 

 If you are viewing the third page of a five-page report, the legend "Page 3 of 5" will be displayed. 

When you view an Unpaid File, the Unpaid File Menu Bar and the Unpaid File Tool Bar are 
displayed above the report. 

The following options are available in the Unpaid File menus. The corresponding icons next to the 
option descriptions are displayed on the Unpaid File Tool Bar. 

File 

 Open File: Choose this option to open another Unpaid File. 

 Print Report: Choose this option to print the Unpaid File to the printer chosen in Print 
Setup. 

 Print Setup 

 Select Font 
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 Exit: Choose this option to close the window and return to the Export Payroll Data dialog 
box. 

Search 

 Find Text: Choose this option to open the Search dialog box. For Help filling in the Search 
dialog box, click here. You can also choose this option by pressing <F2>. 

 Find Again: Choose this option to find the next example of the string of text most recently 
searched for. You can also choose this option by pressing <F3>. 

 The Find Again option will not be available for a string of text after you search for it unsuccessfully. 

Report 

 First Page: Choose this option to go to the first page of a report. 

 Prev Page: Choose this option to go to the previous page of a report. 

 Next Page: Choose this option to go to the next page of a report. 

 Last Page: Choose this option to go to the last page of a report. 

General Tab -- Payroll Table 

The Payroll Table field displays the Employee's assigned Payroll Table. The Payroll Table is used 
to calculate the data transferred to your Payroll Application Software, based on the edited Daily 
Activity File. 

The Payroll Table field displays the number of the Employee's current Payroll Table. The name of 
that Payroll Table is displayed to the right of the Payroll Table field. 

To Choose an Employee's Payroll Table 

1. Choose Add/Edit Employee Profile from the Activities menu. The Employee Master File is displayed. 

2. Choose the Employee whose Badge number is to be edited. For Help choosing an Employee, click here. 

3. Click the drop-down arrow next to the Payroll Table field to open a list of Payroll Tables sorted by number. The 
currently selected Payroll Table will be displayed as a raised gray button with white characters. 

4. To choose a Payroll Table, click anywhere on that Payroll Table's line. The drop-down list will close, and the number 
of the selected Payroll Table will be displayed in the Payroll Table field. The name of the selected Payroll Table will 
be displayed to the right of the Payroll Table field. 

Payroll Menu Bar 

The following options are displayed in the Export Payroll Data dialog box. Click any highlighted 
option on this list for Help using that menu option. 

File menu: 

 View Output File 

 View Payroll Report 

 View Unpaid File 
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 Exit: closes the Export Payroll Data dialog box. 

Report Menu: 

 Select Font: You can also select fonts by pressing <F6>. 

 Select Printer: You can also select a printer by pressing <F7>. 

 Run Payroll Transfer: produces the Payroll Output File (and Payroll Report, if enabled). You can also run payroll transfers by 

pressing <F5>. 

Help Menu 

Payroll Tool Bar 

The following icons are displayed on the Payroll Tool Bar. 

 Click the Help icon for Help using the Payroll Data dialog box. 

 Click the View Output File icon to view the Payroll Output File. 

 Click the View Payroll Report  icon to view the Payroll Report. 

 Click the View Unpaid File  icon to view Records within the Pay Period which were not 
transferred to the Payroll Output File. 

 Click the Select Fonts icon to choose font types and sizes for the Payroll Report. You can 
also select fonts by pressing <F6>. 

 Click the Select Printer icon to choose print options such as paper size and orientation for 
the Payroll Report. You can also select a printer by pressing <F7>. 

 Click the Execute Transfer Program icon to produce the Payroll Output File (and Payroll 
Report, if enabled). You can also run payroll transfers by pressing <F5>. 

 Click the Exit icon to close the Export Payroll Data dialog box. 

 This green exit door icon is used to close the dialog box. Only the red exit door on the Main Tool Bar exits 

the TimeKeeper-PC program. 

Payroll Output File Panel 

Output File Name 

This field displays the name of the file to be created. When you open the Export Payroll Data 
dialog box, this field will display the default name (as defined in TimeKeeper-PC Setup) for Payroll 
Output Files. Double-click this field and enter the Payroll Output File's name. 

If you do not know the Payroll Output File's name, click Browse. For Help using the Browse 
button, click here. 

Use Payroll Transfer Tables 



  161 

These fields display the range of payroll transfer tables included in the Payroll Output File. Every 
Employee must be assigned to a payroll table in the Employee Profile. For Help editing Employee 
Payroll Tables, click here. 

The payroll transfer tables are defined in Table Q (Payroll Transfer Definitions). For Help using 
Table Q, click here. 

The number of the first payroll transfer table included in the Payroll Output File is entered in the 
From field. The number of the last payroll transfer table included in the Payroll Output File is 
entered in the To field. These two payroll transfer tables, as well as all payroll tables between 
them, are included in the Payroll Output File. 

Click the arrows next to the From or To field to open a drop-down list of payroll transfer table 
numbers and names. Click anywhere on a payroll transfer table to choose it. The drop-down list 
will close, and the table number will be displayed in the appropriate field. 

The To value must be greater than or equal to the From value. If you try to produce a Payroll 
Output File with a To value less than the From value, you will receive the error message: "To Q# 
Less Than From Q# Out of Range". At the same time, the From field will be highlighted in yellow. 
To correct this error, click OK on the error message, and then enter a new value in the From or To 
field. 

To Choose Options from the Payroll Output File Panel 

1. Double-click the Output File Name field and enter the Payroll Output File's name. If you do not know the Payroll 
Output File's name, click Browse. 

2. Double-click the From field and enter the number of the first payroll transfer table included in the Payroll Output File, 
or click the arrow next to the From field to open a drop-down list of payroll transfer table numbers and names. 

3. Click anywhere on a payroll transfer table to choose it. The drop-down list will close, and the table number will be 
displayed in the From field. 

4. Repeat steps 2-3 for the To field. Choose a payroll transfer table with the same or greater value than the value in the 
From field. 

Output File Name -- Browse Button 

If you do not know the Payroll Output File's name, click Browse to search for it. Click Browse to 
open the Select Output File dialog box: 

 

File Location 

The Drives field on the bottom right displays the drive currently selected. You can choose a 
different drive by clicking the drop-down arrow in this field to open a list of drives. 
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The name of the directory currently selected is displayed under the title Directories. 

The path of the directory currently selected is displayed in the large Directories panel on the right. 
The name of the directory currently selected is highlighted in this panel. 

 In the example above, the path indicates that the directory currently selected, tk5win, is a directory in the 

c:\ drive. 

Double-click any level of the path to open a list of directories on the level below. 

 You can double-click the c:\ drive to open a list of all directories of c:\. You can also double-click the 

tk5win directory to open a list of all sub-directories of tk5win. 

Click to select any directory on the path displayed. The selected directory will be highlighted, and 
its name will be displayed under the title Directories. 

File Type 

The file type is displayed in the List Files of Type field. You can choose a file type by clicking the 
drop-down arrow in this field to open a list of file types. The two options are: 

 User Defined: Choose this option to display a list of files with a given filename or extension using wild card characters. 

 If you choose User Defined for the File Type, and enter C*.D* in the File Name field, the Files panel will 

display only those files whose names start with C and whose suffixes start with D -- for example, 

calcday.dll. 

 After you enter the wild card characters in the File Name field, press <Tab> or <Enter> to see the results in 

the Files panel. 

 All Files: Choose this option to display all files. 

File Name 

The files of the selected type contained in the selected directory are displayed in the large Files 
panel on the left. Click to select a file. The selected file will be highlighted, and its name will be 
displayed in the File Name field. 

When the desired file name is displayed in the File Name field, click OK to close the dialog box. 
The file name you have chosen will be displayed in the Output File Name field. 

To Use the Browse Button to Select Payroll Output Files 

1. Click Browse. The Select Output File dialog box will open. 

2. Click the drop-down arrow in the Drives field to open a list of drives. 

3. Click to select a drive. The drop-down list will close, and the selected drive will be displayed in the Drives field. 

4. Click to select a directory from the path in the Directories panel. The selected directory will be highlighted, and its 
name will be displayed under the title Directories. 

5. Click the drop-down arrow in the List Files of Type field to open a list of file types. 

6. Click to select a file type. The drop-down list will close, and the selected file type will be displayed in the List Files of 
Type field. The files of this type contained in the currently selected directory will be displayed in the Files panel on the 
left. 

7. Click the file you want to select from the Files panel. 

8. When you finish choosing a file, click OK to close the dialog box. 

Payroll Pay Period Panel 



  163 

This panel displays the Pay Period to be included in the Payroll Output File. 

Pay Period Type 

This field displays the currently selected Pay Period type. 

End of Pay Period Day 

This field displays the end date of the period included in the Payroll Output File. When the Export 
Payroll Data dialog box opens, this field will display the current date, even if it is not the end date 
of a defined Pay Period. 

Period Number, Start, End 

These fields display the position of the selected period in the selected year, as well as its 
beginning and ending dates. 

 If the currently selected Pay Period is Monthly, and you open the Export Payroll Data dialog box in August, 

1997, the Period Number will be 8. The start and end dates will be 08/01/97 and 08/31/97. 

You cannot choose the payroll Pay Period by editing the values in these fields. You can choose 
the payroll Pay Period in one of two ways: 

 by using a graphic calendar display (the Calendar). 

 by choosing its Type and End of Pay Period Day 

To Choose a Payroll Period by Its Type and End of Pay Period Day 

1. Click the drop-down arrow next to the Pay Period Type field to open a list of Pay Periods. The currently selected Pay 
Period will be displayed as a raised gray button with white characters. 

2. To choose a Pay Period, click anywhere on that Pay Period's line. The drop-down list will close, and the selected Pay 
Period will be displayed in the Pay Period Type field. 

3. Double-click the End of Pay Period Day field and enter the desired date. 

4. Press <Tab> or <Enter>. The Period Number, Start, and End fields will display the new values you have chosen. 

Choosing a Payroll Period with the Calendar 

TimeKeeper-PC's Calendar allows you to choose a Pay Period from a convenient graphic 
calendar display. Click Calendar in the Period dialog box to open the Calendar dialog box: 

 

The Calendar dialog box displays the Period Type in the top left corner, the Period Type Name in 
the top center, and the Selection Color in the top right corner. The Calendar displays the full 
calendar year, with the Period highlighted by the Selection Color. 

 The example above highlights the weekly period of March 2nd to 8th, 1997. 
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The default value for the Period Type will be displayed until a new value is selected. The current 
year and Period will be displayed until new values are selected. 

 The example above will be displayed if you open this dialog box on March 6th, 1997, with Weekly as the 

Default value for the Period Type. 

Click and hold the right mouse button on any day in the Calendar to display that date, the Period 
Number it belongs to, and the Year. When you release the right mouse button, this display 
disappears. 

This right-click feature enables you to see which Period Number a date belongs to, without having 
to close the Calendar and return to the Period dialog box. 

 In the example above, if you click and hold the right mouse button on March 6th, you will see the display: 

"03/06/1997 Period:10 Year:1997". 

To Choose a Payroll Period with the Calendar 

1. Click Calendar. The Calendar will be displayed, displaying the current Year and Period highlighted by the Selection 
Color. 

 If you change the values in the Pay Period Panel before clicking Calendar, the Calendar will display the new 

values you have chosen. 

2. Click the arrow under Period Type to open a drop-down list of Period Types and their corresponding Names. The 
currently selected Period Type and Name will be displayed as raised gray buttons with white characters. 

3. Click anywhere on any Period Type or Name to choose it. The drop-down list will close, and the new Period Type and 
Name will be displayed at the top of the Calendar. No period will be highlighted by the Selection Color. 

4. Use the vertical scroll bar on the right side of the screen to move upward to a preceding year, or downward to a 
following year. 

5. Click on any day within the desired period. The selected period will be highlighted by the Selection Color. 

6. When the desired period is displayed, click OK to close the Calendar dialog box. In the Pay Period Panel, the new 
selections for Pay Period Type, End of Pay Period Day, and Period Number will be displayed. The Start and End 
fields will display the beginning and ending dates of that Period. 

Payroll Report Panel 

This panel contains options for producing the Payroll Report. 

Payroll Output Files and Payroll Reports -- What's the Difference? 

A Payroll Output File exports payroll data in text format to your payroll department. You need to 
design the payroll form to match the software used in your payroll department. 

A Payroll Report displays payroll data for your own use. You can design the Payroll Report to 
display data in any form you choose. 

The Payroll Report panel displays the following fields: 

Print Payroll Report 

Click this check box to produce a Payroll Report. If this box is not checked, then all the other fields 
in this panel will be disabled. 

Printing To Printer / Disk 

Click one button to print the Payroll Report as a hard copy on a printer, or as a file on a disk. 

If you choose Printer, the Payroll Report File field will be diabled. Choose Print Setup to choose 
print options such as paper size and orientation. For Help choosing print options, click here. 
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If you choose Disk, choose a Payroll Report File name. 

Printing Definition Form 

This field displays the form used to generate the Payroll Report. You can design the Payroll 
Report to display data in any form you choose. Payroll forms are created by the Payroll Report 
Designer in TimeKeeper-PC Set-Up. 

Payroll Report File 

This field displays the name of the file to be created. When you open the Export Payroll Data 
dialog box, this field will display the default name (as defined in TimeKeeper-PC Setup) for Payroll 
Report files. Double-click this field and enter the Payroll Report File's name. 

If you do not know the Payroll Report File's name, click Browse. For Help using the Browse 
button, click here. 

To Choose Options from the Payroll Report Panel 

1. Click the Print Payroll Report check box. 

2. Click to select either the Printing To Printer or Printing to Disk button. 

3. Click the drop-down arrow next to the Printing Definition Form field to open a list of Definition Forms. The currently 
selected Definition Form will be displayed as a raised gray button with white characters. 

4. To choose a Definition Form, click anywhere on that Definition Form's line. The drop-down list will close, and the 
selected Definition Form will be displayed in the Printing Definition Form field. 

5. Double-click the Payroll Report File field and enter the Payroll Report  File's name. If you do not know the Payroll 
Report File's name, click Browse. 

Payroll Report File Name -- Browse Button 

If you do not know the Payroll Report file's name, click Browse to search for it. Click Browse to 
open the Select Payroll Report File dialog box: 

 

File Location 

The Drives field on the bottom right displays the drive currently selected. You can choose a 
different drive by clicking the drop-down arrow in this field to open a list of drives. 

The name of the directory currently selected is displayed under the title Directories. 

The path of the directory currently selected is displayed in the large Directories panel on the right. 
The name of the directory currently selected is highlighted in this panel. 
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 In the example above, the path indicates that the directory currently selected, tk5win, is a directory in the 

c:\ drive. 

Double-click any level of the path to open a list of directories on the level below. 

 You can double-click the c:\ drive to open a list of all directories of c:\. You can also double-click the 

tk5win directory to open a list of all sub-directories of tk5win. 

Click to select any directory on the path displayed. The selected directory will be highlighted, and 
its name will be displayed under the title Directories. 

File Type 

The file type is displayed in the List Files of Type field. You can choose a file type by clicking the 
drop-down arrow in this field to open a list of file types. The two options are: 

 User Defined: Choose this option to display a list of files with a given filename or extension using wild card characters. 

 If you choose User Defined for the File Type, and enter C*.D* in the File Name field, the Files panel will 

display only those files whose names start with C and whose suffixes start with D -- for example, 

calcday.dll. 

 After you enter the wild card characters in the File Name field, press <Tab> or <Enter> to see the results in 

the Files panel. 

 All Files: Choose this option to display all files. 

File Name 

The files of the selected type contained in the selected directory are displayed in the large Files 
panel on the left. Click to select a file. The selected file will be highlighted, and its name will be 
displayed in the File Name field. 

When the desired file name is displayed in the File Name field, click OK to close the dialog box. 
The file name you have chosen will be displayed in the Payroll Report File field. 

To Use the Browse Button to Select Payroll Report Files 

1. Click Browse. The Select Payroll Report File dialog box will open. 

2. Click the drop-down arrow in the Drives field to open a list of drives. 

3. Click to select a drive. The drop-down list will close, and the selected drive will be displayed in the Drives field. 

4. Click to select a directory from the path in the Directories panel. The selected directory will be highlighted, and its 
name will be displayed under the title Directories. 

5. Click the drop-down arrow in the List Files of Type field to open a list of file types. 

6. Click to select a file type. The drop-down list will close, and the selected file type will be displayed in the List Files of 
Type field. The files of this type contained in the currently selected directory will be displayed in the Files panel on the 
left. 

7. Click the file you want to select from the Files panel. 

8. When you finish choosing a file, click OK to close the dialog box. 

You will be prompted by a small dialog box that asks if you want to save the changes you have 
made. 

Click Yes. 

If you have made any changes but not saved them, you will be prompted by a small dialog box 
that asks if you want to save those changes. 

 If you want to save the changes you have made, click Yes. 
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 If you want to exit without saving those changes, click No. 

 If you want to continue working without exiting, click Cancel. 

Sort Codes are custom-made groups assigned by the user. For example, if you assign Employees 
to Sort Codes according to their mode of travel, you can give paid travel time to Employees 
traveling to work by public transportation on the weekend. 

Date Formats 

Before you enter dates, you need to know if your system configuration is set for the U.S. date 
format, which enters the month before the day, or the International date format, which enters the 
day before the month. Enter a date as mmddyyyy for a U.S. date format, or ddmmyyyy for an 
International date format.  

 Enter August 15th, 1996 as "08151996" for a U.S. date, or 15081996 for an International date. The field will 

automatically add the slashes to display "08/15/1996" or "15/08/1996". 

The month must always be entered as two digits. For example, August is entered as "08". 

The year must always be entered as four digits. 

Choosing an Employee 

You can choose an Employee in the Master File by either the Employee Number or the Employee 
Name. 

When you open the Employee Master File, information for the current Employee with the lowest 
Employee Number will be displayed, including that Employee's Number, Last Name, First Name, 
and Middle Initial. These four fields are displayed at the top of the Employee Master File, directly 
below the Employees File Cabinet. 

 The Middle Initial field can be blank. 

To Choose an Employee by Number 

1. Click the drop-down arrow next to the Employee Number field to open a list of Employees sorted by number. The 
currently selected Employee will be displayed as a raised gray button with white characters. 

2. Use the vertical scroll bar on the right to scroll up and down the list. 

3. To choose an Employee, click anywhere on that Employee's line. The drop-down list will close, and the selected 
Employee's Profile will be displayed in the Employee Master File. 

To Choose an Employee by Name 

1. Click the drop-down arrow next to the Employee Last Name field to open a list of Employees sorted by Last Name. 
The currently selected Employee will be displayed as a raised gray button with white characters. 

 If more than one Employee has the same Last Name, they will be sorted according to First Name. 

2. Use the vertical scroll bar on the right to scroll up and down the list. 

3. To choose an Employee, click anywhere on that Employee's line. The drop-down list will close, and the selected 
Employee's Profile will be displayed in the Employee Master File. 

 

 


